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Introducción 

Blender posee una interfaz gráfica muy peculiar, altamente optimizada para la producción de 

gráficos en 3D. Esto puede parecer un poco confuso para un usuario nuevo, pero le permitirá 

obtener un gran rendimiento a largo plazo.  

¿Qué es Blender? 

Blender fue concebido en diciembre de 1993 y apareció como un producto utilizable en agosto 

de 1994 integrando una serie de herramientas para la creación de una amplia gama de 

contenidos 2D y 3D. Blender ofrece un amplio espectro de funcionalidad para el modelado, 

texturizado, iluminación, animación y post-procesado de vídeo en un paquete. Por medio de su 

arquitectura abierta, ofrece interoperabilidad entre plataformas, extensibilidad, ocupa un 

espacio increíblemente pequeño en disco duro,y un flujo de trabajo altamente integrado. 

Blender es una de las aplicaciones Open Source de gráficos 3D más populares del mundo. 

Tomado en cuenta por los profesionales de medios y artistas alrededor del mundo, Blender 

puede emplearse para crear visualizaciones 3D, fijas como videos para emisión en línea o de 

calidad cinematográfica, mientras que la incorporación de un motor 3D de tiempo real permite 

la incorporación de contenido interactivo 3D para ejecución independiente. 

Destinado a nivel mundial a los profesionales de medios y artistas, Blender puede usarse para 

crear visualizaciones 3D, tanto imágenes estáticas como videos de alta calidad, mientras que la 

incorporación de un motor 3D en tiempo real permite la creación de contenido interactivo que 

puede ser reproducido independientemente. 

Originalmente desarrollado por la compañía 'Not a Number' (NaN), Blender es ahora 

desarrollado como 'Software Libre', con el código fuente disponible bajo la licencia GNU 

GPL. Ahora continúa desarrollándose a través de la Blender Foundation en los Países Bajos. 

Entre el 2008 y el 2010, Blender ha sido enteramente recodificado para mejorar sus funciones, 

flujo de trabajo e interfaz. Ahora es conocido como Blender 2.5 (actualmente en beta testing). 

 

Características principales: 

 Paquete de creación totalmente integrado, ofreciendo un amplio rango de herramientas 

esenciales para la creación de contenido 3D, incluyendo modelado, mapeado uv, 

texturizado, rigging, skinning, animación, simulación de partículas y otros, scripting, 

renderizado, composición, post-producción y creación de juegos; 



 Multiplataforma, con una interfaz basada en OpenGL, lista para ser usada en todas las 

versiones de Windows (98, NT, 2000, XP), Linux, OS X, FreeBSD, Irix, Sun y otros 

sistemas operativos; 

 Arquitectura 3D de alta calidad permitiendo un rápido y eficiente desarrollo. 

 Más de 200.000 descargas de cada lanzamiento (usuarios) en todo el mundo; 

 Foro de soporte comunitario para preguntas, respuestas y críticas en 

http://BlenderArtists.org (inglés), http://www.g-blender.org (español), 

http://www.3dpoder.com (español) y nuevos servicios en http://BlenderNation.com 

(inglés); 

 Ejecutable de pequeño tamaño, para una fácil distribución. 

 

Sobre el Software Libre y la licencia GPL 

Cuando uno escucha hablar sobre "software libre", la primera cosa 

que le viene a la mente es "gratuito". Aunque esto es verdad en la 

mayoría de los casos, el término "software libre" tal como es 

usado por la Fundación para el Software Libre (creadores del 

proyecto GNU y de la Licencia Pública General GNU) significa 

"libre, como en libertad" más que "gratis, como en cerveza gratis" 

(N. del T. En inglés tienen el problema de que la palabra "free" 

significa gratis y libre, por eso al definir "free software" tienden a hacer distinción entre 

software gratuito y software libre). Software libre es, en este sentido, aquel software que 

puedes usar, copiar, modificar y distribuir sin ningún límite. Esto contrasta con la licencia de 

la mayoría de paquetes de software comerciales, en donde se te permite usar el software en 

una sola computadora pero no está permitido hacer copias y menos aún ver el código fuente. 

El software libre da una increíble libertad al usuario. Como añadidura a todo esto, debido a 

que el código fuente está disponible para todo el mundo, los fallos pueden ser detectados y 

corregidos de una manera más eficiente y rápida. 

Cuando un programa es licenciado bajo la Licencia Pública General GNU (la GPL): 

 Tienes el derecho de usar el programa para cualquier propósito. 

 Tienes el derecho de modificar el programa, y tener acceso al código fuente. 

 Tienes el derecho de copiar y distribuir el programa. 

 Tienes el derecho de mejorar el programa, y publicar tus propias versiones. 

A cambio de esos derechos, también tienes algunas responsabilidades, que están diseñadas 

para proteger tu libertad y la libertad de otros, por lo que si distribuyes un programa GPL: 



 Debes proporcionar una copia de la GPL con el programa, así el usuario es consciente 

de los derechos que le otorga la licencia. 

 Debes incluir el código fuente o hacer que esté disponible gratuitamente. 

 Si modificas el código y distribuyes una versión modificada, dichas modificaciones 

deben estar licenciadas bajo la GPL y tienes que facilitar el código fuente modificado. 

(No puedes usar código GPL como parte de un programa propietario.) 

 No puedes licenciar el programa fuera de los términos de la licencia GPL. (No puedes 

transformar un programa GPL en un producto propietario). 

Para más información sobre la licencia GPL, visita el sitio web del Proyecto GNU. Para 

referencia, una copia de la licencia pública general de GNU se incluye en el Volumen II. 

 

Instalando los Binarios 

Blender está disponible de dos maneras: como un archivo ejecutable binario y como un 

archivo de código fuente en el sitio de la Fundación (http://www.blender.org/). Actualmente, 

para descargar Blender selecciona "Blender 2.6x" (según que versión del software esté 

disponible, así puede variar el nombre, ejemplo: ―Blender.2.64‖, en un par de meses podría ser 

actualizado a la versión ―2.65‖) desde el menú de navegación del lado derecho en homepage. 

Para consultar el manual en línea hospedado en la wiki, puedes utilizar la versión más reciente 

de Blender localizada en el sitio web de la Fundación Blender (aunque algunas de las 

características de la más nueva versión liberada puedan no estar completamente actualizadas). 

Si estás utilizando una versión publicada de este manual, te recomiendo que utilices la versión 

de Blender incluída en el CD-ROM Guía. En el texto siguiente, cuando sea que se mencione 

"Descarga", todos los que utilizan el libro deberían, en su lugar, de referirse a Blender 

instalado desde el CD-ROM. 

Descargando e instalando la distribución binaria 

Las distribuciones binarias se proveen para las familias de sistemas operativos primarios. 

Algunas distribuciones no oficiales pueden existir para otros sistemas operativos, pero a esas 

distribuciones no se les brinda soporte técnico por Blender Foundation, deberías de reportarlas 

directamente a sus mantenedores: 

 Windows 

 Linux 

 MacOSX 

 FreeBSD, Irix, Solaris 



Los binarios para los sistemas operativos de Macintosh se proveen para dos distintas 

arquitecturas de hardware x86 (de procesadores Intel y AMD) y de PowerPC y por la elección 

entre las librerías cargadas dinámicamente y estáticamente vinculadas. 

El instalador creará archivos y algunas carpetas en dos lugares en tu ordenador: un juego de 

carpetas es para Blender, y el otro es un juego de carpetas de datos del usuario. Debes tener 

autorización de administrador para crear estos. Las carpetas son: 

 .blender - información de configuración (mayormente presentada en tu lenguaje 

nativo) 

 blendcache_.B - espacio temporal para la información de simulación de física (cuerpos 

blandos, ropas, fluidos) 

 plugins - funcionalidad añadida para texturas y secuenciar 

 scripts - scripts de python que extienden la funcionalidad de Blender 

 tmp - salida temporal, renderizadores intermedios 

 

Soporte de Hardware 

Blender soporta plataformas de 64-bit ejecuntando sistema operrativo unix 64-bit, eliminando 

la limitación de memoria de 2GB. 

Blender soporta procesadores multi-nucleo, como los Core-Duo de Intel y los X2 de AMD, 

proporcinando Threads: en el renderizado de imagen, trabajando con ambos nucleos en 

paralelo. 

Blender soporta una amplia variedad de Tabletas Digitalizadoras en los sistemas operativos 

más importantes, especialmente en OS X, Windows XP, y Linux. 

 

Instalando en Windows 

Descarga el último instalador a través de http://www.blender.org/download 

Versión 

Probablemente notarás que hay dos versiones para Windows. Una etiquetada '32 bit' y la otra 

'64 bit'.  

Esto es simplemente porque Windows viene en dos versiones y hay diferencia en cómo trabaja 

el software entre ellos. La versión de 64 bits hará un mejor uso de PC's que tienen más de 4 

GB de RAM y un procesador multi-core. 



Mantén en mente que sólo hay una opción a elegir si tienes la versión de 64 bits de Windows. 

Si tienes la versión de 32 bits tendrás que elegir la opción para dicha versión. 

Una forma rápida de revisar la versión de Windows que tienes es darle click derecho o  entrar 

a la carpeta ―Equipo‖ (también llamado ―Mi PC‖), click izquierdo en el botón  ―propiedades‖ 

y ahí encontraras la información básica de Windows. 

Localizar 

Puedes correr el programa usando el archivo que acabas de descargar directamente de tu 

navegador. Habrá una advertencia preguntando si de verdad quieres correr este archivo, 

presiona 'si'. Si deseas instalarlo luego puedes encontrarlo en la carpeta 'Descargas'.  

Administrador 

Mantén en mente que Blender requiere ser instalado con derechos de administrador. Puedes 

habilitarlos por defecto o dando click derecho en el archivo de instalación. 

Instalación 

Una vez completados los pasos mencionados arriba, podrás instalar Blender en tu 

computadora. Continuemos...  

 

Pantalla de Bienvenida 

Esta es la primera pantalla de la instalación, proporcionando una pantalla de bienvenida. Click 

en Next para continuar. 

 

 

 

 

 

 

 

 



Acuerdo de Licencia 

 

 

Esta pantalla muestra toda la información 

legal que viene con la instalación de 

Blender, aceptamos y continuamos. 

 

 

 

Opciones de Instalación 

 

 

Aquí tienes varias opciones para los accesos 

directos y la unión del .blend con el 

software. 

 

 

 

Localización 

 

Aquí seleccionas el directorio donde 

Blender será instalado. 

 

 

 

 



Archivos de Usuario 

 

Más opciones. Presiona continuar cuando 

hayas terminado de seleccionar lo que 

veas conveniente 

 

 

 

 

 

 

 

Blender se está instalando, se paciente, no 

tardará mucho. 

 

 

 

 

 

¡Y ya está! Una nueva instalación de 

Blender. 

Puedes seleccionar/deseleccionar la opción 

de correr Blender al cerrar la ventana. 

Para terminar la instalación, presiona 'Finish'. 

 

 



Instalación Portable 

Si desea correr Blender desde un llavero USB para poder usarlo en cualquier lugar al que 

vaya, descargue la versión .zip y extráigalo en el llavero USB. Quizás desee evitar colocar la 

salida de la animación u otros archivos temporales en el llavero USB debido a que las 

frecuentes escrituras al disco pueden acortar su vida. 

Para mantener todos sus archivos de configuración y add-ons instalados en el llavero USB, 

cree una carpeta llamada config en la carpeta descomprimida de Blender. Ahora todos los 

archivos de configuración serán leidos y escritos al USB en vez de a la computadora en la que 

está corriendo Blender. 

 

Al iniciar Blender, echa un vistazo a la pantalla de bienvenida: 

En la parte superior de la misma, verás la versión de Blender. 

 

 

 

 

 

 

 

 

 

 

La parte izquierda muestra algunos enlaces útiles, como el registro de la liberación de la 

versión que estás usando, el manual wiki (lo que estás leyendo ahora mismo), Web Oficial de 

Blender... También puedes encontrar estos enlaces en el menú ayuda. 

La parte derecha muestra los últimos seis archivos blender (.blend) que has guardado. Si se 

estás utilizando Blender por primera vez, esta parte estará vacía, ya que aún no se han 

guardado o editado archivos. Esta lista también está disponible en Archivo → Abrir recientes 

Para comenzar a usar Blender, tienes dos opciones: 



 Haz clic en uno de los seis archivos más recientes (si tienes alguno). 

 Haz clic en cualquier otro lugar en la pantalla (excepto la zona oscura de la pantalla de 

inicio) o pulsa Esc para iniciar un nuevo proyecto. 

Para comenzar a usar Blender, tienes dos opciones: 

Haz clic en uno de los seis archivos más recientes (si tienes alguno). 

Haz clic en cualquier otro lugar en la pantalla (excepto la zona oscura de la pantalla de inicio) 

o pulsa la tecla Esc para iniciar un nuevo proyecto. 

Plataformas 

Antes que nada, Blender es multi-

plataforma. Esto significa que funciona 

en Linux, Mac OSX, Windows... Esto, 

podría a llevarte a hacer la siguiente 

pregunta: ¿Blender se ve igual en todos 

estos sistemas? Y la respuesta es... 

¡Claro! Como la interfaz de Blender se 

basa en OpenGL, tiene su propio diseño. 

 

Las 3 reglas 

La interfaz de usuario de Blender se basa en tres principios fundamentales: 

 Nada se superpone: La interfaz de usuario le permite ver todas las opciones pertinentes 

y herramientas de una vez, sin empujar o arrastrar ventanas por todos lados (1). 

 Nada se bloquea: Las herramientas y opciones de la interfaz no bloquean ninguna 

funcionalidad de Blender en la mayoría de los casos. Blender no lanza ventanas que 

requieren que el usuario introduzca datos antes de ejecutar otras "cosas". 

 No Modal: La entrada de los usuarios deberían ser tan coherente y predecible como sea 

posible, sin cambiar los métodos de uso general (ratón, teclado) sobre la marcha. 

(1)Además, Blender  permite múltiples ventanas para múltiples pantalla de configuración. Se 

trata de una excepción a la regla de "Nada se superpone". 

 

 

 



Una Interfaz Poderosa 

Como la interfaz se dibuja bajo OpenGL, puedes organizar Blender exactamente como te de la 

gana para cada tarea específica. Esta "organización" de las distintas herramientas y elementos 

de Blender puede ser nombrado y guardado. 

Una de las cosas más tediosas del aprendizaje y dominio de Blender, es memorizar los atajos 

del teclado para acelerar el trabajo. Y es que a veces no es muy fácil encontrar determinadas 

funciones en los menús y pestañas, lo que lleva a perder tiempo y dinero (si es que trabajas de 

esto, afortunado tú). Por esto, es importante resaltar la opción de personalizar los atajos del 

teclado, que te permitirá adaptarlos a ti, para facilitarte el recordarlos. 

Información general 

Vamos a echar un vistazo a la interfaz predeterminada (la que seguramente querrás cambiar). 

Se compone de Editores, Cabeceras, Botones de contexto, Paneles y Controles. 

 En Blender, llamamos Ventana (llamado en este apartado Editor pero más adelante 

será solo "Ventana") a la parte del software que responde a una función específica 

(ventana de Vista 3D, ventana de Propiedades, ventana de Edición de secuencia de 

vídeo, ventana de Editor de nodos...). Cada ventana tiene su propia Cabecera (Header) 

en la parte superior o inferior. 

 Los Botones contextuales permiten el acceso a las 

opciones. Son como las fichas. A menudo se colocan en 

una ventana dentro de su cabecera (como el Editor de 

propiedades). 

 En cada uno de los editores, las opciones se agrupan en Paneles para organizar 

lógicamente la interfaz (panel Shadow, panel Color, panel Dimensions...). 

 Las Barras laterales están incluidas en algunos editores. Estas barras laterales agrupan 

los diferentes paneles y controles de dichos editores. Para la optimización del espacio 

de trabajo, es posible ocultar temporalmente las barras laterales. 

 Los paneles contienen Controles. Estos pueden permitirle modificar una función, una 

opción o un valor. En Blender, hay varios tipos de controles: 

 Botones: Permiten el acceso a una herramienta (Translate, Rotate, Insert 

Keyframe). Estas herramientas normalmente disponen de teclas de acceso directo 

para acelerar el trabajo. Para mostrar el "atajo" (o comando abreviado) de un 

determinado botón, tan solo tienes que colocar el puntero del ratón sobre el botón 

en cuestión. 

 Checkboxes: Permiten activar o desactivar una opción. Este control solo 

puede contener un valor booleano (True/False, 1/0, Sí/No,...).  



 Sliders: Puedes introducir un valor flotante. Estos 

pueden ser limitados (Desde 0.0 → 100.0) o no 

(Desde -∞ → +∞). Existen dos tipos de 

reguladores en Blender.  

 Menús de selección: Permiten seleccionar un valor 

de una lista. La diferencia entre esto y un 

Checkbox es que los valores están nombrados. No 

puede haber más de dos valores en estos menús.  

 

 

 

Convenciones en este Manual 

Este manual utiliza las siguientes convenciones para describir la entrada de usuario: 

 Los botones del ratón se llaman: 

LMB  - botón izquierdo del ratón. 

MMB  - botón central del ratón. 

RMB  - botón derecho del ratón. 

MMB  - se refiere a hacer clic en la rueda, como si fuera un botón. 

Wheel  - indica que se debe rotar la rueda. 

 

http://wiki.blender.org/index.php/File:Template-LMB.png
http://wiki.blender.org/index.php/File:Template-MMB.png
http://wiki.blender.org/index.php/File:Template-RMB.png
http://wiki.blender.org/index.php/File:Template-MMB.png
http://wiki.blender.org/index.php/File:Template-MW.png


En este manual las teclas de acceso directo se muestran como aparecen en un teclado; por 

ejemplo, 

 G - se refiere a la minúscula ''g''. 

 ⇧ Shift,Ctrl y Alt son generalmente usados como modificadores de teclas. 

 Ctrl W o ⇧ Shift Alt A - indica que esas teclas deben ser pulsadas simultáneamente. 

 0 NumPad hasta 9 NumPad, + NumPad y así sucesivamente, se refieren a teclas en el 

teclado numérico independiente. Bloqnum, generalmente, debe estar encendido. 

Otras claves son mencionadas por sus nombres, tales como Esc, ⇆ Tab, F1 hasta F12. De 

especial interés son las teclas de flecha, ←, → y así sucesivamente. 

Emulación de ratón 

Si no tienes un ratón de 3 botones, necesitarás emularlo revisado las opciones en la 

Preferencias de usuario. 

La siguiente tabla muestra las combinaciones usadas: 

 

 

 

 

El sistema de ventanas 

Al iniciar Blender debería ver la siguiente ventana (la pantalla de bienvenida del centro puede 

cambiar con nuevas versiones): 



Organizando las ventanas 

Blender usa un nuevo enfoque de división de la pantalla para organizar las ventanas. La 

ventana de la aplicación siempre es un rectángulo en el escritorio. Blender se divide en una 

serie de ventanas redimensionables. Una ventana contiene el espacio de trabajo para un 

determinado tipo de ventana, como una ventana 3D View, o un Outliner. La idea es que se 

puede dividir la ventana mayor de la aplicación en cualquier número de ventanas menores 

(pero siempre rectangulares) que no se superponen. De esta forma, cada ventana siempre es 

totalmente visible, y es muy fácil trabajar en una ventana y saltar sobre otra para seguir 

trabajando. 

Maximizando una ventana 

Puede maximizar una ventana para llenar por entero la ventana de la aplicación entera con la 

entrada del menú View → Toggle Full Screen. Para volver a su tamaño normal, utilice de 

nuevo View → Toggle Full Screen. Una forma más rápida de conseguirlo es utilizar ⇧ 

ShiftSpace, Ctrl↓ o Ctrl↑ para cambiar entre ventanas maximizadas y normales. NOTA: La 

ventana sobre la que el ratón está actualmente es la que se maximiza mediante los atajos del 

teclado. 

División de una ventana 

En la esquina superior derecha de la ventana está el 

divisor widget de ventana, y se parece un poco a una 

pequeña punta triangular. Divide y combina ventanas a la 

vez. Al pasar sobre él, el cursor cambiará a una cruz. 

Pulsar   y arrastrar hacia la izquierda para dividir la 

ventana verticalmente, o hacia abajo para dividir 

horizontalmente.  

Unir dos ventanas 

Para combinar dos ventanas, deben tener la misma 

dimensión en la dirección que se desee combinar. 

Por ejemplo, si desea combinar dos ventanas que 

están lado a lado, deben ser de la misma altura. Si la 

altura de la izquierda no es el misma que la de la 

derecha, no es posible combinarlas en sentido 

horizontal. Esto es para que la ventana resultante 

ocupe un espacio rectangular. La misma regla vale 

para la unión de dos ventanas que se apilan una 



encima de otra, ambas deben tener el mismo ancho. Si la superior está dividida verticalmente, 

primero se deben fusionar esas dos, y luego unir la de abajo con la superior. 

Para combinar la ventana actual con la que tiene encima (en la foto se combina la ventana de 

propiedades "sobre" el Outliner), pasar el puntero del ratón sobre el divisor de ventana. 

Cuando el puntero cambia a una cruz, pulsar   y arrastrar hacia arriba para empezar el 

proceso de combinación. La ventana superior se pone un poco más oscura, cubierto con una 

flecha apuntando hacia arriba. Esto indica que la ventana inferior (actual) se "apoderará" del 

espacio de la ventana oscurecida. Suelte   para fusionar. Si se desea que ocurra lo contrario, 

mover el cursor del ratón de nuevo en la ventana original (inferior), y esta será la que se cubra 

con la flecha.  

De la misma manera, las ventanas se pueden combinar de izquierda a derecha o viceversa. 

Si se presiona Esc antes de soltar el ratón, la operación se cancelará. 

Cambiando el tamaño de la ventana 

Se puede cambiar el tamaño de las ventanas arrastrando sus bordes con . Simplemente 

mueva el cursor del ratón sobre el borde entre dos ventanas hasta que cambie a una flecha de 

dos puntas y, a continuación, haga clic y arrastre. 

 

La interfaz y escena predeterminadas 

La escena predeterminada se carga cada vez que inicias Blender o abres o creas un nuevo 

archivo.  

Está dividida en cinco ventanas: 

 El menú principal (la ventana de información (InfoWindow) y el botón de pantalla 

completa (Toggle Fullscreen)) en la parte superior. 

 Una gran ventana 3D (la vista o visor 3D (3D View]) 

 La ventana de la linea de tiempo (Timeline window) en la parte inferior. 

 La ventana de objetos y jerarquías (Outliner) en la parte superior derecha. 



 Una ventana de propiedades (Properties Window) en la parte inferior derecha. 

 

El menú principal superior o (Ventana de información) 

 Tipo de ventana: Permite cambiar el tipo de ventana que se muestra. Por ejemplo, si 

quieres ver la ventana Outliner tendría que hacer clic y seleccionarla. 

 Interface de escena actual (por defecto es "Default"): De forma predeterminada, 

Blender viene con varias interfaces de escenas pre-configuradas que no suelen ser muy 

útiles. Lo más probable es que tenga que crear sus propias interfaces y nombrarlas. 

 Escena actual: Tener la posibilidad de varias escenas permite que usted pueda dividir 

su trabajo en patrones organizados. 

 Motor de Rendering actual: Ofrece una lista de motores de renderizado disponibles. 

 Información sobre los Recursos: Le da información sobre la aplicación y los recursos 

del sistema. Le dice cuánta memoria se está consumiendo en función del número de 

vértices, caras y objetos en la escena seleccionada. Es una comprobación visual 

agradable para ver si usted está llegando a los límites de su máquina. 

 Botón de Pantalla completa: Activa o desactiva el modo pantalla completa. 

Ventana de Vista 3D 

Tome la imagen de arriba como referencia. 



 Manipuladores de Transformaciones 3D: Es una ayuda visual en la transformación 

(traslación - rotación - escala) de objetos, este cambiara según la transformación que se 

realice. 

Los objetos también pueden ser transformados utilizando los atajos de teclado:  

G-traslación. R-rotación. S-escala; con Ctrl Space podrás ocultar o mostrar el 

Manipulador. La visibilidad del manipulador también puede activarse haciendo clic en 

el icono del sistema de coordenadas (que solía ser un icono de una "mano" en 

versiones previas a la 2,5) en la barra de herramientas. Los manipuladores de traslación 

/ rotación / escala se pueden visualizar haciendo clic en cada uno de los tres iconos 

situados a la derecha del icono de sistemas de coordenadas. Con la combinación ⇧ 

Shift  sobre este icono, podrás mostrar u ocultar los manipuladores.  

 Cursor 3D: El cursor 3D, es algo que en determinadas circunstancias no te gustaría 

que se moviera, pero que tarde o temprano lo moverás y tendrás que reubicarlo... Se 

utiliza para muchas cosas. Por ejemplo, representar el lugar donde se añadirán nuevos 

objetos; o representar el punto de pivote para una rotación de una geometría. 

Aquí está el cursor 3D aislado del resto de la escena:  

 Cubo: Por defecto, al instalar e iniciar Blender, empezaras con la Maya de un Cubo 

situado en el centro del espacio Global 3D. En el futuro, lo más probable es que quiera 

cambiar los ajustes por "Defecto", esto se hace Configurando la interfaz de Blender 

como a usted le gustaría que iniciara y luego guardarla como "predeterminada" por 

medio del atajo de teclado Ctrl U (Guardar configuración por defecto). 

 Luz (de tipo lámpara): Por defecto, al instalar e iniciar Blender, empezaras con una 

fuente de Luz que estará en algún sitio cerca del centro del espacio Global 3D. No la 

borres o solo veras las siluetas de los objetos en el render, siempre tiene que haber una 

luz para el render. 

 Cámara: Por defecto, al instalar e iniciar Blender, empezaras con una Camera que 

estará en algún sitio por del centro del espacio Global 3D, lo más probable enfocando 

el cubo. No la borres a menos que no quieras hacer renders de las escenas, el render se 

hace siempre respecto de una cámara... 

 Objeto seleccionado actualmente: Este campo, situado en la parte inferior izquierda 

(al lado del eje de coordenadas) muestra el nombre del objeto seleccionado 

actualmente. 

 

 



Cabecera de la ventana 3D 

(3D Window Header) Este es la cabecera de la ventana 3D. Todas las ventanas de Blender 

tienen una cabecera (y si bien en este caso, esta al pie de la ventana 3d aun así se le llama 

Cabecera).  

 

 Muestra de objetos 3D (Viewport shading): Blender renderiza la ventana 3D usando 

OpenGL. Puede seleccionar el tipo de sombreado interactivo de los objetos 3d, esto se 

logra haciendo clic en este botón y seleccionar entre una variedad de estilos de 

sombreado. Se puede elegir desde que todos los objetos sean cajas, hasta que los 

objetos usen texturas complejas. Si tienes una tarjeta de video potente sería bueno usar 

este último. 

 Capas (Layers): Hace más fácil modelar y animar. Las Capas de Blender 

proporcionan ayuda para distribuir los objetos en regiones funcionales. Por ejemplo, 

una capa puede contener un objeto de agua y otra capa puede contener árboles, o una 

capa puede contener cámaras y luces. 

Cabeceras de ventana 

Todas las ventanas tienen una cabecera (la franja con fondo gris claro que contiene botones de 

icono). También puede referirse como cabecera a la barra de herramientas de la ventana. El 

encabezado puede ser en la parte superior (como en la ventana de Propiedades) o el fondo 

(como en la ventana 3D) de la superficie de una ventana. La imagen, por ejemplo, muestra el 

encabezado de la ventana 3D: 



Ocultar una cabecera 

Clickea y arrastra este límite para ocultar la cabecera 

Si los encabezados no te agradan, puedes ocultarlos, para ello basta con mover el ratón sobre 

el límite entre una ventana y su cabecera, hasta que el puntero toma la forma de flecha de 

doble punta. Luego manteniendo el   arrastra el límite de la cabecera y lograras ocultarla. 

 

Clickea y arrastra este límite para ocultar la 

cabecera   

 

 

Reaparecer una cabecera 

Si te has arrepentido de tu decisión y quieres 

volver a ver esa linda cabecera bastara con hacer 

  sobre el signo ―+‖ que apareció en la parte 

derecha del lugar donde antes estaba la cabecera, 

para que esta vuelva a parecer.  

 

Nota 1: En la ventana 3D hay hasta dos más de estos pequeños 

signos plus (en la parte superior izquierda y derecha de la ventana). 

Al hacer click sobre ellos se abrirán paneles con varias 

herramientas, esto no son otros encabezados.  

Nota 2: En algunas ventanas, el símbolo plus puede ser difícil de 

encontrar, ya que podría pasar como una parte de otros iconos. Un ejemplo es la ventana de 

Objetos y Jerarquías (Outliner), en el que existen otros signos más. Si la cabecera de esta 

ventana se oculta, el plus pasara a estar dentro de la ventana.  

Posición de la cabecera 

Para colocar un encabezado arriba o abajo, simplemente has  sobre él y selecciona la opción 

que deseas en el menú emergente. 

 

 



Colores del tema 

Blender permite, para la mayor parte de su interfaz, el cambiar la configuración de color del 

programa para adaptarse a la necesidad o gustos del usuario. Si usted encuentra que los colores 

que ve en pantalla no se corresponden con los especificados en el Manual es que el tema por 

defecto a sido alterado. Crear un nuevo tema o seleccionar/modificar uno ya existente se logra 

mediante la selección de la ventana Preferencias de Usuario haciendo click en la sección 

Temas (Themes) de la ventana. 

Botón Tipo de ventana 

Si haces click   en el primer icono a la izquierda de la cabecera, podrás elegir uno, de entre 

los 16 tipos de ventana. Cada marco de la ventana en Blender puede contener cualquier tipo de 

ventana. Así que si quieres vistas 3D en todas partes, deberás cambiar el tipo de ventana en 

todos los marcos. 

Botones y menús 

La mayoría de los encabezados de las ventanas, tienen, al lado del botón "tipo de ventana", un 

set de menús que se pueden ocultar - al lado de un signo menos. Así que, si en una de esas, no 

vez algún menú de los mencionados, intenta buscar un signo plus (en el mismo sitio donde 

está el signo menos), y hazle click  . Los menús deberían aparecer. 

Los menús le permiten acceder directamente a muchas funciones y comandos. 

Todas las opciones de los menús muestran el atajo de teclas de acceso rápido pertinentes, solo 

si dicha opción lo tuviese. 

Los menús y botones se cambian según el Tipo de ventana, el objeto seleccionado y el modo. 

Se muestran sólo las acciones que se pueden realizar. 

Botones y Controles 

Los botones y otros controles se pueden encontrar en la mayoría de las Ventanas de la interfaz 

de Blender. Los distintos tipos de controles son descritos más abajo. 

Botón de Operación 

Son botones que realizan una operación cuando se hace clic en ellos (con click izquierdo como 

en el resto de botones). Pueden ser identificados por su color 

gris en el esquema de colores predeterminado de Blender.  

 

 



Botones conmutadores 

Los botones conmutadores consisten 

en cajas marcables que pueden tener 

dos estados (checkbox). Al hacer clic 

en este un botón de este tipo no se 

ejecuta ninguna operación, pero se 

cambia el estado de algo. En algunos 

casos, el botón está acompañado de un botón numérico que permite controlar la influencia de 

alguna propiedad.  

Botones Radio 

Los botones radio son grupos de botones de tipo conmutador en 

los que solo uno puede estar activado.  

Botones Numéricos 

Los botones numéricos pueden ser identificados por su nombre, 

los cuales en la mayoría de los casos contienen el nombre 

seguido de dos puntos y un número. Los botones numéricos son 

manipulados de diversas maneras: 

Para cambiar el valor en pasos, cliquee con   en el pequeño triángulo a los lados del botón.  

Para cambiar el valor en un rango mayor, mantenga presionado  y arrastre el mouse a la 

izquierda o derecha. Si mantiene Ctrl mientras realiza esto, el valor es cambiado en pasos 

discretos; si mantiene ⇧ Shift, tendrá un control aún mayor sobre los valores. 

Intro o   le permite ingresar un valor manualmente. 

Puede también ingresar expresiones simples, como 3*2, en vez de 6. Asegúrese de ingresar un 

punto decimal si quiere un resultado en punto flotante; de otro modo obtendrá un entero (p.ej. 

3/2 = 1, pero 3.0/2 = 1.5). Incluso constantes como pi (3.142) o funciones como sqrt(2) (raíz 

cuadrada de 2) pueden ser utilizados. 

Presione Ctrl← para mover el cursor al comienzo; y Ctrl→ para mover el cursor al final. 

Presione Esc para cancelar la edición del valor. Puede copiar el valor de un botón manteniendo 

el cursor sobre él y presionando Ctrl C. De forma similar puede pegar el valor copiado con 

Ctrl V. 

Si presiona el botón cero 0 (o Numpad0) cuando el puntero del mouse está sobre un botón 

numérico, su valor de campo se reinicia. Esto usualmente significa un 0, pero puede significar 

otros valores; por ejemplo, en caso de un factor de escala, el valor de reinicio sería 1. En 



algunos casos, esta acción afecta un grupo entero de botones: por ejemplo, si presiona 0 (o 

Numpad0) en el botón 3D Cursor Location en la barra lateral Properties de la ventana 3D, 

todos los valores de las coordenadas serán establecidos a 0, haciendo que el cursor 3D salte al 

punto global (0, 0, 0). 

Botones de Menú 

Use los botones de menú para elegir de 

una lista creada dinámicamente. Los 

botones de menú son principalmente 

utilizados para encadenar Bloques de 

Datos (DataBlocks) a cualquier otro. 

(Los Bloques de Datos son estructuras como Mallas, Objetos, Materiales, Texturas, y demás; 

al encadenar un Material a un Objeto, lo asigna a él.) 

 El primer botón (con un ícono del tipo de bloque de 

datos) abre un menú que le permite seleccionar el 

Bloque de Datos a encadenar clickeando con   el 

ítem requerido. (Esta lista tiene una caja de 

búsqueda debajo.)  

 El segundo botón muestra el nombre de un Bloque 

de Datos encadenado y el permite 

editarlo luego de clickear  

 El botón "+" duplica el actual Bloque de Datos y lo 

aplica. 

 El botón "X" limpia el encadenado. 

 Algunas veces hay una lista de Bloques de Datos 

aplicados (como una lista de materiales usados en 

un objeto.) 

 Para seleccionar un Bloque de Datos cliquéelo con  

 Para añadir una nueva sección (por ejemplo: un material, un sistema de partículas, etc.) 

cliquee con  el botón "+" a la derecha de la lista. 

 Para quitar una selección cliquee con LMB  el botón "-" a la derecha de la lista.  

 

Objetos desencadenados 

Los datos desencadenados no son perdidos hasta que Blender se cierre. Ésta 

es una muy poderosa característica de deshacer. Si usted borra un objeto, el 

material asignado a él se establece como desencadenado, pero ¡aún se 



encuentra allí! Simplemente debe re-encadenarlo a otro objeto o proporcionarle un "Usuario 

Falso" (Fake User) (p. ej. al clickear la opción correspondiente del bloque de datos en la vista 

de bloque de datos del outliner). 

Controles de Selección de color 

Algunos controles muestran un panel de diálogo. Por ejemplo, los controles de Color cuando 

son clickeados, mostrarán un diálogo Selector de Color; vea (Selector de Color). 

Botones en cascada 

Ocasionalmente, algunos botones revelan botones 

adicionales. Por ejemplo, el panel Ramps tiene un botón en 

Cascada llamado Ramp que revela botones adicionales 

relacionados con el colorbanding (bandas de color); vea 

(Bandas de color, antes) y (Bandas de color, después).  

 

 

 

Agarrar/Mover (Grab/Move) 

Modo: modos Object y Edit 

Combinación de teclas: G 

Menú: Object/Mesh/etc. → Transform → Grab/Move 

 

Descripción 

Una de las formas más rápidas de mover objetos en el espacio 3D es con la tecla G. 

Presionándola entraremos al modo Agarrar/Mover (Grab/Move) donde los objetos o datos 

seleccionados se mueven de acuerdo con el movimiento del ratón. La distancia del puntero del 

ratón al objeto manipulado no tiene efecto.  

 

Opciones 

 El botón  confirma el movimiento y deja el objeto o dato en la posición actual del 

objeto en la pantalla. 

 El botón de centro o wheeler  restringe el moviento en el eje X, Y o Z. 

 Con  o Esc se cancela el movimiento y deja el objeto o dato en su lugar original. 



Edición Proporcional 

El circulo de influencia, cambiado por WheelUp  para hacer más chico, y WheelDown  

para hacer más grande, es mostrado y moverá vértices dentro de ese círculo, si la opción 

"Proportional Edit" esta seleccionada (NT: se encuentra en la cabecera de la ventana 3D). 

Rotación 

Modo: modos Object y Edit 

Combinación de teclas: R 

Menú: Object/Mesh/etc. → Transform → Rotate 

 

Descripción 

Presionando R entrará al modo "transformación de rotación", donde los objetos o datos 

seleccionados se rotan acorde a la posición del puntero del ratón. Este modo usa el ángulo del 

eje del objeto al ratón como ángulo de rotación, por lo que si se aleja más el puntero del objeto 

se podrá tener mayor precisión en la rotación (o sea; el movimiento del ratón afectará menos a 

la rotación por la misma distancia movida).  

Opciones 

 Con el boton  Confirma el movimiento y deja el objeto o dato en la rotación elegida. 

 Con  se restringe el movimiento en los ejes X, Y o Z. 

 Clickeando  o Esc se cancela la rotación, y devuelve al objeto o dato a su posición 

original. 

 R (Trackball) 

Presionando R mientras se rota un objeto, intercambia el modo de rotación entre un 

único eje de rotación (ya sea alineado con la pantalla o alrededor de cierto eje) y dos 

ejes, la rotación ―trackball‖. En el modo ―Trackball‖, la rotación del objeto es 

controlada por la posición X e Y del puntero, similar al ―trackball‖ de rotación de la 

visualización. Esta puede ser una forma rápida de rotar un objeto en su lugar, sin tener 

que cambiar la vista de rotación mientras se ajusta. Como sea, es más difícil de usar 

que la rotación simple. 

 

Escala 

Modo: modos Object y Edit 

Combinación de teclas: S 

Menú: Object/Mesh/etc. → Transform → Scale 

 



Descripción 

Presionando S entrará al modo "transformar escala", donde el objeto/dato seleccionado es 

escalado hacia adentro o hacia afuera, acorde a la locación del puntero del ratón. Si se aleja lo 

agranda, y si se acerca lo achica. Si el puntero del ratón cruza desde el lado original del punto 

del eje al lado opuesto, la escala seguirá en la dirección negativa, haciendo al objeto/dato 

aparecer volteado. The precision of the scaling is determined by the distance from the mouse 

pointer to the object/data when the scaling begins (NT; ese texto esta errado, para mayor 

precisión pulsar "shift" mientras se mueve el ratón)  

Opciones 

Clickeando con  se confirma la escala, y deja el objeto o dato en la posición elegida. 

Con  se restringe la escala en el eje X, Y o Z. 

Y con  o Esc se cancela la escala, y regresa el objeto o dato a su tamaño original. 

Alt S (solo en modo Edición): Escala a lo largo de la dirección de las direcciones de las 

Normales. 

Tipos de ventanas 

El menú de selección del tipo de ventana. 

La interfaz de Blender se divide en varias sub-ventanas, cada una 

con diferentes tipos de información, dependiendo del tipo de 

ventana. 

Cada sub-ventana opera de forma independiente, y varias sub-

ventanas del mismo tipo pueden coexistir en el entorno de trabajo. 

Por ejemplo, puede tener varias sub-ventanas 3D abiertas, cada una 

con una perspectiva diferente de la escena. Las sub-ventanas pueden 

dividirse y volverse a unir entre sí para acomodarse a su forma de 

trabajar. También puede elegir, para cada ventana, si quiere que ésta 

se muestre con su cabecera o no, para un mejor aprovechamiento del 

espacio. 

Los tipos de ventana se organizan según su funcionalidad: 

 La vista 3D (The 3D View)- Una vista gráfica de la escena actual. 

 El Editor de Nodos (The Node Editor) - Le permite usar nodos para texturizar, usar los 

materiales y para la composición de la escena. 



 Imagen/Editor UV (The Image/UV Editor) - Un editor de imagen con herramientas 

avanzadas de manejo de UV. 

 El editor de propiedades (The Properties Editor) - Muestra los diferentes atributos del 

objeto 3D seleccionado. 

 El navegador de archivos (The File Browser) - Usado para organizar, cargar y salvar 

archivos (Suele aparecer automáticamente cuando se necesita). 

 El esquematizador (u Organizador) (The Outliner) - Le ayuda a encontrar y organizar 

sus objetos. 

 La línea de tiempo (The Timeline) - Controla la reproducción en las animaciones. 

 The Graph Editor - manage animation keys (and drivers) and inter/extrapolation of 

these. 

 El editor NLA (The NLA Editor) - Controla las secuencias de acciones en animaciones 

no lineales. 

 The Dope Sheet - combine individual actions into action sequences. 

 El editor de secuencias de video (The Video Sequence Editor) - assemble video 

sequences into a film strip. 

 The Logic Editor - a game logic editing window. 

 El editor de texto (The Text Editor) - Para mantener notas y documentación referente a 

su proyecto. También se usa para escribir scripts de Python. 

 La consola (The Console) - Le permite usar directamente Python en Blender. 

 Preferencias de usuario (User Preferences) - Personalice Blender a su estilo de trabajar. 

 

Pantallas 

La flexibilidad de las ventanas de Blender le permite crear 

entornos de trabajo personalizados para diferentes tareas, 

tales como el modelado, la animación y el scripting. Suele ser 

útil poder cambiar entre diferentes entornos para un mismo 

trabajo. Para cada escena, necesita modelar los polígonos, 

pintarlos mediante materiales, etc. En la imagen de ejemplo 

en El sistema de ventanas, estamos en la etapa de modelado. 

 

Para realizar cada una de estas tareas creativas, Blender 

dispone de un conjunto de pantallas (o entornos de trabajo) predefinidas, las cuales le muestra 

los tipos de ventanas que necesita para realizar el trabajo de forma rápida y eficiente. Si tiene 

problemas para encontrar una pantalla particular, puede recurrir a la función de búsqueda, en 

la parte baja de la lista (Vea la imagen de la derecha). 



Animación (Animation)  

Para dar vida a sus actores y objetos, cambiar formas o colores, etc. 

 

Composición (Compositing)  

Combine diferentes partes de una escena (Fondo, actores, efectos especiales, etc.) y aplíquele 

filtros (Por ejemplo, corrección de color). 

 

Default  

Para diseñar, Archivos nuevos o ya existentes, sirve para modelar nuevos objetos. 

  

Lógica de juego (Game Logic)  

Planificación y programación de juegos en Blender. 

 

Scripting  

Documente su trabajo y/o escriba scripts para personalizar Blender. 

 

Editor UV (UV Editing)  

Aplane la proyección de un objeto o una malla en 2D para texturizarla. 

Edición de video (Video Editing)  

Edición de secuencias de animación. 

 

Blender ordena automáticamente 

estas pantallas en orden alfabético 

y/o numérico. La lista se encuentra 

en la cabecera de la ventana de información. Para cambiar a la siguiente pantalla en orden 

alfabético, presione Ctrl→; Para cambiar a la pantalla anterior, presione Ctrl← 

Por defecto, cada pantalla "recuerda" la última escena en la que fue usada, por lo que cambiar 

de pantalla supondrá un cambio a la nueva pantalla y a la última escena en la que ésta se usó. 

 

Configuración de Pantallas 

Agregando una nueva pantalla 

Sólo da click en el botón "Add" . Una nueva pantalla será creada a partir de la actual. 

Probablemente no sólo querrás darle nombre a tu nueva pantalla sino que también un número 

para poder predecir su orden usando las flechas del teclado. Puedes renombrar la pantalla 

haciendo   en el campo y escribiendo ahí el nombre, o dando un segundo click para 



posicionar el cursor en el campo para editar. Por ejemplo puedes usar el nombre "6-

MiPantalla". 

Borrando una Pantalla 

Puedes borrar una pantalla usan el botón "Delete datablock"  

Reorganizando una Pantalla 

Usa los controles de ventana para mover los bordes. Divide y une ventanas. Cuando tengas la 

pantalla que quieras, presiona Ctrl U para actualizar las 'Preferencias de usuario' (ten cuidado, 

la escena actual se convertirá en parte de las preferencias por defecto, así que arregla tus 

pantallas con una escena simple abierta, por ejemplo; la escena por defecto). 

La ventana de propiedades tiene una opción especial. Usando  en su fondo se podrá 

acomodar el panel de manera horizontal o vertical. 

Anulando las opciones predefinidas 

Cuando guardas un archivo .blend, las pantallas se guardan en el. Cuando abres un archivo, la 

casilla Load UI del encabezado del navegador controla cuándo Blender debe usar las pantallas 

del archivo, o continuar usando tus pantallas. Si Load UI está activada, las pantallas del 

archivo son usadas, anulando las que tengas por defecto mientras usas ese archivo. 

Pantallas adicionales 

Conforme vayas avanzando en el uso de Blender, considera agregar algunas pantallas para una 

línea de trabajo (workflow) completa. Esto dará como resultado un dramático incremento en 

su funcionalidad. 

 Model: Ventana 3D con el modo quad (frente, lado, arriba, perspectiva), ventana de 

propiedades. 

 Iluminación: Ventana 3D para mover las luces, UV/Editor de imágenes para ver los 

renders, ventana de propiedades para las opciones de renderizado y de las luces. 

 Materiales: Ventana de propiedad en las opciones de materiales, ventana 3D, outliner, 

librería de script (si son usadas), y tal vez el editor de nodos. 

 Composición: Ventana 3D, ventana de UV/editor de imágenes, línea del tiempo, 

ventana de propiedades, ventana de nodos. 

 Editor de UV: UV/editor de imágenes, ventana 3D para pintar sobre los objetos con el 

modo de selección caras, 3 mini ventanas con las demás perspectivas con imágenes de 

referencia y ventana de propiedades. 



 Animación: Editor de gráficos, Ventana 3D para poner esqueleto, Ventana NLA, 

Outliner, ventana de 3D con la perspectiva de la cámara, ventana de propiedades y 

línea de tiempo. 

 Nodal: Un gran editor de nodos, ventana de UV/editor de imágenes vinculado con el 

Resultado de Render, y ventana de 3D. 

 Secuencia: Editor de gráficos, editor de secuencia de video en modo de 

previsualización, editor de secuencia en modo de línea de tiempo, ventana de línea de 

tiempo y ventana de propiedades. 

 Notas/Scripting: Outliner, ventana de editor de texto (Scripts). 

 

Reutiliza tus pantallas 

Si creas una pantalla que te gustaría usar en el futuro, simplemente guárdala presionando Ctrl 

U (no olvides que todas las pantallas y la escena se guardaran como preferencias por defecto). 

 

Escenas 

Es posible tener varias escenas en el mismo fichero de Blender (Para entender lo que esto 

significa, eche un vistazo a Libreria de Blender y sistema de datos). 

Las escenas pueden compartir 

objetos o ser totalmente 

independientes. Usted puede 

elegir y crear escenas con el Selector de escena (Scene selector) en la cabecera de la ventana 

de información (La barra en la parte alta de la mayoría de las pantallas de Blender, la cual es 

realmente una ventana que sólo muestra su cabecera.  

Configuración de Escenas - Añadiendo una nueva escena 

Usted puede añadir una nueva escena clicando . Cuando crea una nueva escena, puede 

elegir entre 5 opciones para controlar su contenido (Menú de añadido de escena) 

Para elegir entre estas opciones, usted necesita entender perfectamente cuál es la diferencia 

entre "Objetos" y "Datos de Objetos". Cada elemento gráfico de Blender (Una malla, una 

lámpara, una curva, etc.) se compone de dos partes: Un objeto y los datos del mismo (También 

conocido como "ObData") El objeto contiene información sobre la posición, la rotación y el 

tamaño de un elemento particular. Los datos del objeto contienen información que es común a 

cada instancia de ese tipo de elemento. p.e. mallas, listas de materiales, y demás. Cada objeto 

tiene un enlace sus datos asociados, y un ObData puede ser compartido por varios objetos. 



Las cinco opciones, por lo tanto, determinan qué parte de esta información será copiada de la 

escena actual a la nueva, y qué parte será compartida ("Enlazada"): 

 Nueva (New): Crea una escena vacía. En la nueva escena, los Ajustes de Render pasan 

a tener los valores por defecto. 

 Copia de Ajustes (Copy Settings): Al igual que la opción anterior, crea una escena 

vacía. Sin embargo, en este caso, los Ajustes de Render se copian de la escena original. 

 Enlazar objetos (Link Objects): La copia más superficial disponible. Esta opción 

crea una nueva escena con el mismo contenido de la escena actual. Nada se copia : Lo 

que la nueva escena contiene son enlaces a los objetos de la escena actual. Por lo tanto, 

los cambios en la nueva escena también modificararán la otra escena, ya que los 

objetos usados en la escena nueva son, literalmente,' los mismos objetos usados en la 

escena actual. 

 Enlazar datos de objeto (Link 

Object Data): Crea copias 

duplicadas de todos los objetos de 

la escena actual, pero cada uno de 

estos duplicados tendrán enlaces a 

las mismas mallas, materiales, etc 

(El "ObData") de los correspondientes objetos en la escena original. Esto significa que 

usted puede cambiar la posición, orientación y tamaño de los objetos en la nueva 

escena sin afectar a las otras escenas; Pero cualquier modificación sobre las mallas, 

materiales, y demás (El "ObData") afectará también a las otras escenas (Esto es así 

debido a que una sola instancia del "ObData" está siendo compartida por todos los 

objetos, en todas las escenas. Si quiere hacer cambios a un objeto en la nueva escena y 

que no afecte al mismo objeto en las otras escenas, tendrá que hacer que el objeto en 

cuestión sea "monousuario" ("single-user") en el panel de la ventana de preferencias 

(preferences window), lo cual tiene el efecto de hacer una nueva copia independiente 

del "ObData".  

 Copia total (Full Copy): Es la forma de copia más profunda disponible. Nada se 

comparte: Esta opción crea una escena totalmente independiente con copias del 

contenido de la escena actual. Cada objeto de la escena original se duplica, así como su 

"ObData". 

Entonces, ¿por qué todo este alboroto acerca de la vinculación? Considera lo siguiente: 

Necesitas un bar como locación para tu animación con todos los objetos necesarios dentro de 

él. Para tener una versión limpia de el bar, será preferible que realices todas tus acciones en 

una segunda escena, que sea una copia de la primera. Al final, necesitas diferentes objetos 

vinculados de diferentes maneras: 



 Link Objects: Paredes, el bar, una escalera - todos estos estarán vinculados a la escena 

base de esta manera. Así, si corriges el emplazamiento de una pared, se moverá en 

cada escena que use el bar como locación. 

 Link Object Data: Los muebles se vincularán de esta manera, así puedes mover las 

sillas a diferentes posiciones en diferentes escenas. Las sillas permanecerán en el suelo 

del bar en todas las escenas. Como no cambiarán de forma, no es necesario 

desperdiciar memoria en copias idénticas de ellas. 

 Full Copy: El cristal que se romperá al caer al piso, necesita su propia copia en cada 

escena, porque cambiará su forma. 

Todo lo anterior no es posible al mismo tiempo en una escena nueva, pero puede ayudar a 

entender el porqué de vincular diferentes objetos en diferentes maneras. 

Eliminando una escena 

Puedes eliminar una escena usando el botón Delete datablock  y confirmando dando click 

en la caja de diálogo Delete current scene que aparece. 

 

Contextos 

La Ventana de Propiedades (o Botones) 

muestra varios Contextos que pueden 

ser seleccionados a través de la fila de iconos situada en la cabecera. 

El número y tipo de botones cambia dependiendo del Contexto seleccionado de forma que 

solo se muestran los botones útiles. El orden de estos botones sigue la jerarquía detallada a 

continuación: 

  Renderizar: Todo lo relacionado con el renderizado (dimensiones, anti-aliasing, 

rendimiento, etc). 

  Escena: Gravedad en la escena, unidades y más información general. 

  World (Mundo): Iluminación ambiental, cielo, niebla, estrellas... 

  Objeto: Transformaciones, opciones de visualización, configuración de visibilidad 

(por medio de capas), configuración de duplicación e información de animación (con 

respecto a la posición del objeto). 

   Restricciones: Utilizadas para controlar la transformación, el seguimiento y las 

propiedades de relación de un objeto. 



  Modificadores: Operaciones que pueden afectar de forma no destructiva a objetos 

cambiando la forma en que se presentan sin alterar su geometría; por ejemplo, espejo y 

suavizado (mirror and smoothing). 

  Datos de Objeto: Contiene todos los datos de un objeto específico (color de una 

lámpara, longitud focal de una cámara, grupos de vértices, etc.). El icono varía según 

el tipo de objeto (el que se muestra aquí es un objeto maya). 

  Materiales: Información sobre una superficie (color, transparencia, etc.). 

  Texturas: Son utilizadas en los materiales para proporcionar detalles adicionales; 

por ejemplo, color, transparencia, falsa profundidad tridimensional, etc. 

  Partículas: Añaden una cantidad variable de (generalmente pequeños) objetos 

tales como luces u objetos de malla que pueden ser manipulados por Campos de 

Fuerza (Force Fields) y otros ajustes. 

  Física: Propiedades relacionadas con la simulación de telas (Cloth), campos de 

fuerza (Force Fields), colisiones, fluidos y humo.  

 

Abrir las preferencias del usuario 

Ve a File → User Preferences o presiona CtrlAltU para abrir el editor de preferencias. 

También puedes cargar el editor en el área de menú principal de Blender.  

Este editor te permite configurar cómo Blender trabajará. Las opciones están agrupadas en 7 

pestañas situadas en la parte superior de la ventana: Interface, Editing, Input, Add-Ons, 

Themes, File y System. 

Configurar 

Ahora que tienes abierta la 

ventana de preferencias del 

usuario, vamos a 

configurar Blender. 

Selecciona lo que quieras 

cambiar de la siguiente 

lista: 

 

 

 



Interfaz: La configuración de la Interfaz permite cambiar cómo se muestran los elementos de 

la UI y cómo reaccionan. 

  

 

 

 

 

 

 

 

 

Display 

 Tooltips: Si está activado, cuando sitúes el puntero del ratón sobre un control aparecerá 

una nota explicando la función de dicho control, mostrando también el atajo o tecla de 

acceso rápido (hotkey) asociado (si lo hubiera) y la función de Python a la que se 

refiere. ¡Muy útil! 

 Object Info: Muestra el nombre y el fotograma del objeto activo en la esquina inferior 

izquierda de la ventana 3D. 

 Large Cursors: Utiliza los cursores del ratón grandes cuando estén disponibles. 

 View Name: Muestra el nombre y tipo de la vista actual en la esquina superior 

izquierda de la vista 3D. Por ejemplo: perspectiva de usuario o vista superior. 

 Playback FPS: Muestra la frecuencia en fotogramas por segundo (fps) con la que la 

pantalla se actualiza mientras reproduce una animación. Aparecerá en la esquina 

superior izquierda de la ventana 3D cuando sea relevante. 

 Global Scene: Fuerza al tema actual a mostrarse en todas las escenas (un proyecto 

puede incluir más de una escena). 

 Object Origin Size: Diámetro de los objetos centrados en el visor (valor en píxeles de 4 

a 10). 

 Display Mini Axis: Muestra el mini eje en la esquina inferior izquierda de la ventana 

3D. 

 Size: Tamaño del mini eje. 

 Brightness: Brillo del mini eje. 



View manipulation (manipulación de vista) 

 Auto Depth (auto profundidad): Usa la profundidad bajo el ratón para mejorar las 

funcionalidades de pan/rotate/zoom.  

 Zoom to Mouse Position (zoom a la posición del mouse): Cuando esta activado, la 

posición del puntero se convertirá en el punto de zoom en lugar de el centro de la 

ventana. Útil para evitar paneo si frecuentemente estás haciendo zoom. 

 Rotate Around Selection (rotar alrededor de la selccion): Los objetos seleccionados se 

convierten en el centro de rotación del viewport. 

 Global Pivot (pivote global): Usa el mismo pivote en todas las vistas 3D. 

 Auto Perspective (auto perspectiva): Cambia automáticamente entre las vistas 

ortográficas y perspectiva cuando tienes la pantalla con las 4 vistas. Si esta 

desactivado, cada vista permanecerá como esta. 

 Smooth View (vista suavizada): Aumentan el tiempo de animación cuando se cambia 

con el pad numérico. Redúcelo a 0 para quitar la animación. 

 Rotation Angle (angulo de rotación): Determina la cantidad de grados, cada vez que 4 

NumPad, 6 NumPad, 8 NumPad, or 2 NumPad son usados para rotar la vista 3D. 

Manipulador 

Permite la configuración del manipulador de transformaciones 3D que es usado para mover, 

rotar y escalar objetos. 

Menús 

 Open on Mouse Over: Activarlo para desplegar los menús con solo posicionar el 

puntero encima del menú en lugar de darle click. 

 Menu Open Delay 

o Top Level: Tiempo de retraso en décimas de segundo antes de que un menú se 

abra. 

o Sub Level: Lo mismo que el anterior, pero para submenús (por ejemplo: File → 

Open Recent. 

2D Viewports 

Minimum Grid Spacing: Determina el número mínimo de pixeles entre las líneas de la malla 

(grid) en una vista 2D. 

 

 

 



Edición: Estas preferencias controlan cuantas herramientas interactuarán con tu interfaz. 

 

Ligar materiales 

Para entender esta opción correctamente, necesitas entender cómo es que Blender trabaja con 

los objetos. Casi todo en Blender está organizado en bloques de datos (datablocks). Así que si 

agregas un objeto, siempre existirá ese objeto (un bloque de datos por 

ejemplo: que contenga la ubicación) y los datos del objeto ligados a este 

(de nuevo un bloque de datos que contenga la data de malla (mesh-data) 

en caso de tener un objeto malla). 

 Object: El material será ligado al objeto en sí 

(derecha)  

 Object Data: Esto significa que por defecto, 

un material será creado bajo los datos del objeto (a la izquierda). 

 

Nuevos objetos 

 Enter Edit Mode: Si esta activo, se entrará al modo de edición en cuanto el objeto sea 

creado. 

 Align To 

o World: Los nuevos objetos se alinearán de acuerdo a las coordenadas del 

mundo. 

o View: Los objetos se alinearán de acuerdo a las coordenadas del viewport. 

 



Deshacer 

 Global Undo: Conservará una copia entera del documento en la memoria 

(consumiendo más memoria). 

 Steps: Determina la cantidad de pasos para deshacer que serán guardados. 

 Memory Limit: Uso máximo de memoria (0 es ilimitada). 

 Grease Pencil: Permite dibujar ligas en la vista 3D. 

 Manhattan Distance: El número mínimo de pixeles que el ratón tiene que mover 

horizontal o verticalmente antes que un movimiento sea grabado. 

 Euclidian Distance: La distancia mínima que el ratón tiene que viajar antes de que el 

movimiento sea grabado. 

 Eraser Radius: Determina el tamaño del borrador, usado con el grease pencil 

 Smooth Stroke: Suavizado del Grease pencil una vez que termina de dibujar. 

Keyframing 

En muchas situaciones, la animación es contralada por fotogramas clave. El estado de un valor 

(o locación) es guardado en un fotograma clave y la animación entre dos de estos es 

interpolada por Blender. 

 Visual Keying: Se usa automáticamente para objetos restringidos. 

 Only Insert Needed: Cuando esté activado, sólo se crearán keyframes cuando sea 

necesitado. 

 Auto Keyframing: Inserción de un keyframe automático para Objetos y Huesos.  Esta 

opción no está activada por defecto. 

o Only Insert for Keying 

o Only Insert Available: Inserción automática de un keyframe en curvas 

disponibles. 

 New F-Curve Defaults 

o Interpolation: (puede aparecer como "Interpolar") La interpolación por 

defecto para nuevos keyframes: Bezier (suave aceleración y desaceleración), 

lineal o constante (cambios abruptos) - Este controla el cómo se hace la 

interpolación entre dos keyframes. 

o XYZ to RGB: Colorea las curvas de animación X, Y ó Z (posición, escala o 

rotación) de manera que sean iguales. 

 

 

 

 

 



Pintura y Escultura 

En Blender, el pintado interactivo y la deformación de la superficie de un objeto es posible 

con varias herramientas. 

 Unify Size: Todas las brochas tendrán el mismo tamaño. 

 Unify Strength: Todas las brochas tendrán la misma fuerza. 

 Threaded Sculpt: Aprovecha los procesadores de varios núcleos cuando está 

activado. 

 Show Brush: El tamaño de la brocha será visible mientras es usada. 

Duplicate Data 

Define qué datos serán duplicados de un objeto. Así, si copiamos esto: 

 Object 

o Mesh 

Si Mesh es activado, el resultado de la duplicación será: 

 Object.001 

o Mesh.001 

El nuevo objeto obtiene una copia de la malla anterior. Las transformaciones a esta malla no 

tendrán impacto en el objeto original. 

Si Mesh no está activado, el resultado será: 

 Object.001 

o Mesh 

Así, ambos objetos están ligados a Mesh. Cambios en la malla afectará a ambos objetos, pues 

están usando la misma malla. 

Entrada: En las preferencias de entrada, puedes configurar como Blender reacciona al mouse 

y al teclado. Desde Blender 2.5, también es posible cambiar el mapa de teclas. 



 

 

Manejar Presets 

Blender te permite configurar múltiples configuraciones de entrada. En lugar de borrar el 

mapa de teclas por defecto para crear el tuyo, puedes sencillamente agregar nuevos presets. 

Entonces, serás capaz de elegir tu configuración preferida. 

Crear un nuevo preset 

Antes de cambiar cualquier cosa en la configuración por 

defecto, solo haga click en el signo ―+‖ a la par de la lista 

―preset‖. Blender le pedirá nombrar la nueva configuración. 

Una vez hecho, selecciónela en la lista (habilitara la configuración y le permitirá editarla). 

Úsalo 

Una vez que ha configurado su preset, puede alternar entre el predefinido y el suyo: 

 Abra las preferencias de usuario y 

seleccione su configuración en la 

lista de presets. 

 Cuando se inicia Blender, 

seleccione su preset en el menú de 

interacción de la ventana de bienvenida. Note que se cambiara solo para el archivo 

actual abierto. Si selecciona File → New or File → Open, el preset predefinido será 

cargado nuevamente. 

 



Add-Ons 

La ficha de Add-Ons le permite administrar opciones secundarias, las cuales no están 

habilitadas en Blender por defecto. Nuevas características pueden ser añadidas con Install 

Add-On. Allí habrá una cantidad creciente de Add-Ons, generados por la Comunidad de 

Blender, así que puede buscar aquella característica que esté echando en falta (O quizás, 

simplemente, créela usted mismo). 

 

 

 

 

 

 

 

 

 

Temas 

Como ya se ha mencionado, Blender es muy personalizable. Puedes crear y editar los colores 

y la apariencia de la interfaz. La pestaña Themes te permite hacer esto. 

 

 

 

 

 

 

 

 



 

Puedes cambiar los colores de todos los editores. Selecciona el el editor en la lista multiopción 

de la izquierda y configúralo. Notarás que los cambios se aplican instantáneamente. 

Puedes cambiar no sólo los colores, sino también detalles como el tamaño de los puntos en la 

Vista 3D o el Graph Editor. 

 

Archivo 

Esta imagen muestra las preferencias de archivo, las cuales se explican más abajo. 

 

Rutas de Archivo 

Cuando usted trabaja en un proyecto importante, es inteligente configurarlo apropiadamente. 

Establezca las rutas por defecto para los diferentes tipos de archivo que usará. 

Aquí hay un ejemplo de configuración: 

 

Note que Blender no creará la estructura de su proyecto 

automáticamente. Usted deberá crear todos los directorios 

manualmente en su navegador de archivos del sistema (O 

usando el navegador de archivos de Blender, y creándola 

desde ahí). 

 

 

 

 

Fonts //fuentes/ 

Textures //texturas/ 

Texture Plugins //plugins/textura/ 

Sequence Plugins //plugins/secuencia/ 

Render Output //renders/ 

Scripts //scripts/ 

Sounds //sonidos/ 

Temp //tmp/ 



 

 

Guargar y Cargar 

 Relative Paths  

 Por defecto, los archivos externos utilizan rutas relativas. Ésto sólo funciona cuando un 

archivo de Blender es guardado. 

 Compress File  

 Comprime el archivo .blend cuando es guardado. 

 Load UI  

 Cuando carga un archivo .blend, la disposición de las ventanas (las Pantallas) que son 

guardadas en él, son utilizadas en lugar de su actual configuración de ventanas (esto 

puede ser cambiado individualmente cuando carga un archivo - la configuración es 

solamente la utilizada allí). 

 Filter File Extensions  

 Al activar esto, la ventana de diálogo de archivo sólo mostrará los archivos 

seleccionados (p.ej. los archivos .blend al cargar una configuración de Blender). La 

selección de los tipos de archivos puede ser cambiada en la ventana de diálogo. 

 Hide Dot File/Datablocks  

 Oculta los archivos que comiencen con ".*" en los navegadores de archivos (en Linux 

y sistemas apple, los archivos ".*" están ocultos). 

Autoguardado 

 Save Versions  

 El número de versiones creadas para el mismo archivo (para copias de seguridad). 

 Recent Files  

 Cantidad de archivos mostrados en File → Open Recent. 

 Save Preview Images  

 Una pequeña imagen de vista previa será incluida en cada nuevo archivo .blend 

guardado. 

 Auto Save Temporary File  

 Habilita el guardado automático (crea un archivo temporario) 

 Timer  

 El tiempo a esperar entre guardados automáticos. 

 

 

 



Sistema 

La imagen muestra el panel de las preferencias de sistema de Blender. Las diferentes opciones 

son explicadas más abajo. 

 

General 

 DPI: Este valor es la resolución de pantalla y, por lo tanto, controla el tamaño de las 

fuentes de la interfaz.Para cambiar el tamaño de partes de la interfaz, puede preferir 

arrastrar con Ctrl +   hacia la izquierda y hacia la derecha sobre el panel para 

redimensionar su contenido. 

 Frame Server Port: Puerto del frameserver para renderizado mediante frameservers. 

 Console Scrollback: El número de líneas de la ventana de consola almacenadas en 

memoria. 

 Auto Run Python Scripts: Permite a los archivos .blend correr sus propios scripts 

automáticamente (Puede resultar inseguro con archivos de fuentes desconocidas). 

 Tabs as Spaces: Las etiquetas en los archivos de texto son convertidas en espacios 

mientras se tipea, o cuando un archivo de texto es cargado. 

Screencast 

 FPS: Cuadros por segundo que se reproducen para el screencast. 

 Wait Timer: Tiempo en milisegundos entre cada cuadro grabado para el screencast. 

Open GL 

 Clip Alpha: Recorte de alpha por debajo de este umbral en la vista 3D. 



 Mipmaps: Texturas escaladas en la ventana 3D para filtrado mediante mipmap. Esto 

aumenta la calidad de la visualización, pero utiliza más memoria. 

 VBOs: Usa Objetos de Búfer de Vértices, o si no es soportado usa las matrices de 

vértices para el renderizado en el visor. 

 Window Draw Method 

o Automatic: Configuración automática basada en la tarjeta gráfica y driver. 

o Triple Buffer: Usa un tercer búfer para redibujado mínimo a un costo de 

mayor memoria. 

o Overlap: Redibuja todas las regiones superpuestas. Mínimo uso de memoria, 

pero mayor redibujado. 

o Overlap Flip: Redibuja todas las regiones superpuestas. Mínimo uso de 

memoria, pero mayor redibujado (para tarjetas gráficas que realizan flipping). 

o Full: Realiza un redibujado completo a cada momento. Sólo utilizar para 

referencia, o en caso de que todo lo demás fracase. 

 Limit Size: Limita la resolución máxima a imágenes utilizadas en textured display 

para el ahorro de memoria. 

 Time Out: Tiempo desde el último acceso a una textura GL en segundos, luego de lo 

cual es liberado. Déjelo en 0 para mantener asignadas las texturas. 

 Collection Rate: Cantidad de segundos entre cada ejecución del recolector de basura 

de texturas GL. 

Solid OpenGL lights 

Cuando el visor en una ventana 3D es colocado en solid view, hay tres fuentes de luz 

virtuales (usted no puede verlas en los renders) usadas para iluminar la escena. La 

dirección, y la iluminación difusa y especular de aquellas luces pueden ser cambiadas aquí. 

International Fonts 

Es posible cambiar el idioma predeterminado 

de Blender (inglés) y traducir tanto la 

interface como la descripción de cada 

herramienta. 

Haga click en International Fonts para marcar la casilla con un cheque como se muestra en 

la imagen. Luego, seleccione de la lista donde dice Default, el idioma de su preferencia. 

Por último, click para chequear las casillas de Interface y Tooltips. 

 

 



Renderizado 

¿Qué es el renderizado? 

Blender crea una imagen al aplicar diversos materiales, texturas, iluminación, 

composición, etc para crear un resultado final. 

 

Ajustando la resolución 

Primero de todo, debería ajustar la resolución final (por defecto es puesta a 25%), la mejor 

calidad se encuentra a 100%, aunque este valor puede incrementarse aún más allá de 

100%, pudiendo colocar por ejemplo, una imagen del doble del tamaño: 200%, que sería 

equivalente a 4 veces la superficie de la primera en 100%. 

Tenga cuidado: Cuanto más grande sea, mayor tiempo le tomará renderizar la escena. 

 

Formato de salida y salida de archivo 

Seguidamente necesita elegir un formato de salida y dónde desea crear su animación 

renderizada (Por defecto, es guardado en /tmp o /TPW.). Aquellos directorios se pueden 

encontrar en: "C:/" en windows, o en root /tmp, en Linux. Para windows recomendamos 

usar el codec AVI para las animaciones. 

 

Renderizando una imagen 

Atajo de teclado: F12 

Para abortar el render o simplemente quitarlo, presione ESC. 

 

Guardando su imagen 

Blender no guarda su imagen 

automáticamente: haga click en 

save as para almacenarlo en su 

computadora (o F3). 

 

 

 



Renderizando una animación 

Para crear una animación, vaya a: Properties: Render y presione Animation o use la 

combinación de teclas Ctrl F12. 

 

Capturas de pantalla 

Para facilitar el trabajo en equipo y obtener prototipos rápidamente, quizá quiera tomar una 

captura rápida de su ventana o la configuración entera de las ventanas de Blender. 

Ctrl F3 toma una captura de su ventana activa, y abre una ventana de "guardado", el File 

Browser, que le permite especificar la posición y nombre del archivo. 

Capturas de pantalla en el Sistema Operativo 

Use el sistema operativo para capturar la ventana en su portapapeles. Luego puede pegar la 

imagen desde el portapapeles en su editor de imagen. 

Para Windows, presione Ctrl Prtscr para capturar la pantalla en el portapapeles. 

 

Modelado en Blender 

Como ha visto en los capítulos de iniciación Un hombre de jengibre estático, la creación de 

una escena 3D necesita al menos 3 cosas vitales; Modelos, Materiales y Luces. En esta sección 

se investigará más profundamente al Modelado. Modelar es el arte y ciencia de crear una 

superficie que imita la forma de un objeto del mundo real o ajustar su imaginación a objetos 

abstractos. 

Los objetos vienen en muchas formas y tamaños, por lo que Blender dispone de muchas 

herramientas diferentes para ayudarle a hacer su modelado rápida y eficientemente: 

 Objetos: Trabajar con los objetos en su conjunto 

 Mallas: Trabajar con la malla que define la forma de un objeto 

 Curvas: Usar curvas para modelar y controlar objetos 

 Superficies: Modelar una superficie NURBS 

 Texto: Herramientas de texto para colocar palabras en el espacio 3D. 

 Meta: Objetos Globos y Glóbulos 

 Duplicaciones: Duplicar objetos 

 Modeling Scripts: Desde que la funcionalidad de Blender puede extenderse vía 

Python, existen un número de scripts muy útiles que lo asisten durante el modelado. 

http://wiki.blender.org/index.php/Doc:ES/2.6/Manual/Your_First_Animation/1.A_static_Gingerbread_Man
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Mucha gente utiliza el "box modeling", en el que se comienza con un cubo base y se procede 

con extruír caras y mover vértices para crear una malla más grande y compleja. Para objetos 

planos, como paredes y tablas de mesa, puede utilizar el "curve modeling", que define el 

bosquejo utilizando curvas Bézier o Nurbs, y luego las extruye al espesor deseado. Cualquiera 

de los métodos está totalmente soportado en Blender utilizando sus herramientas de modelado. 

Objetos Empty 

El "Empty" es un objeto nulo. No contiene geometría real, pero se puede usar como un 

manipulador para muchos propósitos. 

Configuración 

 Plain Axes: Se dibuja como seis líneas en cada dirección de los ejes +X,-X,+Y,-Y,+Z 

y -Z. 

 Arrows: Se dibuja como flechas apuntando a los ejes X, Y y Z, en sentido positivo, 

cada uno con una etiqueta. 

 Single Arrow: Se dibuja como una sola flecha apuntando al eje +Z. 

 Circle: Se dibuja como un círculo en el plano XZ. 

 Cube: Se dibuja como un marco de cubo. 

 Sphere: Se dibuja como una esfera implementada definida por 3 círculos. 

 Cone: Se dibuja como un cono, apuntando al eje +Y. 

 Image: Los objetos empty ahora pueden mostrar imágenes. Esto se puede usar para 

crear imágenes de referencia, incluyendo blueprints o hojas de personaje desde las que 

modelar, en vez de usar imágenes de fondo (background). La imagen se muestra sin 

importar el modo 3D mostrado. La configuración es la misma que en Configuración de 

Imagen de Fondo (Background) 

 Size: Controla el tamaño local del empty. Esto no cambia su escala, sino que 

simplemente modifica el tamaño de la forma. 

 
Uso y Funciones 

Pueden servir como manipulador de una transformación, que no puede ser editado y no se 

renderiza. Los objetos empty son importantes y útiles. Algunos ejemplos de los modos de 

usarlos incluyen: 
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Padre de un grupo de objetos 

 Un Empty puede ser el padre de 

cualquier número de objetos 

diferentes. Esto proporciona al 

usuario la habilidad de controlar 

un grupo de objetos fácilmente 

sin afectar al renderizado. 

Objetivo de restricciones 

 Un Empty también puede usarse 

como objetivo de restricciones 

normales o de hueso.  

 Esto da al usuario mucho más control, por ejemplo se puede configurar fácilmente un 

rig para habilitar que una cámara apunte hacia un Empty usando la restricción Track 

to. 

Offset de array 

 Se puede usar un Empty como offset de un modificador array, lo que se traducirá en 

que se podrá alcanzar complejas deformaciones simplemente moviendo un sólo objeto. 

Modo Edición 

 

 

 

 

 

 

 

 

 

 

 

 

 

Un ejemplo de un empty siendo usado para 

controlar un array 

Un ejemplo de un empty siendo usado para 

controlar el seguimiento a una restricción 

Los ocho tipos de empty diferentes que se pueden dibujar vistos desde 

arriba 



Ingresando al Modo Edición 

Puede trabajar con objetos geométricos en dos modos. 

Modo Objeto: Las operaciones en  Modo Objeto  afectan el objeto entero. 

El modo Objeto tiene la siguiente cabecera en la Vista 3D: 

 

Cabecera del Modo Objeto 

Modo Edición 

Las operaciones en el Modo Edición afectan sólo la geometría de un objeto, pero no 

sus propiedades globales como la posición o la rotación. El Modo Edición posee la 

siguiente cabecera en la Vista 3D: 

 

Cabecera del Modo Edición 

 

Las herramientas y los modos en la cabecera de la Vista 3D son (de izquierda a derecha): 

 Ver (View), Seleccionar (Select) y Menús de Malla (Mesh) 

 Modo de Blender (Edición y Objeto) 

 Método de dibujado para la Vista 3D 

 Centro de Pivotaje 

 Manipulador 3D 

 Modo de Selección 

 Búfer de Profundidad para recorte en vista sólida (Ocultación) 

 Edición Proporcional 

 Ajuste 

 Render OpenGL 

Puede alternar entre esos dos modos con la tecla ⇆ Tab  ó seleccionando el Mode deseado en 

el menú de cabecera de la Vista 3D. 

Luego de crear un objeto puede ser inmediatamente ubicado en Modo Edición – dependiendo 

de si el botón Cambiar a Modo Edición (Switch to Edit Mode) se encuentra habilitado en la 

pestaña Edición (Editing) de las Preferencias de Usuario (User Preferences). El Modo 

Edición sólo aplica a un objeto a la vez, el activo, o el objeto más recientemente seleccionado.  

http://wiki.blender.org/index.php/Doc:2.6/Manual/Modeling/Objects
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Visualización 

 

Un Cubo seleccionado 

 

Dos Cubos seleccionados antes de ingresar al Modo Edición 

Por defecto, Blender resalta en naranja la geometría seleccionada en ambos 

modos, Objeto yEdición. El color puede ser cambiado en las Preferencias de 

Usuario ( CtrlAltU →Themes.) 

En Modo Objeto con el sombreado Wireframe habilitado ( Z ), los objetos son mostrados en 

negro cuando no se encuentran seleccionados y en naranja cuando lo están. Si más de un 

objeto es seleccionado, todos los objetos seleccionados excepto el objeto activo, usualmente el 

último seleccionado, es mostrado en un color naranja más oscuro. Similarmente, en Modo 

Edición, la geometría no seleccionada es dibujada en negro mientras las caras, aristas y 

vértices seleccionados son dibujados en naranja. El objeto activo es resaltado en blanco. 

En Modo Edición, sólo uno objeto puede ser editado a la vez. Sin embargo, varios objetos 

pueden ser unidos en una única malla con ( CtrlJ  en el Modo Objeto) y luego pueden ser 

separados nuevamente con ( P  en el Modo Edición). Si múltiples objetos son seleccionados 

antes de ingresar al Modo Edición, todos los objetos seleccionados permanecen resaltados en 

naranja indicando que son parte del conjunto seleccionado. 

Si dos vértices unidos por una arista están seleccionados en el Modo de selección de Vértice, 

la arista entre ellos es resaltada también. Similarmente, si son seleccionados suficientes 

vértices o aristas para definir una cara, aquella cara también será resaltada.  

http://wiki.blender.org/index.php/File:25-manual-editmode-cubeselect-1.png
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Barra de Herramientas 

 

El panel Barra de Herramientas en Modo Edición (panel separado en dos partes por razones 

de disposición) 

Para Abrir/Cerrar el panel de las Herramientas de Malla puede utilizar T . Al ingresar alModo 

Edición, varias herramientas de malla se vuelven disponibles. 

La mayoría de aquellas herramientas también se encuentran disponibles como atajos de 

teclado (mostrados en los Menúes para cada herramienta) y/o en el menú Specials accesible 

con ( W ), el menú Arista con CtrlE , y el menú Cara con CtrlF . Para cada herramienta un 

menú contextual dependiente es abierto en la zona inferior de la Barra de Herramientas. 

Aún más herramientas de edición de malla pueden ser habilitados en las User Preferences' 

sección Add-Ons. El desarrollo de nuevas herramientas es regularmente anunciado en sitios y 

foros relacionados con Blender. 

Para información adicional acerca de los paneles, vea la sección Referencia de Paneles.  

Properties Shelf 

 

 

 

 

 

 

 
El panel Properties Shelf enModo 

Edición (panel separado en dos partes por 

razones de disposición) 
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Vértices, Aristas y Caras 

En mallas básicas, todo es construído a partir de estructuras básicas: Vértices, Aristas y Caras (no estamos 

hablando de curvas, ni de NURBS aquí). Pero no hay necesidad de decepcionarse: esta simplicidad aún nos 

provee con una riqueza de posibilidades que serán la base para todos nuestros modelos.  

 

Vértices 

 

Ejemplo de Vértice 

 

 

Un vértice es primeramente un único punto o posición en el espacio 3D. Usualmente es 

invisible para el render y para el Modo Objeto. No confunda el punto central de un objeto con 

un vértice. Se ven similares, pero el punto central es más grande y no se puede 

seleccionar.Ejemplo de Vértice le muestra el punto central etiquetado como ―A‖. En esta caso, 

los vértices son ―B‖ y ―C‖. 

Una manera sencilla para crear nuevos vértices es cliquear con CtrlLMB  en Modo Edición. 

Por supuesto, como la pantalla de una computadora es bidimensional, Blender no puede 

determinar las tres coordenadas del vértice desde un simple click del mouse, por lo que el 

nuevo vértice es ubicado a la profundidad en la que se encuentra el Cursor 3D. Utilizando el 

método descrito más arriba, el vértice C es un nuevo vértice añadido al cubo con una nueva 

arista entre ambos vértices B y C.  

Aristas 

Una arista siempre conecta dos vértices por una línea recta. Las aristas son la "estructura" que 

puede ver cuando observa una malla en el modo de visualización de alambre. Son usualmente 

invisibles en la imagen del render. Son utilizados para construír caras. Cree una arista 

seleccionando dos vértices y presionando F .  

 

Caras 

Una cara es la estructura de nivel superior en una malla. Las caras son utilizadas para construír 

la superficie del objeto. Son lo que puede ver cuando observa el render de una malla. Una cara 

es definida como el área de tres vértices (triángulo) o el de cuatro vértices (cuadrángulo), con 

una arista en cada lado. Los triángulos son siempre planos y por lo tanto, fáciles de calcular. 

Por otro lado, los cuadrángulos se "deforman bien" y son preferidos para el modelado basado 

en subdivisión. 

http://wiki.blender.org/index.php/File:25-Manual-Mesh-Structures-CubeExample.png
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Tenga cuidado cuando utilice caras de cuatro lados (quads), porque internamente también son 

divididos en dos triángulos cada uno. Las caras de cuatro lados sólo funcionan bien si la cara 

es lo suficientemente plana (todos los puntos se mantienen dentro de un plano imaginario) y 

convexo (el ángulo de los extremos es mayor que 180 grados). Éste es el caso con las caras de 

un cubo, por ejemplo. Esa es la razón por la que no puede ver ninguna línea diagonal en la 

vista de alambre de su modelo, porque dividirían cada cuadrado en dos triángulos. 

Usted puede construir un cubo con caras triangulares, pero éste se verá mucho más confuso 

en Modo Edición. Un área de entre tres o cuatro vértices, delineado por aristas, no necesita ser 

una cara. Si este área no contiene una cara, simplemente se verá transparente o no existirá en 

la imagen renderizada. Para crear una cara, seleccione tres o cuatro vértices apropiados y 

presione F .  

 

Circuitos 

 

Circuitos de Arista y Cara 

Los circuitos de Arista y Cara son conjuntos de caras o aristas que conforman "circuitos" 

como se muestran en (Circuitos de Arista y Cara). La fila superior (1-4) muestra una vista 

sólida, la fila inferior (5-8) una vista de alambre de los mismos circuitos. 

Note que los circuitos 2 y 4 no se van a lo largo de todo el modelo. Los circuitos se detienen 

en los llamados polos debido a que no hay un único camino para continuar un circuito desde 

un polo. Los polos son vértices que están conectados a tres, cinco o más aristas. De esta 

manera, los vértices conectados exactamente a una, dos o cuatro aristas, no son polos. 

En la imagen superior, los circuitos que no terminan en los polos son cíclicos (1 and 3). 

Comienzan y terminan en el mismo vértice y dividen el modelo en dos porciones. Los 

circuitos pueden ser una rápida y poderosa herramienta para trabajar con regiones específicas 

y continuas de una malla y son un prerequisito para la animación de personajes orgánicos. 

Para unas descripciones más detalladas de cómo trabajar con circuitos en Blender, por favor, 

refiérase a la siguiente página del Manual en Edge and Face Tools.  

Circuitos de Aristas 

Los circuitos 1 y 2 en (Circuitos de Arista y Cara) son circuitos de aristas. Conectan vértices 

de manera que cada uno en el circuito tenga dos vecinos que no se encuentran en el circuito y 

http://wiki.blender.org/index.php/Doc:2.5/Manual/Modeling/Meshes/Selection#Advanced_Selection_Tools
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que se encuentran ubicados a ambos lados del circuito (excepto los vértices iniciales y finales 

en el caso de los polos). 

Los circuitos de aristas son un concepto importante especialmente en el modelado orgánico 

(subsuperficie) y la animación de personajes. Cuando son usados correctamente, le permite 

construir modelos con relativamente pocos vértices que se ven muy naturales cuando son 

utilizados como superficies de subdivisión y se deforman bien durante las animaciones. 

Por ejemplo, en los Circuitos de Aristas de los modelado orgánicos, el circuito de aristas sigue 

los contornos naturales y las líneas de deformación de la piel y de los músculos subyacentes y 

son más densos en áreas que se deforman más cuando el personaje se mueve, por ejemplo en 

los hombros y en las rodillas. 

Para detalles adicionales de cómo trabajar con Circuitos de Aristas, puede ver Edge Loop 

Selection.  

Circuitos de Caras 

Son una extensión lógica de los Circuitos de Aristas en el sentido de que consisten en caras 

entre dos circuitos de aristas, como se muestra en los circuitos 3 y 4 en (Circuitos de Arista y 

Cara). Note que para circuitos no circulares (4) las caras que contienen polos no son incluidos 

en los Circuitos de Caras. 

 

Objetos de Malla Básicos 

Modo: Modo Objeto 

Combinación de teclas: ⇧ ShiftA  

Menú: Add » Mesh 

 

Descripción 

Un tipo común de objeto usado en escenas 3D es la malla. Blender viene con un número de 

mallas "primitivas" que constituyen formas a partir de las que puede comenzar a modelar. 

http://wiki.blender.org/index.php/Doc:2.5/Manual/Modeling/Meshes/Selection#Edge_Loop_Selection
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Las diez primitivas de Blender 

Las opciones comúnmente incluídas en varias primitivas son: 

Radius 

Establece el tamaño inicial para Círculo, Cilindro, Cono, Esfera UV e Icoesfera. 

Depth 

Establece la longitud inicial para el Cilindro y Cono. 

 

Opciones 

Plane 

Un plano estándar contiene cuatro vértices, cuatro aristas y una cara. Es como un 

pedazo de papel sobre una mesa; no es un objeto tridimensional real, debido a que es 

plano y no posee espesor. Los objetos que pueden ser creados con planos incluyen 

pisos, mesas o espejos. 

Cube 

Un cubo estándar contiene ocho vértices, doce aristas, y seis caras, y es un objeto 

tridimensional real. Los objetos que pueden ser creados desde un cubo incluyen, dados, 

cajas o cajones. 

Circle 

Un círculo estándar está compuesto de n cantidad de vértices. El número de vértices y 

el radio puede ser especificado en el panel contextual ubicado en el Tool Shelf el cual 

aparece cuando el círculo es creado. Cuando el botón Fill está activo, el círculo será 

rellenado con caras triangulares los cuales comparten un vértice en el medio. Sin 

http://wiki.blender.org/index.php/File:Mesh-primitives.png


embargo, el círculo es tan solo una forma plana. Si no es rellenado y desea 

renderizarlo, debe asignar un material de alambre en el menú de materiales. El 

parámetro Radius ajusta el tamaño del círculo. 

Cuantos más vértices contenga el círculo, más suave será el contorno. En contraste, un 

círculo con tan solo 3 vértices, es en realidad un triángulo — el círculo es en realidad 

la manera estándar de agregar polígonos como triángulos, pentágonos, etcétera. 

UV Sphere 

Una esfera UV estándar es creada a partir de n segmentos y m anillos. El nivel de 

detalle y el radio puede ser especificado en el panel contextual del Tool Shelf el cual 

aparece cuando la esfera UV es creada. Incrementando el número de segmentos y 

anillos, hace que la superficie de la esfera UV se vuelva más suave. Los Segmentos son 

como los meridianos de la Tierra, yendo de polo a polo; y los Anillos son como los 

paralelos de la Tierra. Algunos ejemplos que pueden ser creados a partir de esferas UV 

son bolas, cabezas o perlas para collares. 

Icosphere 

Una icoesfera es una esfera hecha con triángulos. La cantidad de subdivisiones y el 

radio pueden ser especificados en el panel contextual del Tool Shelf cuando la 

Icoesfera es creada; al incrementar el número de subdivisiones, hace que la superficie 

de la Icoesfera sea más suave. En el nivel 1, la Icoesfera es un icosaedro, un sólido con 

20 caras triangulares equiláteras. Cualquier nivel de subdivisión adicional, divide cada 

cara triangular en cuatro triángulos, resultando en una apariencia más esférica. Las 

Icoesferas son usualmente utilizadas para lograr una disposición más isotrópica y 

económica de vértices que en el caso de una esfera UV. 

Cylinder 

Un cilindro estándar está constituido por n cantidad de vértices. El número de vértices 

en la sección circular puede ser especificada en el panel contextual del Tool Shelf que 

aparece cuando el objeto es creado; a una mayor cantidad de vértices, más suave será 

la superficie de la sección circular. Los parámetros de Radio y Profundidad controlan 

las dimensiones del cilindro. Los objetos que pueden ser creados desde cilindros, 

incluyen manivelas o barras. 

Si Cap Ends está desactivado, el objeto creado será un tubo. Los objetos que se pueden 

crear a partir de tubos incluyen pipas y vasos de agua (La diferencia básica entre un 

cilindro y un tubo es que la forma tiene los extremos cerrados). 

 



Cone 

Un cono estándar está compuesto por n cantidad de vértices. El número de vértices en 

la base circular, dimensiones y opciones para cerrar la base del cono puede ser 

especificada en el panel contextual del Tool Shelf que aparece cuando el objeto es 

creado; a mayor cantidad de vértices, más suave se vuelve la base circular. Los objetos 

que pueden ser creados a partir de conos incluyen puntas o sombreros puntiagudos. 

Torus 

Una primitiva con forma de rosquilla es creada al rotar un círculo alrededor de un eje. 

Las dimensiones completas se definen mediante el Radio Mayor y el Radio Menor. El 

número de vértices (en segmentos) puede ser diferente para los círculos y es 

especificado en el panel contextual del Tool Shelf tanto con Segmentos mayores como 

con Segmentos menores. 

Grid 

Una grilla estándar está compuesta por n y m cantidad de vértices. La resolución del 

eje X y el eje Y puede ser especificado en el panel contextual del Tool Shelf el cual 

aparece cuando el objeto es creado; a mayor resolución, más vértices serán creados. Un 

ejemplo de objetos que pueden ser creados a partir de grillas incluyen paisajes (con la 

herramienta de edición proporcional o el modificador Desplazar); y otras superficies 

orgánicas. También puede obtener una grilla cuando crea un plano y utiliza un 

modificador de subdivisión en Modo edición. Sin embargo, existe un añadido 

llamado Landscape disponible en las Preferencias de Usuario que le otorga un control 

mucho más fino y complejo que las grillas genéricas. 

Monkey 

Este es un regalo de la antigua empresa Not A Number para la comunidad y es visto 

como un chiste de programación o un "Huevo de Pascuas". Crea una cabeza de mono 

una vez que presiona el botón Monkey. El nombre del mono es "Suzzanne" y es la 

mascota de Blender. Suzanne es muy útil como una malla estándar de testeos, así como 

sucede con la Tetera de Utah o el Conejo de Stanford. 

 

 

 

 

 

http://en.wikipedia.org/wiki/Utah_teapot
http://en.wikipedia.org/wiki/Stanford_Bunny


Añadidos 

 

Algunas de las mallas primitivas disponibles como añadidos. 

En adición a las primitivas geométricas básicas, Blender contiene un número en incremento de 

scripts que generan mallas, que se ofrecen como añadidos preinstalados. Aquellos se vuelven 

disponibles cuando son habilitados en la sección de Añadidos (Add-ons) de las Preferencias de 

Usuario. Puede filtrar la lista como Add Mesh). Solo unas pocas son mencionadas aquí: 

Landscape 

Añade una primitiva de paisaje. Muchos parámetros y filtros aparecen en el Tool Shelf. 

Pipe Joints 

Añade uno de cinco distintas primitivas tipo juntas de pipa. El Radio, el ángulo y otros 

parámetros pueden ser cambiados en el Tool Shelf. 

 

Gears 

Añade un engranaje o un Tornillo sin fin el cual contiene muchos parámetros para 

controlar la forma en el Tool Shelf. 

Edición Proporcional 

Modo: Modo Edición 

Combinación de teclas: O  / AltO  / ⇧ ShiftO  

Menú: Mesh → Proportional Editing 

Cuando trabaja con geometría muy densa, puede resultar difícil hacer finos ajustes a los 

vértices sin causar feos bultos y pliegues en la superficie del modelo. Cuando se encuentra 

http://wiki.blender.org/index.php/Extensions:2.6/Py/Scripts/Add_Mesh/ANT_Landscape
http://wiki.blender.org/index.php/Extensions:2.6/Py/Scripts/Add_Mesh/Add_Pipe_Joints
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frente a situaciones como ésta, utilice la herramienta de edición proporcional. Actúa como un 

imán para deformar suavemente la superficie del modelo, sin crear abolladuras o arrugas, al 

modificar también vértices deseleccionados dentro de un rango dado, no solo los 

seleccionados. 

 

 

Opciones 

 

Ícono de Edición Proporcional. 

 

Menú de Atenuación. 

El modo de Edición Proporcional está disponible en Modo Edición, en la cabecera de la Vista 

3D. 

Off ( O ) 

La Edición proporcional está desactivada, sólo los vértices seleccionados serán 

afectados. 

On ( O  o AltO ) 

Otros vértices además de los seleccionados son afectados, dentro de un radio definido. 

Connected ( AltO ) 

En lugar de utilizar sólo el radio, la atenuación proporcional se propaga a través de de 

la geometría conectada. Esto significa de que puede fácilmente editar 
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proporcionalmente los vértices de un dedo en una mano, sin afectar los otros dedos, ya 

que aunque los otros vértices están espacialmente cercanos, se encuentran muy 

distantes siguiendo la topología con conexiones de aristas de la malla. El ícono será 

limpiado (coloreado en gris) en el centro cuando Connected sea activado. 

Falloff 

Cuando se encuentra editando, puede cambiar el perfil de la curva utilizado tanto el 

menúMesh → Proportional Falloff, y usando el ícono de la barra de herramientas 

(Falloff menu), o presionando ⇧ ShiftO  para intercambiar entre las distintas opciones. 

 

 

 

Círculo de Influencia. 

 

Influencia 

Puede incrementar o decrementar el radio de la edición proporcional con la rueda del 

ratón WheelUp / WheelDown  o PageUp / PageDown respectivamente. A medida 

que cambie el radio, los puntos al rededor de su selección ajustarán su posición de 

acuerdo a él. 
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Ejemplos 

Cambie a una vista frontal ( 1 NumPad ) y active la herramienta de arrastrar con G . Cuando 

arrastre el punto hacia arriba, note cómo los vértices cercanos son arrastrados con él. Cuando 

esté satisfecho con el desplazamiento, cliquee con LMB  para fijar la posición. Si no está 

satisfecho, cancele la operación y vuelva la malla a la forma en que se veía antes con RMB 

 (o la tecla Esc ). 

Puede utilizar la herramienta de edición proporcional para producir buenos efectos con el 

escalado ( S ) y la herramienta de rotación ( R ), como se ve en "Un paisaje obtenido a través 

de la Edición Proporcional". 

 

Un paisaje obtenido a través de la Edición Proporcional. 

Combine esas técnicas con el pintado de vértices para crear fantásticos paisajes. "Paisaje final 

renderizado" muestra el resultado de la edición proporcional luego de la aplicación de texturas 

y luces. 

 

Paisaje final renderizado. 
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Seleccionando Componentes de Malla 

Existen muchas formas de seleccionar elementos, y depende de en qué Modo de Selección de 

Malla esté como también de qué selecciones están disponibles. Primero iremos a través de 

aquellos modos y luego haremos un paneo a las herramientas básicas de selección.  

 

Modos de Selección 

Herramientas del Modo de Selección de la Cabecera 

 

Botones de selección enModo Edición (Vértices, Aristas, Caras, Limitar a lo Visible) 

En Modo Edición existen tres modos distintos de selección. Puede ingresar a los diferentes 

modos seleccionando uno de los tres botones en la barra de herramientas. 

Utilizando los botones también puede ingresar a un modo mixto cliqueando con⇧  

ShiftLMB  sobre los botones. 

Vertices 

Los vértices seleccionados son dibujados en naranja, los vértices no seleccionados, en 

negro; y el vértice activo o el último seleccionado, en blanco. 

 

Edges 

En este modo los vértices no son dibujados. En lugar de ello, las aristas seleccionadas 

son las que se dibujan en naranja, las aristas no seleccionadas en negro, y el último o 

activo, en blanco. 

Faces 

En este modo las caras son dibujadas con un punto de selección en el medio, el cual es 

utilizado para seleccionar la cara. Las caras seleccionadas y su punto de selección son 
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dibujados en naranja, las caras deseleccionadas son dibujadas en negro, y la última 

cara seleccionada o cara activa es resaltada en blanco. 

Casi todas las herramientas de modificación están disponibles en los tres modos de selección 

de malla. Por lo que puede Rotar,Escalar, Extruír, etc. en todos los modos. Desde luego la 

rotación y el escalado de un único vértice no harán nada útil, por lo que algunas herramientas 

son más o menos aplicables en todos los modos. 

 

 

Menú desplegable del Modo de Selección 

Modo: Modo Edición 

Combinación de teclas: Ctrl⇆ Tab  

 

Menú deModo de Selección de Malla 

También puede elegir un modo de selección con el menú desplegable 

Select Mode » Vertex 

Presione Ctrl⇆ Tab  y seleccione Vertices desde el menú desplegable, o 

presione Ctrl⇆ Tab1 . 

Select Mode » Edge 

Presione Ctrl⇆ Tab  y seleccione Edges desde el menú desplegable, o presione Ctrl⇆  

Tab2 . 

Select Mode » Face 

Presione Ctrl⇆ Tab  y seleccione Faces desde el menú desplegable, o presione Ctrl⇆  

Tab3 . 
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Intercambiando entre los Modos de Selección 

Cuando intercambia el modo de selección, desde Vértices a Aristas y desde Aristas a Caras, 

las partes seleccionadas aún quedarán seleccionadas si conforman un conjunto completo en el 

nuevo modo de selección. Por ejemplo, si las cuatro aristas de una cara están seleccionadas, 

cambiando desde el modo de Aristas a Caras mantendrá la cara seleccionada. Todas las partes 

seleccionadas que no forman un conjunto completo en el nuevo modo serán deseleccionadas.  

Elementos seleccionados luego de cambiar entre los modos de selección 

Cuando cambia los modos en forma "ascendente" (por ejemplo, desde uno más simple a uno 

más complejo), desde Vértices a Aristas y desde Aristas a Caras, las partes seleccionadas aún 

se mantendrán seleccionadas si conforman un conjunto completo de elementos en el nuevo 

modo. 

Por ejemplo, si las cuatro aristas en una cara están seleccionadas, cambiando desde el modo 

de Aristas a Caras mantendrá la cara seleccionada. Todas las partes seleccionadas que no 

forman un conjunto completo en el nuevo modo serán deseleccionadas. 

Por lo tanto, intercambiando de forma "descendente" (por ejemplo, desde uno más complejo a 

uno más simple), todos los elementos que definen el "nivel alto" (como una cara) serán 

seleccionados (los cuatro vértices o aristas de un cuadrángulo, por ejemplo). 

Manteniendo Ctrl  cuando selecciona un modo más elevado, todos los elementos que están en 

contacto con la selección activa serán añadidos, incluso si la selección no conforma por 

completo un elemento más elevado. 

Véa (Modo de Vértices de ejemplo), (Modo de Aristas de ejemplo), (Modo de Caras de 

ejemplo) y (Modo mixto de ejemplo) para varios ejemplos de los distintos modos. 

 

Modo de Vértices de ejemplo. 

 

Modo de Aristas de ejemplo. 
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Modo de Caras de ejemplo. 

 

Modo mixto de ejemplo. 

 

Selección Básica 

Modo: Modo Edición 

Combinación de teclas: RMB  y ⇧ ShiftRMB  

La forma más común para seleccionar un elemento es presionar con RMB  sobre aquél 

ítem, esto reemplazará la selección existente con el nuevo ítem.  

 

Añadiendo a una Selección 

Para añadir a la selección existente mantenga presionado ⇧ Shift  mientras hace click con el 

botón derecho del ratón. Cliqueando nuevamente sobre el ítem seleccionado lo deseleccionará. 

Como en el Modo Objeto, hay un único elemento activo, mostrado en un color más claro (por 

lo general, el último elemento seleccionado). Dependiendo de las herramientas utilizadas, ¡este 

elemento puede ser muy importante! 

Note que no existe opción para elegir qué elemento seleccionar entre los que están 

superpuestos (como el comando con AltRMB  en Modo Objeto). Sin embargo, si se 

encuentra en el modo de visualización sólida, sombreada o texturada (no de caja o de vista de 

alambre), tendrá un cuarto botón que se ve como un cubo, justo al lado de los modos de 

selección. 

Cuando se encuentra habilitado, esto limita la posibilidad de seleccionar basado en los 

elementos visibles (tal cual si el objeto fuese sólido), y previene de seleccionar, mover, 

eliminar o cualquier otro trabajo accidental en la zona posterior o de ítems ocultos.  
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Seleccionando Elementos en una Región 

Modo: Modo Edición 

Combinación de teclas: B , BB , y cliquear y arrastrar con CtrlLMB  

La selección de Región le permite seleccionar grupos de elementos dentro de una región 

bidimensional en su vista 3D. La región puede tratarse de un círculo o un rectángulo. La 

región circular está sólo disponible en Modo Edición. La región rectangular o "Selección de 

Borde", está disponible tanto en Modo Edición como en Modo Objeto. 

 

Región rectangular (Selección de Borde) 

La Selección de Borde está disponible tanto en Modo Edición como en Modo Objeto. Para 

activar la herramienta utilice la tecla B . Use la Selección de Borde para seleccionar un grupo 

de objetos dibujando un rectángulo mientras mantiene presionado con LMB . Al hacer esto 

seleccionará todos los objetos que quedan dentro o que toquen este rectángulo. Si algún objeto 

que estuvo como el último activo aparece dentro del grupo, se mantendrá 

seleccionado y activo. 

 

Comenzando. 

 

Seleccionando. 

 

Completo. 

En Comenzando., la Selección de Borde ha sido activada y es indicada mostrando un cursor 

punteado. En Seleccionando., laregión de selección es elegida al dibujar un rectángulo 

con LMB . El área de selección se encuentra cubriendo solamente los tiradores de las tres 

caras. Finalmente, al soltar LMB  la selección se completa; véa Completo. 

Región Circular 

Ésta herramienta de selección está solamente disponible en Modo Edición y puede ser activada 

con el atajo C . Una vez que se encuentra en este modo, el cursor cambiará a una cruz 
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punteada con un círculo 2D a su alrededor. Esta herramienta operará estando en cualquier 

modo de selección (Vértice, Arista o Cara). Cliqueando o arrastrando con LMB , cuando 

los elementos se encuentran dentro del círculo, causará que aquellos elementos queden 

seleccionados. 

Puede agrandar o encojer la región circular utilizando + NumPad  y - NumPad , o la Rueda  

del ratón . 

Selección de Región Circular 

 

 

 

 

 

 

 

Selección de Región Circular es un ejemplo de la selección de aristas en el Modo de Selección 

de Arista. Tan pronto como una arista es interseccionada con el círculo, la arista se queda 

seleccionada. La herramienta es interactiva por lo que aquellas aristas son seleccionadas 

mientras que la región circular está siendo arrastrada con LMB . 

Si desea deseleccionar elementos puede tanto mantener presionado MMB  o AltLMB  y 

comenzar cliqueando o arrastrando nuevamente. 

Para el modo de selección de Caras, el círculo debe intersectar los indicadores de la cara, 

usualmente representados por unos pequeños píxeles cuadrados; uno en el centro de cada cara. 

Para salir de esta herramienta cliquee con RMB , o presione la tecla Esc .  

 

Región de Lazo 

La selección de Lazo es similar a la selección de Borde en el sentido de que selecciona objetos 

basados en una región, excepto porque el Lazo es una región dibujada a mano que 

generalmente conforma una forma circular/redondeada; tal como un lazo. 

El Lazo está disponible tanto en Modo Edición como en Modo Objeto. Para activar la 

herramienta utilice CtrlLMB  mientras arrastra. La diferencia principal entre la selección 

de Lazo y la de Borde es que en el Modo Objeto, el Lazo solo selecciona los objetos donde la 

región del lazo intersecta los centros de los objetos. 

Antes 

Antes 

Después 
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Para deseleccionar utilice Ctrl⇧ ShiftLMB  mientras arrastra. 

Selección de Lazo es un ejemplo de la utilización de la selección de Lazo en el Modo de 

Selección de Vértice.  

 

 

Herramientas Adicionales de Selección 

El menú de selección en modo edición contiene herramientas adicionales para la selección de 

componentes: 

 

Herramientas Básicas 

Select All/Select None A  

Selecciona todo o nada de los componentes de la malla. 

Invert Selection CtrlI  

Selecciona todos los componentes que no están seleccionados, y deselecciona los 

componentes actualmente seleccionados. 

More CtrlNum+  

Propaga la selección al añadir componentes que se encuentran adyacentes a los 

elementos seleccionados. 

Less CtrlNum-  

Deselecciona los componentes que conforman los límites de la selección actual. 

Herramientas Avanzadas 

Mirror 

Comenzando Seleccionando Completo 
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Selecciona elementos malla en la posición espejada. 

Linked CtrlL  

Selecciona todos los componentes que están conectados a la selección activa. 

Select Random 

Selecciona un grupo aleatorio de vértices, aristas o caras, basado en un valor 

porcentual. 

Select Every N Number of Vertices 

Selecciona vértices que son múltiplos de N. 

Select Sharp Edges 

Esta opción seleccionará todas las aristas que se encuentran entre dos caras formando 

un ángulo menor que el valor dado, el cual es solicitado mediante un pequeño diálogo 

desplegable. Cuanto menor sea el límite del ángulo, más afiladas serán las aristas 

seleccionadas. En 180°, todas las aristas múltiples serán seleccionadas (véa mas abajo). 

Linked Flat Faces ( Ctrl⇧ ShiftAltF ) 

Selecciona las caras conectadas basado en un umbral del ángulo entre ellas. Ésto es útil 

para seleccionar caras que no son planares. 

Select Non Manifold ( Ctrl⇧ ShiftAltM ) 

Selecciona vértices que no están completamente limitadas por geometría. Incluyendo 

bordes de aristas, aristas flotantes, y vértices huérfanos. Sólo disponible en el modo de 

selección de vértice. 

Interior 

Selecciona caras donde todas las aristas tienen más de 2 caras. 

Side of Active 

Selecciona todos los datos de la malla en un único eje 

Tris 

Selecciona todos los triángulos en la malla 



Quads 

Selecciona todos los cuadrángulos en la malla 

Loose 

Selecciona todos los vértices o aristas que no forman parte de una cara. 

 

Seleccionar Similar 

Modo: Modo Edición 

Combinación de teclas: ⇧ ShiftG  

Menú: Select » Similar to Selection 

Selecciona componentes que poseen atributos similares a los seleccionados, basado en un 

umbral que puede ser establecido en las propiedades de la herramienta luego de activarla. Las 

opciones de la herramienta cambian dependiendo del modo de selección 

Modo de Selección de Vértices 

Normal 

Selecciona todos los vértices que poseen normales similares a aquellas seleccionadas. 

Amount of Vertices in Face 

Selecciona todos los vértices que pertenecen exactamente al mismo número de caras 

como las que ya se encuentran seleccionadas. Por ejemplo, asumiendo que solo tiene 

un vértice seleccionado, si éste no pertenece a ninguna cara, ésta opción seleccionará 

todos los vértices que no estén involucrados con caras. 

Vertex Groups 

Selecciona todos los vértices que comparten uno o más grupos de vértices con aquellos 

que ya están seleccionados. 

 

Modo de Selección de Aristas 

Length 

Selecciona todas las aristas que poseen una longitud similar a aquellas seleccionadas. 

Direction 
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Selecciona todas las aristas que poseen una dirección similar (ángulo) a aquellos 

seleccionados. 

Amount of Vertices in Face 

Selecciona todas las aristas que pertenecen a exactamente el mismo número de caras 

que aquellas que ya están seleccionadas. Esto es lo mismo para el modo de selección 

de Vértice descrito arriba. 

Face Angles 

Selecciona todas las aristas que están entre dos caras conformando un ángulo similar, 

como aquellas ya seleccionadas. 

Crease 

Selecciona todas las aristas que poseen un valor de Pliegue similar a aquellos ya 

seleccionados. El valor de Plieguees un ajuste utilizado por el Subsurf Modifier. 

Seam 

Selecciona todas las aristas que tienen el mismo estado de Costura a aquellos ya 

seleccionados. Las Costuras son un ajuste de dos estados utilizado en UV-texturing. 

Sharpness 

Selecciona todas las aristas que poseen el mismo estado de Afilado a aquellos ya 

seleccionados. La opción deAfilado es un ajuste de dos estados (una bandera) utilizada 

por el EdgeSplit Modifier. 

 

Modo de Selección de Caras 

Material 

Selecciona todas las caras que utilizan el mismo material a aquellos ya seleccionados. 

Image 

Selecciona todas las caras que utilizan la misma textura UV a aquellas ya 

seleccionadas (véa las páginas de UV-texturing). 

Area 

Selecciona todas las caras que poseen un área similar a aquellas seleccionadas. 
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Perimeter 

Selecciona todas las caras que poseen un perímetro similar a aquellas seleccionadas. 

Normal 

Selecciona todas las caras que poseen una normal similar a aquellas seleccionadas. 

Ésta es una forma de seleccionar caras que tienen la misma orientación (ángulo). 

Co-planar 

Selecciona todas las caras que se encuentran cercanas al mismo plano que aquellas 

seleccionadas. 

 

Circuitos de Selección 

Puede fácilmente seleccionar circuitos de componentes: 

Selección de Circuitos de Aristas y Circuitos de Vértice 

Modo: Modo Edición → modo de selección de Vértice o Arista 

Combinación de teclas: AltRMB  o CtrlE  → Select » Edge Loop 

Menú: Select » Edge Loop o Mesh » Edges » Edge Loop 

Manteniendo Alt  mientras selecciona una arista selecciona un circuito de aristas que se 

encuentran conectadas en forma de línea de inicio a fin, pasando a través de la arista bajo el 

puntero del ratón. Manteniendo Alt⇧ Shift  mientras cliquea añade a la selección actual. 

Los circuitos de aristas pueden también ser seleccionados basados en una selección existente 

de aristas, utilizando tanto la opción Select » Edge Loop, o Edge Loop Select desde el 

menú Edge Specials accesible con CtrlE . 

 

Ejemplo 

 

Circuitos de Arista Longitudinales y Latitudinales. 
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La esfera de la izquierda muestra una arista que ha sido seleccionada longitudinalmente. Note 

cómo el circuito está abierto. Esto sucede porque el algoritmo llega a los vértices de los polos 

y finaliza debido a que la arista del polo está conectada a más de tres aristas. Sin embargo, la 

esfera de la derecha muestra una arista que ha sido seleccionada latitudinalmente y ha formado 

un circuito cerrado. Esto sucede debido a que el algoritmo llega a la primera arista desde la 

que partió, y finaliza.  

 

Selección de Circuitos de Caras 

Modo: Modo Edición → modo de selección de Caras o Vértices 

Combinación de teclas: AltRMB  

En el modo de selección de cara, manteniendo Alt  mientras selecciona una arista selecciona 

un circuito de caras que están conectadas en línea de inicio a fin, a lo largo de sus aristas 

opuestas. 

En el modo de selección de vértice, lo mismo se puede lograr utilizando CtrlAlt  para 

seleccionar una arista, el cual selecciona el circuito de caras implícitamente.  

 

Ejemplos 

 

Selección de Circuito de Caras. 

Este circuito de caras fue seleccionado cliqueando con Alt RMB  sobre una arista, en el 

modo de selección de cara. El circuito se extiende de forma perpendicular desde la arista que 

fue seleccionada.  

 

 

http://wiki.blender.org/index.php/File:Template-RMB.png
http://wiki.blender.org/index.php/File:Manual-Part-II-EdgeFaceTools-FaceLoopSel.png
http://wiki.blender.org/index.php/File:Template-RMB.png


 

Alt  versus CtrlAlt  en el modo de selección de vértice. 

Un circuito de caras también puede ser seleccionado en el modo de selección de Vértices, véa 

 Alt  versus CtrlAlt  en el modo de selección de vértice. Las aristas seleccionadas en la grilla 

etiquetada como ―Alt-RMB‖ es el resultado de seleccionar un circuito de aristas en 

contraposición a seleccionar un anillo de aristas. Debido a que en el modo de selección de 

vértice, seleccionando aristas opuestas de una cara implícitamente selecciona la cara entera, el 

circuito de cara ha sido implícitamente seleccionado. 

Note que en aquellos casos, el resultado generado por el algoritmo fue vértices debido a que 

estábamos en el modo de selección de Vértices. Sin embargo, de haber estado en el modo de 

selección de Aristas, el resultado generado hubiera sido aristas seleccionadas.  

 

Selección de Anillos de Aristas 

Modo: Modo Edición → modo de selección de Arista 

Combinación de teclas: CtrlAltRMB  o CtrlE  → Select » Edge Ring 

Menú: Select » Edge Ring o Mesh » Edges » Edge Ring 

En el modo de selección de Arista, manteniendo presionado CtrlAlt  mientras selecciona una 

arista se selecciona una secuencia de aristas que no están conectadas, pero que contiúan a lo 

largo de un circuito de caras. 

Como los circuitos de aristas, también puede seleccionar anillos de aristas basados en la 

selección actual, utilizando tanto la opción Select » Edge Ring, como Edge Ring Select del 

menú Edge Specials al presionar CtrlE . 

 

http://wiki.blender.org/index.php/Doc:2.6/Manual/Modeling/Meshes/Mesh_Structures
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Ejemplo 

 

Un circuito de aristas seleccionado y un anillo de aristas seleccionado. 

En Un circuito de aristas seleccionado y un anillo de aristas seleccionado, la misma arista ha 

sido cliqueada pero dos diferentes "grupos de aristas" han sido seleccionados, basados en los 

diferentes comandos. Uno está basado en las aristas durante la computación y el otro es basado 

en las caras.  

 

Circuito a Región y Región a Circuito 

Modo: Modo Edición → modo de selección de Arista 

Combinación de teclas: CtrlE  » 9 NumPad  y CtrlE  → Select » Loop to Region/Region to 

Loop 

Menú: Select » Loop to Region/Region to Loop o Mesh » Edges » Loop to Region/Region to 

Loop 

Circuito a Región examina el actual conjunto de aristas seleccionadas y las separa en grupos 

de "circuitos" de manera que cada una disecciona la malla en dos partes. Entonces, por cada 

circuito, selecciona la "mitad" más pequeña de la malla. Incluso funcionando en el modo de 

selección de Vértices y de Caras, el resultado utilizando aquellos podría ser extraño - debería 

mantenerse en el modo de selección de Aristas 

Región a Circuito es el "lógico inverso" de Circuito a Región, basado en todas las regiones 

actualmente seleccionadas, y selecciona solo las aristas en los bordes de aquellas regiones. 

Puede operar en cualquier modo de selección, pero siempre debería cambiar al modo de 

selección de Arista una vez aplicado. 

Todo esto es mucho más sencillo de ilustrar con ejemplos:  

http://wiki.blender.org/index.php/File:Manual-Part-II-EdgeFace-LoopingEdge-Algors-Select.png


 

Ejemplo: Circuito a Región 

 

Selección. 

 

Circuito a Región. 

 

Selección. 

 

Esta herramienta manipula bien múltiples circuitos, 

como puede ver. 

http://wiki.blender.org/index.php/File:Mesh.loop.select4.jpg
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Selección. 

 

Esta herramienta manipula igual de bien los "huecos" 

 

Ejemplo: Región a Circuito 

  

Selección.                               Este es el "lógico inverso" de Circuito a Región. 

 

Seleccionando Aristas 

Las Aristas pueden ser seleccionadas del mismo modo que los vértices y las caras -al cliquear 

con el boton derecho sobre ellos mientras que el modo de arista está activado. 

Circuitos de Aristas 

Los Circuitos de Aristas pueden ser seleccionados al seleccionar una arista o dos vértices, y 

yendo al menú Select>Edge Loop 

 

 

http://wiki.blender.org/index.php/File:Mesh.loop.select5.jpg
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Anillos de Aristas 

Los Anillos de Aristas son seleccionados de forma similar. 

 

Qué sucede si desea seleccionar las caras que se encuentran dentro de un anillo de aristas (no 

un circuito de aristas, ya que no existen caras dentro de un circuito de aristas). Si cambia al 

modo de selección de caras luego de seleccionar un anillo de aristas, verá que nada está 

seleccionado. ¿Por qué? Debido a que ninguna de aquellas caras tenía todos sus (cuatro) 

aristas seleccionadas, tan solo dos de ellas. Necesitará seleccionar las aristas superiores y las 

inferiores de cada una de aquellas caras (esto puede ser realizado seleccionando los circuitos 

de arista superior e inferior). 

Sin embargo, existe una forma más sencilla: justo luego de seleccionar un anillo de aristas, 

vaya a modo vértice. Ahora cada una de las aristas transfiere su selección a dos vértices, lo 

cual significa que ahora los cuatro vértices de la cara deseada están seleccionados. Esa es toda 

la información que posee Blender: Los cuatro vértices están seleccionados, no existe 

información acerca de qué aristas están seleccionadas o deseleccionadas. Lo cual significa que 

si vuelve al modo de arista, la selección de los vértices será trasladada a todas las aristas que 

http://wiki.blender.org/index.php/File:Edgeloop.png
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están entre ellos, por lo que ahora todas las aristas deseadas serán seleccionadas; o también si 

cambia a modo cara directamente, verá en realidad aquellas caras apropiadamente 

seleccionadas. 

 

Suavizado de Mallas 

 

 

Como se ha visto en las secciones previas, los polígonos son un elemento central en Blender. 

La mayoría de los objetos son representados por polígonos y los objetos verdaderamente 

curvos son también aproximaciones con mallas. Cuando renderiza imágenes, puede notar que 

aquellos polígonos aparecen como una serie de pequeñas caras planas. 

Algunas veces este es un efecto deseado, pero usualmente necesitamos que los objetos se vean 

agradables y suaves. Ésta sección le muestra cómo visualizar suaves los objetos, y cómo 

aplicar el filtro Auto Smooth rápida y fácilmente, y combinar polígonos suaves y facetados en 

el mismo objeto. 

La última sección en esta página le muestra las posibilidades para suavizar la geometría de una 

malla, no solamente su apariencia.  

 

Sombreado Suave 

La forma más sencilla es establecer un objeto entero como suave o facetado, seleccionando un 

objeto malla, y enModo Objeto cliquear Smooth en el Tool Shelf. Este botón no permanece 

presionado, y fuerza la asignación del atributo "suavizado" para las caras en la malla, incluso 

cuando añade o elimina geometría en Modo Edición. 

Note que la línea de contorno del objeto es aún altamente facetada. Activar la característica de 

suavizado en realidad no modifica la geometría del objeto; sólo cambia la forma en que el 

Malla de ejemplo, representada en plano; suavizada utilizando separación de arista; y utilizando Subdivisión de 

Superficie. Note cómo las aristas son representadas de manera distinta. 



sombreado es calculado a través de las caras, dando la ilusión de una superficie suave. Haga 

click en el botón Flat del Tool Shelf en el panel Shading para revertir el sombreado a aquél 

mostrado en la primera imagen de arriba.  

 

Suavizando partes de una malla 

Alternativamente, puede elegir qué aristas suavizar ingresando en Modo Edición, 

seleccionando algunas caras y cliqueando en el botón Smooth. Las aristas seleccionadas son 

marcadas en amarillo. 

Cuando la malla está en Modo Edición, sólo las aristas seleccionadas recibirán el atributo de 

"suavizado". Puede establecer aristas como planas (removiendo el atributo "suavizado") de la 

misma manera seleccionando las aristas y cliqueando en el botónFlat.  

Autosuavizado 

Puede resultar dificultoso crear ciertas 

combinaciones de caras sólidas y suaves 

utilizando solamente la técnica descrita más 

arriba. Aunque hay algunas maneras (como 

separar conjuntos de caras seleccionándolas 

y presionando Y ), existe una manera más 

sencilla para combinar caras suaves y 

sólidas, utilizando el Auto 

Smooth (Autosuavizado). 

El autosuavizado puede ser habilitado en el 

panel de malla en la ventana Properties. Los 

ángulos en el modelo que son menores que el 

ángulo especificado en el botón Angle serán 

suavizadas durante la representación (por 

ejemplo, en la vista 3D) cuando aquella parte 

de la malla es puesta en suavizar. Valores más altos producirá caras más suaves, mientras que 

valores más bajos se verán idénticos a una malla que ha sido completamente puesta en sólido. 

Note que una malla, o cualquier cara que ha sido colocada en Flat, no cambiará su sombreado 

cuando la opción Auto suavizado es activada: esto le permite obtener un control extra sobre 

qué caras serán suavizadas y cuáles no al obviar las decisiones tomadas por el algoritmo de 

Autosuavizado.  

 

 

Malla de ejemplo con Autosuavizado habilitado. 

http://wiki.blender.org/index.php/File:25-manual-meshsmooth-example-04rrautosmooth.png
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Modificador Separación de Arista 

 

Modificador Separación de Arista habilitado 

Con el modificador Edge Split se obtiene un resultado similar al Autosuavizado con la 

posibilidad de elegir qué aristas deberían ser separadas. 

Edge Angle  

Utiliza los ángulos entre aristas para determinar qué aristas separar. Es similar 

alAutosuavizado. El ángulo puede ser establecido entre 0° y 180°. 

Sharp Angles  

Utiliza las aristas marcadas como afiladas para determinar qué ángulos separar. 

EnModo Edición, se puede seleccionar un conjunto de Circuitos de Arista utilizando, 

por ejemplo, Alt⇧ ShiftRMB  y marcándolas como afiladas en el 

menú Edge (accesible con CtrlE >Mark Sharp.) 

 

 

 

 

Con una selección de Circuitos de Arista colocados enMark sharp, se puede controlar cómo la malla es representada. 
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Suavizando la geometría de la malla 

Las técnicas de arriba no alteran la malla en sí misma, sólo la forma en la que se muestran y 

son representadas. En lugar de hacer que la malla se vea como una superficie suave, también 

puede suavizar físicamente la geometría de la malla con éstas herramientas: 

Herramientas de Edición de Malla 

Puede aplicar una de las siguientes alternativas en Modo Edición: 

 Smooth 

Esto relaja los componentes seleccionados, resultando en una malla más suave. 

 Subdivide Smooth 

Ajustando el parámetro smooth y utilizando posteriormente la 

herramienta subdivide resulta en una forma más orgánica. Esto es similar a utilizar el 

modificador Subdivisión. 

 Bevel 

Esto bisela la arista seleccionada, causando que las aristas duras sean aplanadas. 

Modificadores 

Alternativamente, puede suavizar la malla de forma no destructiva con uno o varios de los 

siguientes modificadores: 

Modificador de Suavizado 

Trabaja como la herramienta Smooth en Edit mode; puede ser aplicada a partes 

específicas de la malla utilizando grupos de vértices. 

Modificador Bisel 

Trabaja como la herramienta Bevel en Edit mode; El Bisel puede ser establecido para 

que trabaje con un umbral de ángulo, o con valores de pesos de aristas. 
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Subsuperficie 

Modificador de Subdivisión de Subsuperficie 

El proceso de subdivisión de Catmull-Clark produce resultados suaves. Las aristas 

afiladas pueden ser definidas con subdivision creases o al establecer ciertas aristas para 

que sean "afiladas" y añadiendo un modificador de Separación de Arista(establecido 

en From Marked As Sharp) antes del modificador Subsurf. 

 

 

 

 

 

Ajuste de Transformación 

La habilidad de ajustar los componentes de malla a varios tipos de elementos de la escena está 

disponible al habilitar el ícono del imán en la cabecera de la vista 3D. En modo edición, puede 

forzar a los componentes seleccionados a mantenerse pegados a otros objetos. 

En versiones previas de Blender, la herramienta retopo ha sido utilizada para ajustar 

componentes a superficies, permitiendo a los usuarios crear nuevas topologías, o adaptar la 

forma de los objetos a la misma que la de otros. Esta funcionalidad está ahora disponible a 

través de las opciones de ajuste. 

  

Utilizando aristas plegadas, 

resultando en artefactos de 

subsuperficie. 

Circuitos de Arista extra 

añadidos 
Vista 3D mostrando aristas 

plegadas (rosado) y 

Circuitos de Arista añadidos 

(amarillo) 
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Modos de Ajuste 

Ajuste de Elemento 

Increment 

Ajusta a puntos de grilla. Cuando está en la vista Ortográfica, el incremento del ajuste 

cambia dependiendo del nivel de zoom. 

Vertex 

Ajustar a vértices de los objetos malla. 

Edge 

Ajustar a aristas de objetos malla. 

Face 

Ajustar a superficies o caras en objetos malla. Útil para retopologizar. Por defecto, si 

varios elementos son seleccionados, se ajustan a sus objetivos de caras como un todo. 

Al habilitar el botón que sigue al menú de ajuste, cada elemento será proyectado 

individualmente al objeto sobre el cual proyectar. 

Volume 

Ajusta a regiones dentro del volumen de los objetos; el primero que se encuentra 

debajo del cursor del ratón. A diferencia de los otros, esta opción controla (en el 

espacio de vista actual) la profundidad (por ejemplo, las coordenadas Z en el espacio 

de vista) del elemento transformado, el cual es ubicado en el actual "centro del 

volumen". Al habilitar el botón que aparece a la derecha del menú de ajuste, los 

objetos en los cuales proyectar serán considerados como un todo cuando se determine 

el centro del volumen. 

Ajuste Objetivo 

Las opciones del Ajuste del Objetivo son sólo efectivos en modo objeto.  

 

Subdivisión de Superficies 

Descripción 

La Subdivisión de Superficie es un método para subdividir las caras de una malla otorgándole 

una apariencia más suave, permitiendo el modelado de complejas superficies suaves con 

simples mallas de bajos polígonos. Esto le posibilita el modelado de mallas de alta resolución 

sin la necesidad de almacenar y mantener grandes cantidades de datos y otorgándole una 



apariencia suave muy orgánica al objeto. Con cualquier malla como punto de partida, Blender 

puede calcular una subdivisión suave al vuelo, mientras modela o mientras renderiza, 

utilizando una subdivisión simple (Subsuperficie), o el método más inteligente denominado 

Catmull-Clark.  

 

Opciones 

 

Modificador de Subdivisión de Superficie. 

Subdivision Surface es un modifier. Para añadirlo a una malla, seleccioneModifiers, 

presione Add Modifier y seleccione Generate→Subdivision Surfacedesde la lista. 

Type 

Este botón intercambiable le permite elegir el algoritmo de subdivisión: 

 Catmull-Clark – Opción por defecto, subdivide y suaviza las superficies. 

 Simple – Tan solo subdivide las superficies, sin suavizado alguno (similar 

a Levels; W  → Subdivide, en Modo Edición). ¡Raramente útil! 

View 

Define la resolución mostrada, o nivel de subdivisión para las vistas 3D de Blender. 

Render 

Este es el nivel de subdivisión utilizado durante el renderizado 

 

 

 

http://wiki.blender.org/index.php/Doc:2.4/Manual/Modifiers
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Subdivide UVs 

Cuando es habilitado, los mapas UV también serán subdivididos y suavizados (por 

ejemplo, Blender añadirá coordenadas "virtuales" para todas las sub caras creadas por 

este modificador). 

Optimal Display 

Restringe la vista de alambre para mostrar solamente las aristas de la caja de malla 

original, en lugar del resultado subdividido, para ayudar en la visualización. 

Pliegues con pesos para la subdivisión de superficies 

Modo: Modo Edición (Malla) 

Panel: 3D View → Transform Properties 

Menú: Mesh → Edges → Crease Subsurf 

Descripción 

Los pesos de las aristas plegadas para la subdivisión de superficies le permite cambiar la 

manera en la que la Subsuperficie subdivide la geometría para otorgarle a las aristas una 

apariencia más suave o más afilada.  

Opciones 

El peso plegado de las aristas seleccionadas puede ser cambiado utilizando las Propiedades de 

Transformación ( N ) y cambiando el deslizador de Transformación Medio. Un valor mayor 

hace que la arista sea "más fuerte" y más resistente a la subsuperficie. Otra forma de 

recordarlo es que el peso se refiere al filo de las aristas. Las aristas con un peso mayor se 

deformarán menos con la subsuperficie. Recuerde que la forma subdividida es producto de 

todas las aristas que se intersectan, por lo que para hacer que una arista sea más afilada, deberá 

incrementar el peso para todas las aristas a su alrededor. 

 

Edición de Malla 

Blender provee una variedad de herramientas para la edición de mallas. Aquellas están 

disponibles a través de la paleta Mesh Tools, accesible desde el menú Mesh de la cabecera de 

la vista 3D, así como también en los menúes contextuales de la vista 3D, también alcanzables 

mediante atajos de teclado individuales. 

Note que todas las teclas de "transformación precisa/ajuste" como Ctrl  y/o ⇧ Shift  trabajan 

también para todas aquellas operaciones avanzadas. Sin embargo, la mayoría de ellos no 

tienen posibilidades de axis locking, y algunos de ellos no toman en cuenta el pivot point y/o 

las transform orientation. 

http://wiki.blender.org/index.php/Doc:2.6/Manual/3D_interaction/Transform_Control/Axis_Locking
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Aquellas herramientas de transformación están disponibles en la sección Transform del 

menú Mesh en la barra de menú. Note que algunos de ellos también pueden ser utilizados en 

otros objetos editables, como curvas, superficies y rejillas. 

 

 

Tipos de Herramientas 

 

Herramientas de Malla 

Las herramientas de malla se pueden encontrar en varios lugares, y también están disponibles 

a través de atajos de teclado. 

http://wiki.blender.org/index.php/File:25-Manual-Modeling-Meshes-Tools.png


Transform and Deform tools: 

 Trasladar (Translate) 

 Rotar (Rotate) 

 Escalar (Scale) 

 Espejar (Mirror) 

 Encojer/Aplanar/A lo largo de 

la Normal 

(Shrink/Flatten/Along Normal) 

 Empujar/Tirar (Push/Pull) 

 A Esfera (To Sphere) 

 Cizallar (Shear) 

 Combar (Warp) 

 Deslizamiento de Aristas (Edge 

Slide) 

 Ruido (Noise) 

 Suavizado de Vértices (Smooth 

Vertex) 

 Inversión de Arista (Edge Flip) 

 Rotación de Arista (Rotate 

Edge) 

Merge and Remove tools: 

 Eliminar (Delete) 

 Unir (Merge) 

 Remover Dobles (Remove 

Doubles) 

 Tiángulos a Cuadrados (Tris to 

Quads) 

Add and Divide tools: 

 Crear Arista/Cara 

(Make Edge/Face) 

 Rellenar (Fill) 

 Relleno prolijo 

(Beauty Fill) 

 Solidificar 

(Solidificar) 

 Cuadrados a 

Triángulos (Quads to 

Tris) 

 Extruír Región 

(Extrude Region) 

 Extruír Individual 

(Extrude Individual) 

 Subdividir 

(Subdivide) 

 Corte de 

Circuito/Deslizar 

(Loop Cut/Slide) 

 Herramienta cuchillo 

(Knife Tool) 

 Duplicar (Duplicate) 

 Voltear (Spin) 

 Atornillar (Screw) 

Separate tools: 

 Rasgar (Rip) 

 Dividir (Split) 

 Separar (Separate) 
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Accediendo a las Herramientas de Malla 

Paleta de Herramientas de Malla 

Cuando selecciona una malla y presiona ⇆ Tab  para ingresar al modo edición, el Tool 

Shelf cambia de Object Tools aMesh Tools. Aquellas son solo algunas de las herramientas de 

edición de mallas. 

Menúes 

El menú Mesh está ubicado en la barra de la cabecera. Algunos de los menúes pueden ser 

accedidos con atajos de teclado: 

CtrlF  trae el menú de herramientas de Caras 

CtrlE  trae el menú de herramientas de Aristas 

CtrlV  trae el menú de herramientas de Vértices 

Normales 

Recalculate ( CtrlN ) 

Recalcula las normales de las caras seleccionadas. 

Flip Direction ( W  » Flip Normals u 8) 

Invierte las normales de las caras seleccionadas para que apunten en la dirección 

opuesta. 

 

Añadiendo y Dividiendo 

Estas herramientas pueden ser utilizadas para añadir más geometría a la malla actual. 

Crear Caras y Aristas 

Make Edge/Face F  

Ésta herramienta creará nueva geometría desde una selección de caras, aristas o 

vértices de acuerdo a las siguientes reglas: 

 2 vértices crearán una arista 

 3 vértices crearán una cara 

 4 vértices crearán una cara 

 2 aristas crearán una cara 



Fill AltF  

A partir de una selección de aristas cerradas, esto rellenará el hueco con triángulos 

Beauty Fill ⇧ ShiftAltF  

Esto tomará un grupo de cuadrángulos y triángulos para organizar el interior de las 

aristas y limpiarlas. Cada vez que la herramienta es usada, el relleno es mejorado hasta 

que no sea encontrada una mejor organización. 

Extruír 

Extrude Region ( E  o AltE  » Region o 1) 

Extruye los vértices seleccionados como una única región coherente utilizando sus 

normales en común. 

Extrude Individual ( AltE  » Individual Faces o 2) 

Extruye caras individuales a lo largo de sus respectivas normales. 

Solidificar 

Solidify 

Esto toma una selección de caras y las solidifica al extruírlas uniformemente para dar 

volumen a una superficie. Esto también está disponible como un modificador. Luego 

de usar la herramienta, puede establecer la distancia entre las superficies en la 

paleta Tool. 

Subdividir 

Subdivide ( W  » Subdivide o 1) 

Subdivide las aristas seleccionadas. 

El número de cortes y la suavidad de la operación se puede establecer en el Tool Shelf. 

Fractal puede ser usado para añadir aleatoriedad al corte. 

Otros varios como Corner Cut Patterns (Fan, Inner Vertex, y Path) producen 

resultados diferentes para selecciones más complejas de aristas. 

Corte de Circuito 

Loop Cut and Slide ( CtrlR ) 

Añade un circuito de aristas y lo desliza. 



Esta herramienta tiene un factor, el cual es mostrado en la cabecera de la vista 3D y en 

el Tool Shelf (luego de la confirmación). Un valor numérico entre -1 y 1 puede ser 

ingresado para obtener precisión. Esc  centra el nuevo circuito de aristas. 

Herramienta de Cuchillo 

Knife Tool K  y ⇧ ShiftK  

Con una selección de aristas o caras, manteniendo presionado K  y arrastrando el 

cursor manteniendo presionado LMB , a lo largo de las aristas para cortarlas en 

donde intersectan con el cursor. Luego de que LMB  es liberado, algunas opciones 

se hacen disponibles en la paleta Tool: 

Type: 

 Exact - Corta una vez donde el cuchillo intersectó a las aristas. 

 Midpoints - Corta los puntos medios de las aristas que están cortadas. 

 Mulitcut - Corta las aristas el número especificado de veces, de manera 

homogénea. 

 

Duplicar 

Duplicate (⇧ ShiftD ) 

Duplica los vértices seleccionados y los arrastra. Esc  para mantener la nueva copia en 

la posición original. 

En el Tool Shelf hay opciones para Vector, Edición Proporcional, Duplication Mode, 

y Axis Constraints. 

Convertir Cuadrángulos a Triángulos 

Quads to Tris CtrlT  

Esto toma una selección de cuadrángulos y los triangula. 

Voltear 

Spin ( AltR ) 

Voltea los vértices seleccionados alrededor del cursor 3D. Es dependiente de la vista. 

El número de Pasos y Ángulo, así también como la posición del Centro y dirección 

del Eje, se puede establecer en el Tool Shelf. 

http://wiki.blender.org/index.php/File:Template-LMB.png
http://wiki.blender.org/index.php/File:Template-LMB.png


Atornillar 

Screw 

Atornilla la selección alrededor del cursor 3D. Es dependiente de la vista. La selección 

debe ser una cadena de vértices conectados, pero no un circuito. 

 

Eliminar y Unir 

Estas herramientas pueden ser usadas para remover componentes, y unir componentes 

existentes. 

Eliminar 

Delete ( X  o Del ) 

Elimina los vértices seleccionados, las aristas o las caras. 

Esta operación también se puede limitar a: 

All 

Extiende la operación a la malla entera. El objeto no es eliminado; permitiendo 

reiniciar la malla desde dentro del objeto (por ejemplo, dejando otras propiedades del 

objeto como materiales, modificadores y capas intactos.) 

Esta es una forma rápida de "exportar" propiedades desde una malla existente a una 

nueva malla. Simplemente duplique una malla existente en modo objeto, digamos un 

cubo azul emparentado a una curva y con modificadores; presione ⇆ Tab  para 

ingresar al modo edición, elimine todos los vértices y añada, por ejemplo, una esfera 

para "reutilizar" todas las propiedades del cubo. 

Edges & Faces 

Limita la operación sólo a las aristas seleccionadas y las caras adyacentes. 

Only Faces 

Sólo elimina las caras seleccionadas. 

Edge Loop 

Elimina un circuito de aristas. Si la actual selección no es un circuito de aristas, esta 

operación no hace nada. 



Unir 

Merge ( AltM ) 

Une los vértices seleccionados. 

Un menú emergente pregunta por un centro donde ser unido. Utilice el selector de 

número de menú para seleccionar rápidamente, por ejemplo First (1), Last (2), 

o Center (3). 

Remove Doubles ( W  » Remove doubles o 4) 

Remueve todos los vértices superpuestos en la selección. 

Los vértices seleccionados no necesitan estar perfectamente alineados. Luego de ello, 

una opción de Merge Thresholdaparece en el Tool Shelf el cual puede ser incrementado 

para unir más vértices. 

Convertir Triángulos a Cuadrángulos 

Tris to Quads AltJ  Esto toma triángulos adyacentes y remueve la arista compartida para crear 

un cuadrángulo. Esta herramienta puede ser utilizada en una selección múltiple de triángulos. 

Esta misma acción puede ser realizada con 2 triángulos, al seleccionarlos y utilizar el atajo de 

teclado F , para crear una cara. 

 

Separating Geometry 

Estas herramientas pueden ser utilizadas para separar componentes de una malla. 

Separar 

Separate P  

Separar remueve los componentes y los coloca en un nuevo objeto. Puede establecer 

cómo la herramienta separa: 

Selected 

Separa componentes seleccionados. 

By Material 

Si la malla tiene múltiples materiales asignados a él, cada uno será separado en su 

propia malla. 



All Loose Parts 

Si hay múltiples grupos continuos de componentes de malla en la malla actual, esto 

separará cada uno de ellos en una malla independiente. 

Dividir 

Split Y  

Dividir toma la selección de elementos y desconecta los vértices que están compartidos 

con los elementos deseleccionados. 

Rasgar 

Rip ( V ) 

Con una arista o un circuito de aristas como entrada, esta herramienta corta un hueco 

en la malla a lo largo de la selección de arista y directamente arrastra el nuevo 

[circuito] de aristas más cercano al cursor. 

 

Herramientas de Transformación 

Estas herramientas simplemente mueven los componentes de las mallas de distintas maneras. 

Mover, Rotar, Escalar 

Para mover, rotar y escalar los componentes seleccionados, utilice los 

botones Translate, Rotate, y Scale, que son los transform manipulators, o los atajos de teclado: 

G , R , y S  respectivamente. 

Cuando lo hace, la parte inferior del Tool shelf cambia en un panel específico de la 

herramienta (p.ej. un panel Resize es mostrado cuando una selección de componentes han sido 

escalados). Puede utilizar este panel para afinar sus cambios, limitar el efecto a determinados 

ejes, habilitar y deshabilitar la edición proporcional, etc. 

Espejar 

Para Espejar geometría, utilice el atajo de teclado CtrlM  

Luego de activar esta herramienta, seleccione un eje para espejar la selección al 

ingresar x, y y z. 

También puede espejar la geometría interactivamente manteniendo 

presionado MMB  y arrastrando en la dirección del eje de espejado deseado. 
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Deslizamiento de Arista 

Deslizamiento de Arista ( CtrlE  » Edge Slide) 

Desliza uno o más aristas a lo largo de caras adyacentes con unas pocas restricciones 

involucrando la selección de aristas (por ejemplo, la selección debe tener sentido, véa 

abajo). 

LMB  confirma la herramienta, y RMB  o Esc  lo cancela. 

Esta herramienta tiene factor, el cual es mostrado en el pie de la vista 3D y en el Tool 

Shelf (luego de la confirmación). Un valor numérico entre -1 y 1 puede ser ingresado 

para precisión. 

Encojer/Aplanar 

Una selección de vértices puede ser encojida y aplanada a lo largo de sus normales utilizando 

el botón Along Normals, o el atajo AltS . 

Inversión de Arista 

Edge Flip alcanzable con ⇧ ShiftCtrlF  

Seleccione dos triángulos adyacentes y entonces utilice esta herramienta para invertir 

la arista compartida a los extremos opuestos. 

Rotate Edge alcanzable con CtrlE  >> rotate edge CW/CCW 

Con una arista seleccionada, o dos caras adyacentes, utilice esta herramienta para rotar 

aristas compartidas dentro del grupo de aristas. 

Empujar/Tirar 

Similar a encojer/aplanar, esta transformación consiste en trasladar todos los elementos 

seleccionados a lo largo de la línea que une su posición original a la posición promedio de los 

puntos. Todas las transformaciones son del mismo valor, y controlados por el ratón. Otorga 

algo que recuerda un poco al efecto de escalar, pero mucho más deformado. 

Note que a diferencia de los anteriores, usted puede bloquear esta transformación en un eje –

 incluso si este no tiene utilidad real (excepto quizás con un "bloqueo en plano‖).  

 

Combar 

Modo: Modo Edición 

Combinación de teclas: ⇧ ShiftW  
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Menú: Mesh/Curve/Surface » Transform » Warp 

La transformación de Comba es útil en casos muy específicos. Trabaja combando los 

elementos seleccionados alrededor del cursor 3D (siempre el cursor 3D, no toma en cuenta la 

configuración del punto de pivote…). También es dependiente de la vista. Los puntos que 

están en línea verticalmente con el cursor, permanecerán en su lugar. Cada distancia de los 

puntos a la posición vertical del cursor corresponde al radio sobre el que estará luego de haber 

activado la herramienta. La herramienta entonces combará el punto alrededor del cursor. Un 

valor de 360 combará la malla en un círculo completo, de manera que los puntos más alejados 

a la izquierda y la derecha quedarán en línea uno junto al otro sobre la posición del cursor. 

Para utilizar esta herramienta, establezca el cursor en la vista donde el centro debería estar. 

Active la herramienta, entonces mueva el cursor o ingrese el valor del ángulo a la que la malla 

debería ser combada.  

Ejemplo 

Una pieza de texto combada en un anillo esférico es útil cuando crea logos voladores, pero 

será difícil de modelar sin el uso de la herramienta de comba. Para nuestro ejemplo, 

combaremos la frase "Amazingly Warped Text" al rededor de una esfera. 

 Primero añada la esfera. 

 Entonces añada el texto en la vista frontal, en el contexto Editing y el panel Curve and 

Surface establezca el valor deExtrude a 0.1 – haciendo el texto en 3D, y establezca el 

valor de Bevel Depth a 0.01, añadiendo un biselado a la arista. Coloque el valor de Bev 

Resol a 1 ó 2 para tener un suave biselado y disminuya la resolución para que la 

cantidad de vértices no sea muy elevada cuando subdivida el objeto luego al utilizar el 

panel Curve and Surface y el panel Font. 

 Convierta el objeto a curvas, luego a una malla ( AltC  dos veces), porque la 

herramienta de comba no funciona sobre texto o sobre curvas. 

 Subdivida la malla dos veces ( W  » Subdivide Multi » 2), para que la geometría cambie 

su geometría limpiamente, sin artefactos. 
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Panel Curve and Surface. 

 

Panel Font. 

 
Vista superior de texto y esfera. 

 Vaya a la vista superior y mueva la malla más lejos del cursor 3D. Esta distancia 

define el radio de la comba. Véa Vista superior de texto y esfera. 

 

Texto combado. 

 Ubique la malla en Modo Edición con (⇆ Tab ) y presione A  para seleccionar todos 

los vértices. Presione ⇧ ShiftW  para activar la herramienta de transformación de 
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comba. Mueva el ratón a la izquierda o a la derecha para definir interactivamente 

cuánta comba. Véa Texto combado. 

 

Render final. 

Ahora puede ir a la vista de la cámara, añadir materiales, luces y renderizar. Véa Render final.  

 

Cizallar 

Modo: Modo Edición 

Combinación de teclas: CtrlAlt⇧ ShiftS  

Menú: Object/Mesh/Curve/Surface » Transform » Shear 

La transformación de Cizallar aplica un cizallado a su selección de elementos (en Modo 

Edición, los vértices/aristas/puntos de control/…). Tanto como la otra herramienta de 

transformación, utiliza el espacio de vista, y está centrado en el punto de pivote: el cizallado 

ocurre a lo largo del eje X y alrededor del punto de pivote. Todo lo que se encuentra "sobre" 

este eje (por ejemplo si tiene una posición en la ubicación Y positiva) se moverá (cizallará) en 

la misma dirección en la que se encuentra el puntero del ratón (pero siempre paralelo al eje X). 

Y todo lo que se encuentra por "debajo", se moverá en el eje X pero en dirección opuesta. 

Cuanto más alejado se encuentra un elemento del eje X, más se moverá 

Cuando la herramienta sea activada, mueva el ratón de izquierda a derecha para controlar 

interactivamente el cizallado. Para hacer que el efecto trabaje en el eje vertical en vez del 

horizontal, cliquee con MMB  y entonces mueva el ratón hacia arriba o hacia abajo. 

Alternativamente ingrese un valor numérico entre 0 e infinito. Para finalizar la herramienta, 

haga click con LMB . 
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Esfera 

Modo: Modo Edición 

Panel: Mesh Tools (en el contexto Editing o F9 ) 

Combinación de teclas: ⇧ ShiftAltS  

Menú: Mesh/Curve/Surface » Transform » To Sphere 

Este comando "esferiza" los elementos de malla seleccionados. Realiza esto encontrando la 

posición promedio de los elementos, y moviéndolos hacia este promedio desde donde se 

encuentran. Utilizando un valor de 1 coloca todos los vértices a una distancia igual desde este 

punto, creando una forma esférica. 

Cuando la herramienta se active, arrastre el ratón hacia la izquierda o derecha para controlar el 

efecto interactivamente, o tipee un valor desde 0 a 1 para controlarlo manualmente.  

 

Ejemplo 

Esta herramienta permite la creación de esferas desde cubos subdivididos. Primero, comience 

con un Cubo. Comience desde una escena limpia eliminando todo ( CtrlX ). 

 Presione ⇆ Tab  para ingresar al Modo Edición. 

 Asegúrese de que todos los vértices del cubo están seleccionados presionando A dos 

veces. Entonces, vaya al contexto Editing presionando F9 . Debería poder ver el 

panel Mesh Tools ahora. 

 Subdivida el cubo presionando el botón Subdivide en el panel Mesh Tools, o 

con W  » Subdivide. Puede realizar esto cuantas veces desee; cuanto más subdivida, 

más suave será la superficie de su esfera. 

 Ahora, presione Ctrl⇧ ShiftS  y mueva su ratón hacia la izquierda o la derecha para 

controlar interactivamente la proporción de la "esferización" (o directamente tippe un 

valor, como "1.000" para lograr el mismo efecto de abajo) – ¡preferentemente 

utilizando el punto de pivote Median Point! 

 Alternativamente, puede utilizar el botón To Sphere (en el panel Mesh Tools). 

Seleccione "100" para hacer su esfera. Note que no debería mover el cursor 3D – o no 

obtendrá una esfera, pero algo similar. 
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Esfera de baja resolución finalizada 

 

Ruido 

Noise Utiliza la textura en el primer slot de textura del material como entrada para deformar 

los vértices seleccionados. 

La malla debe tener un material y una textura asignada a él para que esta herramienta 

funcione. Para evitar que la textura afecte las propiedades del material, puede 

deshabilitarlo en el menú de textura. 

La deformación puede ser controlada modificando el panel Mapping y/o en el propio 

panel de textura (por ejemplo Clouds, Marble, etcétera). 

 

Suavizar 

Smooth Vertex ( W  » Shade Smooth o 9): Suaviza los vértices seleccionados al aplanar los 

ángulos de los vértices. 

Luego de confirmar, las alternativas aparecen en el Tool Shelf para limitar el efecto a 

ciertos ejes y para establecer el número de iteraciones. 

 

Grupos de Vértices 

Una malla es un conjunto de vértices conectados, incluso miles para los objetos más 

complejos. Blender le permite agrupar aquellos vértices por varias importantes razones: 

 Reutilizar partes de una malla para realizar copias 

 Esconder "todo lo demás" mientras trabaja en los detalles 
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 Documentación y explicación para otros 

 Deformación por Armaduras 

 Generar partículas solamente desde el grupo 

 Controlar la velocidad de las partículas emitidas 

 Asignar múltiples materiales a una única malla 

¿Por qué utilizar Grupos de Vértices? 

Los Grupos de Vértices identifican sub componentes de un objeto, como las patas de una silla 

o las bisagras de una puerta. Al "marcar" aquellas regiones en grupos de vértices puede 

fácilmente seleccionar y trabajar sobre ellos separadamente sin necesidad de crear objetos 

separados. Con la función de esconder puede incluso remover todo lo demás de la vista. 

Los Grupos de Vértices también hacen que sea fácil eliminar o duplicar partes de una malla 

muchas veces. Considere modelar una pieza de Lego. La pieza más sencilla consiste de una 

base y una boquilla. Para crear un bloque de cuatro boquillas, deseará poder seleccionar 

fácilmente los vértices de las boquillas y, aún en Modo Edición, duplicarlos y posicionarlos 

donde desee. 

Otro uso para los grupos de vértices es para vestir una armadura. Si desea animar su malla y 

hacer que se mueva, definirá una armadura, el cual consiste de un puñado de huesos invisibles. 

En la medida en la que el hueso se mueva, deformará o moverá los vértices asociados a él. No 

todos los vértices, tan solo algunos de ellos; los asociados a él. Por lo que, cuando mueve el 

hueso "Brazo", se mueven los vértices "Brazo", y no los vértices "pierna". De esta manera, 

algunas partes de la malla se pueden estirar y mover, mientras que otras partes permanecen 

quietas. 

El menú de los Sistemas de Partículas tiene un panel de Grupos de Vértices donde varias 

propiedades pueden ser limitadas según los grupos de vértices. El pintado de pesos para los 

grupos de vértices puede controlar la cantidad, tamaño y velocidad de las partículas. Por 

ejemplo, Hair — un tipo de sistema de partículas — puede utilizar un grupo de vértices 

denominadoCuero Cabelludo para tener el pelo emitido solamente desde una parte del cráneo. 

Adicionalmente, muchos Modificadores utilizan Grupos de Vértices para limitar su influencia. 

Algunos modificadores, como el Mask Modifier, necesitan un grupo de vértices para tener 

algún efecto.  
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Creando y Eliminando 

 

 

Panel Vertex Groups en Modo Edición 

Por defecto, un objeto no tiene ningún grupo, y todos sus vértices están alli en el ciberespacio 

como solitarios. Mientras que en algunos contextos, los grupos de vértices pueden ser 

generados automáticamente, por ejemplo mientras se pintan los pesos de vértices, típicamente 

se crean y modifican grupos de vértices en elpanel de los Grupos de Vértices en el 

menú Object data. Una vez que un grupo de vértice ha sido añadido, y cuando nos 

encontramos enModo Edición, el panel del grupo de vértices se expande para mostrar una fila 

de botones. 

 

Menú desplegable Vertex Groups 

Para crear un grupo de vértices, haga click con LMB  sobre el botón +. Cuando lo haga, un 

nuevo grupo de vértices (nombrado ―Group‖) es creado, y el panel le muestra un deslizador 

numérico/caja de entrada de datos acerca del peso (Weight). Cualquier vértice seleccionado no 

son asignados todavía al nuevo grupo, debe cliquear el botón Assign para que los vértices se 

incluyan en el nuevo grupo de vértices recien creado. Note que utilizando el 

Atajo CtrlG  » Add to New Group, hará todo esto en un solo paso. 
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Para eliminar un grupo de vértices, selecciónelo de la lista y cliquee el botón -. Si, es tan 

sencillo como eso. Cualquier vértice que perteneciera a aquel grupo es desasignado de él. Sin 

embargo, por favor tenga en cuenta que los vértices pueden pertenecer a muchos grupos. 

Cuando son desasignados de un grupo, ellos todavía pertenecen a sus otros grupos.  

 

Para nombrar el grupo a algo más creativo que "Group" cliquee con ⇧ ShiftLMB  en el 

campo del nombre, y simplemente tipee el nombre que desee. Eligiendo un nombre corto y 

claro es crucial en proyectos grandes que involucran a muchos usuarios.  

 

Seleccionando y Deseleccionando 

Desde la experiencia, hemos encontrado que es mejor comenzar primero viendo los vértices 

existentes en un grupo, antes de añadir o remover otros. Para ello, primero deseleccione todos 

los vértices presionando A  una o dos veces en la vista 3D. Entonces, con el grupo apropiado 

activo, presione el botón Select. En su vista 3D, los vértices que pertenecen al grupo activo 

serán seleccionados y resaltados. 

Algunas veces quizás quiera ver si algún vértices aún está solitario. Para hacerlo, seleccione 

todos con A  en la ventana 3D. Para cada Grupo de Vértices cliquee con LMB  en el 

botón Deselect para deseleccionar los vértices en aquél grupo. Repita la deselección para cada 

grupo. Cuando termine con todos los grupos, cualquier vértice resaltado es un vértice solitario. 

Tal como elegir equipos de baseball.  

 

Asignando y Removiendo Vértices 

Para añadir vértices a un grupo debe hacer lo siguiente: 

1. Seleccionar el grupo con el que desea trabajar desde la lista de grupos. 

2. Utilice su ratón con ⇧ ShiftRMB  para seleccionar más vértices que desee incluir en 

el grupo. 

3. Cliquee con LMB  sobre el botón Assign, o haga CtrlG  » Add Selected to Active 

Group. 

Tenga en mente que un vértice puede ser asignado a múltiples grupos. 

 

Para eliminar vértices de un grupo: 

1. Seleccione el grupo con el que desea trabajar desde la lista de grupos. 

2. Seleccione los vértices que desee remover del grupo de vértices. 
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3. Cliquee con LMB  sobre el botón Remove, o utilice el atajo CtrlG  » Remove from 

Active Group. 

Administración de los Grupos de Vértices 

 

 

Panel del menú desplegable para Grupos de Vértices 

 

Sort Vertex Groups 

Ordenar los grupos de vértices alfabéticamente. 

Copy Vertex Group 

Crear una copia del grupo de vértices activo (por ejemplo, los vértices asignados al 

grupo activo son automáticamente asignados al nuevo grupo). 

Copy Vertex Group to Linked 

Copiar los grupos de vértices a todos los objetos duplicados que estén vinculados. 

Copy Vertex Group to Selected 

Copiar los grupos de vértices a otras mallas seleccionadas. 

Mirror Vertex Group 

Espeja todos los grupos de vértices, invierte los pesos y/o nombres, editando solamente 

los vértices seleccionados, invirtiendo solamente cuando ambos lados están 

seleccionados, de lo contrario copia desde el deseleccionado. 
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Delete All 

Elimina todos los grupos de vértices. 

 

Modo de Pintado de Pesos 

El modo de Pintado de Pesos es utilizado para crear y modificar grupos de vértices. Un vértice 

puede no solamente ser un miembro de uno o más grupos de vértices, también puede tener un 

cierto peso en cada grupo. El peso simboliza su influencia en el resultado. 

El pintado de pesos es principalmente utilizado para el rigging de mallas, pero puede ser 

utilizado para controlar la emisión de partículas, y la densidad de los cabellos.  

 

Modo: Modo Weight Paint 

Combinación de teclas: Ctrl⇆ Tab  

Menú: Mode menu (Imagen 1) 

Cuando cambia al modo de Pintado de Pesos usted ve el objeto seleccionado (si no ha creado 

ningún grupo aún), en un color azul levemente sombreado (Imagen 2). 

 

Imagen 2: Un objeto en el modo de Pintado de Pesos. 

El color visualiza el peso de cada vértice del grupo activo actual. Un vértice dibujado en azul 

indica que: el peso es cero, o que no se encuentra en el grupo activo, o que no se encuentra en 

ningún grupo de todos modos. 

Puede personalizar los colores en el gradiente de pesos habilitando Custom Weight Paint 

Range en la pestaña System de las Preferencias de Usuario. 

Puede asignar el peso a cada vértice al pintar sobre la malla con un cierto color. Empezar a 

pintar sobre una malla creará automáticamente un nuevo grupo de vértices de peso (cuando no 

existe ningún grupo o no hay ninguno activo). Si un vértice no pertenece al grupo activo es 
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añadido automáticamente (si la opción Vgroup no se encuentra establecida), incluso si pinta 

con un peso de "0". El espectro de color utilizado es mostrado en la Imagen 3.  

 

Imagen 3: El espectro de color y sus respectivos pesos. 

Usted pinta sobre la malla con una brocha. El color solo influencia a los vértices, no las caras ni las aristas. Por lo que no 

intente pintar en ellos. Hay un panel de herramientas para la brocha en el contexto Editing accesible con F9  así como también 

en la vista 3D al presionar N  para abrirlo. 

 

Panel de Pintura 

 

 

Imagen 4: El panel dePintura en el contextoEditing. 

Las herramientas en el panel de Pintura son sofisticadas, y puede aplicar pesos en la forma 

más detallada. Pero normalmente no necesitará todas esas opciones, y aplicará los pesos 

utilizando unas pocas técnicas. Los ajustes más utilizados e importantes están resaltados en 

negro. 
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Weight 

El peso (color) que es utilizado para pintar. La fila de botones de abajo contiene varios 

parámetros preestablecidos para pintar. Por defecto, el pintado solo funciona con una 

cantidad fija absoluta (como los ajustes por defecto de GIMP o Photoshop), por lo que 

puede por ejemplo establecer un "peso de 0.2" a los vértices mientras mantiene el 

botón del mouse presionado, sin importar cuál haya sido su peso original. 

Auto Normalize 

Se asegura de que todos los grupos de vértices se recorten a 1 mientras pinta. 

Radius F  

El tamaño de la brocha, el cual es dibujado como un círculo durante el pintado. 

Strength 

Qué tan poderoso es el efecto de la brocha, cuando es aplicado. 

Jitter 

Aleatoriza la posición de la brocha mientras pinta 

Herramientas de Peso (Panel Weight Tools) 

Cuando aquellas herramientas son activadas, aparecen opciones adicionales en la sección de 

los ajustes de las herramientas, en la zona inferior del panel de propiedades. 

Normalize All 

La normalización se asegura de que la suma de los pesos para cada vértice en todos los 

grupos sea igual a 1. Esta herramienta normaliza todos los grupos de vértices. 

Lock Active 

Esto mantiene los valores del grupo activo mientras normaliza otros. 

Normalize 

Esto normaliza solo los valores del grupo de vértices actual 

Invert 

Invierte los valores de los pesos (1-valor) 

 



Add Weights 

Añadir vértices de los grupos que tienen peso cero antes de invertir 

Remove Weights 

Remueve los vértices de los grupos que tienen peso cero antes de invertir 

Clean 

Remueve la asignación de los grupos de vértices que no son requeridos 

Limit 

Remueve pesos por debajo de éste límite 

All Groups 

Limpia todos los grupos de vértices 

Keep Single 

Mantener los vértices en al menos un grupo al limpiar 

Levels 

Ajusta los valores de peso utilizando las herramientas siguientes: 

Offset 

Valor a añadir a los pesos 

Gain 

Valor por el cual multiplicar los pesos. 

Trazo (Panel Brush) 

Airbrush 

La opción Airbrush aplica el efecto de pintado mientras mantiene presionado el ratón. 

Smooth Stroke 

Provoca que la brocha tenga un retraso detrás del ratón y siga una ruta más suave. 

Radius 

Distancia mínima desde el último punto antes de que el trazo continúe 



Factor 

Valores más altos otorgan un trazo más suave 

Space 

Limita la aplicación de la brocha a la distancia especificada en el valor de Spacing, 

como un porcentual del radio de la brocha. 

Curva (Panel Curve) 

Establece la forma de la brocha al reformar la curva de atenuación. 

La fila inferior de botones son ajustes predefinidos para la formas de la curva de atenuación. 

 

Opciones (Panel Options) 

All faces 

Si esto es desactivado, solo pintará los vértices que pertenezcan a una cara en la cual el 

cursor se encuentra. Esto es útil si tiene una malla compleja y desea pintar en las caras 

visualmente más cercanas y que en realidad se encuentran más distantes en la malla. 

Normals 

Las normales de vértice (ayudan) a determinar la extensión del pintado. Esto causa un 

efecto como si pintara con luz. 

Spray 

La opción de Spray acumula pesos en cada movimiento del ratón. 

X-mirror 

Utilice la opción de X-mirror para pintado en espejo en grupos que tienen nombres 

similares, como por ejemplo con la extensión .R/.L, o _R/_L. Si un grupo no tiene 

contraparte espejada, se pintará simétricamente en el mismo grupo activo. Puede leer 

más acerca de la convención de nombres en Editing Armatures: Naming conventions. 

La convención para armaduras/huesos se aplica aquí por igual. 

Topology Mirror 

Utilice el espejado basado en topología cuando ambas partes de una malla posean 

topología espejada que coincida. 

Ajustes Unificados: El Tamaño y Fuerza de una brocha puede ser establecido para que sea 

compartido entre las distintas brochas, en contraposición a "por brocha" (per-brush). 
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Apariencia (Panel Appearance) 

Aquí puede establecer el color del cursor de la brocha, o cargar un ícono personalizado desde 

un archivo. 

Herramienta (Panel Tool) 

La herramienta define cómo los valores de los pesos son aplicados a los vértices. 

Mix 

El nuevo color reemplaza el color más antiguo. Aplicando más y más del nuevo color 

llevará eventualmente a que se vuelva del nuevo color. 

Add 

El nuevo color es añadido al más antiguo. Note que debe pensar en pesos aquí (no en 

colores RGB): añadiendo azul (0.0) a algo no lo modificará, añadiendo verde (0.5) a 

verde dará rojo (1.0),… 

Sub 

El nuevo color es sustraído del existente. Aquí nuevamente debe pensar en términos de 

"peso", y no de "colores RGB". 

Mul 

El nuevo color es multiplicado por el más antiguo. 

Blur 

Desenfoca el color con los valores circundantes. 

Lighten 

Solo pinta los vértices "más oscuros" (menor peso) que el "color" actual, 

"aclarándolos". 

Darken 

Solo pinta los vértices "más claros" (mayor peso) que el "color" actual, 

"oscureciéndolos". 

 Vgroup: Solo los vértices que pertenecen al grupo de vértices actual son pintados. Muy 

útil para limpiar y refinar grupos de vértices sin tener que lidiar con otros grupos. 

 



Enmascarado de Selección de Cara 

Si tiene una malla compleja es casi imposible alcanzar todos los vértices en el modo 

de Pintado de Pesos. Y es bastante difícil decir dónde están exactamente los vértices. Pero hay 

una muy buena y sencilla solución: el modo Face Selection Masking. El botón Face Selection 

masking en la cabecera de botones le permite seleccionar caras y limitar las herramientas de 

pintado de pesos a aquellas caras. 

 

Imagen 5: Menú Select en el modo Weight Paint. 

El modo Select tiene varias ventajas sobre el modo normal deWeight Paint: 

1. La malla original es dibujada, incluso la subsuperficie está activa. Puede ver los 

vértices sobre los que tiene que pintar. 

2. Puede seleccionar caras, solo los vértices de las caras seleccionadas son pintadas. 

3. Las herramientas de selección incluyen: 

o RMB  – Caras únicas. Utilice ⇧ ShiftRMB  para selección múltiple. 

o A  – Selecciona todas las caras, también las deselecciona. 

o B  – Selección de Bloque/Caja. 

o BB  – Seleccionar con brocha. 

o CtrlL  – Seleccionar vinculados. 
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o En el menú Select: Las caras con Same UV, también invierten la selección 

(Inverse). 

4. Puede ocultar las caras seleccionadas con H  y mostrarlas nuevamente 

con AltH  (Imagen 6). 

 

 

 

Imagen 6a: Seleccionar caras que interfieren… 

 

Imagen 6b: … y ocultarlas con H . 

 Para restringir el área de pintado adicionalmente puede utilizar el Recorte de Borde. 

Presione AltB  y LMB arrastrando un área rectangular. El resto de la ventana 3D es 

ocultado. Para mostrar todo nuevamente, tan solo presione otra vez AltB . 

Pintado de Pesos para Huesos 

Esta es quizá la aplicación más utilizada para el pintado de pesos. Cuando un hueso se mueve, 

los vértices al alrededor de la unión también se deberían mover, pero tan solo un poco, para 

imitar el estiramiento de la piel a su alrededor. Utilice un peso "liviano" (10-40%) pintando en 

los vértices de la unión para que se muevan solo un poco cuando el hueso rote. Mientras que 

existen maneras de asignar pesos automáticamente a una armadura, puede realizar esto 

manualmente. Para hacer esto desde el comienzo, vea el proceso más abajo. Para modificar los 

pesos asignados automáticamente, salte al medio del proceso cuando sea avisado: 

 Cree una armadura. 

 Cree una malla que para ser deformada cuando el hueso de la armadura se mueva. 

 Con la malla seleccionada, cree un modificador de Armadura para su malla (ubicada 

en el contexto Editing, del panel Modifiers). Ingrese el nombre de la armadura. 

Tómese un tiempo aquí para modificar los pesos asignados automáticamente. 
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 Seleccione la armadura en la Vista 3D, y lleve la armadura al modo Pose ( Ctrl⇆ Tab , 

o el selector de modo en la cabecera de la ventana de Vista 3D). 

 Seleccione un hueso deseado en la armadura. 

 Seleccione su malla (utilizando RMB ) y cambie inmediatamente al modo Weight 

Paint. Esta malla será coloreada de acuerdo al peso (graduación) que ejerce el 

movimiento del hueso seleccionado afectando la malla. Inicialmente, será todo azul 

(sin efecto). 

 Pinte a su gusto. La malla al rededor del hueso en sí mismo debería ser rojo 

(generalmente) y difuminarse a través del arco iris hacia azul para los vértices que 

están más alejados del hueso. 

Puede seleccionar un hueso diferente con RMB . Si la malla rodea al hueso, no podrá ver 

los huesos, debido a que la malla está pintada. Por lo que activando la vista X-Ray de la 

ventana (Buttons, en el contexto Editing, y el panel Armature). En aquél panel, también puede 

cambiar la forma en la que los huesos son dibujados (Octahedron, Stick, B-Bone, o Envelope) 

y habilitarDraw Names para asegurarse de que el nombre de los huesos seleccionados coincide 

con los grupos de vértices. 

Si pinta sobre la malla, un grupo de vértices es creado para el hueso. Si pinta sobre los vértices 

que no están en el grupo, los vértices pintados son automáticamente añadidos al grupo de 

vértices. 

Si posee una malla simétrica y una armadura simétrica puede utilizar la opción X-Mirror. 

Entonces los grupos espejados con los pesos espejados son automáticamente creados.  

 

Pintado de Pesos para Partículas 

 

Emisión de partículas pintadas con pesos. 
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Las caras o lo vértices con peso cero no generan partículas. Un peso de 0.1 resultará en un 

10% de la cantidad de partículas. Esta opción "conserva" el número total de las partículas 

indicadas, ajustando las distribuciones para que los pesos adecuados sean conseguidos 

mientras utiliza el número actual de partículas que ha sido asignado. Utilice esto para hacer 

que ciertas porciones de su malla sean más peludas que otras, al pintar con pesos un grupo de 

vértices, y aplicando el nombre del grupo de vértices en el campo VGroup: del panel 

(Particles, en el contexto Object).  

 

Modo Objeto 

 

Objeto seleccionado. 

La geometría de una escena es construida a partir de uno o más objetos. Por ejemplo, 

Lámparas, Curvas, Superficies, Cámaras, Mallas, y los objetos básicos ("primitivas"). 

 

Tipo de objetos 

Mallas 

Las mallas son objetos poligonales compuestos por Caras, Aristas y/o Vértices, y pueden ser 

extensivamente editados con las herramientas de edición de mallas de Blender. 

Curvas 

Las curvas son objetos definidos matemáticamente, los cuales pueden ser manipulados con 

puntos de control o agarraderas, a diferencia de los vértices. 

Superficies  

Las superficies son parches de cuatro lados que también son manipulados por puntos de control 

(puntos de influencia). Aquellos son muy útiles para formas simples muy orgánicas y 

redondeadas. 

Meta Objetos  

Las metabolas son objetos constituidos por una función que define el volumen 3D en el cual 

existe el objeto. Las metabolas pueden crear formas "burbujientas" que tienen una calidad como 
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si se tratase de líquidos, cuando dos o más metabolas son combinadas. 

Texto  
Los objetos texto crean una representación 2D para una cadena de caracteres. 

Armaduras. Las armaduras son utilizadas para riggear modelos 3D para poder posarlos y hacerlos animables. 

Vacío o 

Ayudante  

Los objetos Vacíos son objetos nulos que son simplemente nodos transformables que no pueden 

ser renderizados. Son útiles para controlar la posición o movimiento de otros objetos. 

Cámaras  
Esta es la cámara virtual que es utilizada para determinar qué aparece en el render. 

Lámparas  
Aquellas son utilizadas para ubicar fuentes de luz en la escena. 

Campos de 

fuerza  

Los campos de fuerza son utilizados en simulaciones físicas. Brindan simulaciones de fuerzas 

externas, creando movimiento, y son representados en 3D como pequeños objetos de control. 

 

 

 

Cada objeto puede ser movido, rotado o escalado en Modo objeto. Sin embargo, no todas 

aquellas transformaciones tienen un efecto en todos los objetos. Por ejemplo, escalando o 

rotando un campo de fuerza no incrementará su efecto. 

 

Para realizar otros cambios a la geometría de los objetos editables, debe utilizar el Modo 

Edición. 

Una vez que haya añadido un objeto básico, se queda en Modo Objeto. En versiones anteriores 

de Blender, era automáticamente lanzado alModo Edición si el objeto se trataba de una Malla, 

una Curva o una Superficie. 

Puede alternar entre el Modo Objeto y el Modo Edición presionando ⇆ Tab . 
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El alambrado del objeto, si es que hay alguno, debería aparecer ahora en anaranjado, 

indicando que el objeto está ahora seleccionado y activo, como se puede ver en (Objeto 

Seleccionado.). 

La imagen muestra los modos de vista sólida y la vista en alambre de su cubo por defecto. 

Para alternar entre los modos de alambre y la vista sólida, presione Z .  

 

Centros de Objetos 

Cada objeto tiene un punto de origen o centro. La posición de este punto determina dónde está 

ubicado este objeto en el espacio 3D. Cuando un objeto es seleccionado, un pequeño círculo 

aparece, mostrando el punto de origen. La posición del punto de origen es importante cuando 

rota o escala un objeto.  

 

Moviendo los centros de Objetos 

Los centros de los objetos pueden ser movidos a una posición diferente a través del menú 

Objeto, bajo el sub-menú Transform: 

 3D Cursor Location 

Mueve el origen a la posición del cursor 3D.  

 Median Point of Geometry 

Mueve el origen al promedio de la posición de los componentes de objeto. 

 

 

Borrar Objetos 

Modo: Modo Edición o Modo Objeto 

Combinación de teclas: X  o Del  

Menú: Object → Delete 

Elimina o borra los objetos seleccionados.  

 

Unir Objetos 

Modo: Modo Objeto 



Combinación de teclas: CtrlJ  

Menú: Object → Join Objects 

Une todos los objetos seleccionados del mismo tipo en un objeto único cuyo punto central es 

obtenido del objeto previo activo (El último seleccionado). Ejecuta una unión que es 

equivalente a añadir objetos mientras se está en Modo Edición. Los objetos no activos son 

eliminados, sólo el objeto activo se mantiene. Esto solo trabaja con objetos editables, como 

mallas y curvas.  

 

Duplicación 

Modo: Modo Edición y Modo Objeto 

Combinación de teclas: ⇧ ShiftD  

Menú: Object → Duplicate 

Descripción 

Esto creará una copia visual idéntica del objeto seleccionado. La copia es creada en el mismo 

lugar que el original y la herramienta de Arrastrar queda activada automáticamente. 

Esta copia es un nuevo objeto, el cual "comparte" el mismo bloque de datos con el original 

(por defecto, todos los Materiales, Texturas, y Curvas-F), pero no copia otros, por ejemplo los 

bloques de datos de las mallas. Esto es por lo que esta forma de duplicación algunas veces es 

denominada "copia parcial", debido a que no todos los bloques de datos son compartidos, 

algunos de ellos son "copias duras" 

Note que puede elegir qué tipo de bloques de datos serán encadenados o copiados durante la 

duplicación: en las Preferencias de Usuario (disponibles en el menú File), sección Editing, 

para activar aquellos bloques de datos que realmente desea copiar en Duplicate Data list — 

los demás tan solo serán vinculados.  



Ejemplos 

 

La malla Cono.006 del objeto Cone.002 está siendo editada. El Nombre ID del bloque de datos único de la malla aparece 

resaltado en el Outliner. 

El cono en el medio ha sido (1) duplicado y encadenado al objeto de la izquierda y (2) 

duplicado a la derecha. 

 El cono duplicado a la derecha está siendo editado, el cono original en el medio 

permanece sin cambios. Los datos de malla han sido copiados, no vinculados. 

 De igual manera, si el cono de la derecha es editado en modo objeto, el cono original 

permanecerá sin cambios. Las propiedades de transformación del nuevo objeto o 

bloque de datos es una copia, no vinculada. 

 Cuando el cono de la derecha fue duplicado, heredó el material del cono del medio. 

Las propiedades de material han sido vinculadas, no copiadas. 

Duplicación Vinculada 

Modo: Modo Objeto 

Combinación de teclas: AltD  

Menú: Object → Duplicate Linked 

Descripción 

También tiene la opción de crear una "Duplicación Vinculada" en lugar de un Duplicado; esto 

es llamado un "vinculado profundo". Creará un nuevo objeto con todos los datos vinculados al 

objeto original. Si modifica alguno de los objetos vinculados en Modo Edición, todas las 

copias vinculadas son modificadas. Las propiedades de transformación (bloques de datos del 

objeto) aún se mantienen como copias, no vínculos, por lo que aún puede rotar, escalar y 

mover libremente sin afectar las otras copias.  
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Ejemplos 

 

 

El objeto Cone.001 ha sido duplicado y vinculado. Aunque ambos conos son objetos separados con nombres únicos, la malla 

única llamada Cone, resaltada en el Outliner, es compartida por ambos. 

El cono de la izquierda es una Duplicación Vinculada del cono central (utilizando AltD ). 

 Cuando un vértice es movido en Modo Edición dentro de un objeto, el mismo vértice 

es movido en el cono original. Los datos de malla se encuentran vinculados, no 

copiados. 

 Por el contrario, si uno de aquellos dos conos es rotado o reescalado en Modo objeto, 

los demás permanecen sin cambios. Las propiedades de transformación están copiadas, 

no vinculadas. 

 Como en el ejemplo previo, el nuevo cono creado ha heredado el material del cono 

original. Las propiedades del material están vinculadas, no copiadas. 

Una mesa común posee una parte superior y cuatro patas. Modele una sola pata, y entonces 

haga duplicaciones vinculadas tres veces para el resto de las patas. Si luego decide hacer 

algunos cambios a la malla, todas las patas coincidirán en su forma. Las duplicaciones 

vinculadas también aplican a un conjunto de vasos, ruedas en un automóvil... en cualquier 

lugar donde existe repetición o simetría.  

 

Duplicación Procedural 

Modo: Modo Objeto y Modo Edición 

Panel: Object settings 

En blender existen cuatro maneras de duplicar procesualmente los objetos. Aquellas opciones 

están ubicadas en el panel Object. 
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Verts  

Esto crea una instancia de todos los hijos de este objeto en cada vértice (para objetos 

malla solamente). 

Faces  

Esto crea una instancia de todos los hijos de este objeto en cada cara (para objetos 

malla solamente). 

Group  

Esto crea una instancia de un grupo con la transformación del objeto. Los duplicadores 

de grupo pueden ser animados utilizando acciones, o pueden tener un Proxy. 

Frames  

Para objetos animados, esto crea una instancia en cada cuadro. Como verá en el tópico 

de esta subpágina, también es una muy poderosa técnica para organizar objetos y para 

modelarlos. 

Duplicación de Librerías Vinculadas 

Combinación de teclas: ⇧ ShiftF1  

Menú: File → Link Append 

Linked Libraries  

Las librerías vinculadas son también una forma de duplicación. Cualquier objeto o 

bloque de datos en otros archivos blend pueden ser reutilizados en el archivo actual. 

Empties 

El Empty o Vacío es un objeto nulo. Sirve como un tirador de transformación, el cual no puede 

ser editado y no se puede renderizar. Los Empties son objetos importantes y útiles. Algunos 

ejemplos de formas de utilizarlos incluyen: 

 Emparentar objetos para un grupo de objetos 

 Objetivos para Restricciones 

 Marcador de Posición 

 Control de Rigging 

 Distancia de Profundidad de Campo (DoF) 

 Diferencia de distancia en matrices 

 Imágenes de Referencia 
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Ajustes 

Plain Axes 

Representado como seis líneas, cada una apuntando en los ejes +X, -X, +Y, -Y, +Z, y -

Z. 

Arrows 

Representado como flechas apuntando en los ejes positivos X, Y y Z, cada uno de ellos 

con una etiqueta que lo indica. 

Single Arrow 

Representado como una sola flecha apuntando en el eje +Z. 

Circle 

Representado como un círculo en el plano XZ. 

Cube 

Representado como una estructura cúbica. 

Sphere 

Representado como una esfera implícita definido por 3 círculos. 

Cone 

Representado como un cono, apuntando en el eje +Y. 

Image 

Los Empties pueden mostrar imágenes. Ésto puede ser utilizado para crear imágenes de 

referencia, incluyendo proyectos o laminillas de caracteres desde los cuales modelar, 

en lugar de utilizar imágenes de fondo. La imagen es mostrada sin tener en cuenta el 

modo de visualización 3D. Los ajustes son los mismos que en el caso de Background 

Image Settings 

Size 

Controla el tamaño local del Empty. Esto no cambia su escala, pero simplemente 

redimensiona la forma. 
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Las ocho maneras distintas de representación de un empty. 

Agrupando y Emparentando Objetos 

Pueden haber muchos objetos en una escena: Una escena típica consiste en muebles, 

accesorios, luces y telones de fondo. Blender le ayuda a mantener todo organizado al 

permitirle agrupar objetos. 

Cuando modela un objeto complejo, como un reloj, puede elegir modelar las diferentes partes 

como objetos separados. Sin embargo, todas las partes deberían estar relacionadas unas con 

otras. En estos casos, usted desea designar un objeto como el padre de todos los hijos. El 

movimiento y rotación del padre también afecta a los hijos.  

 

Emparentando Objetos 

 

Menú emergente Set Parent To 

Para emparentar objetos, seleccione al menos dos objetos (Seleccione los objetos hijos 

primero, y luego seleccione el objeto padre), y presione CtrlP . Un diálogo de confirmación 

aparecerá preguntándole si desea relacionarlos (Make Parent). Seleccionando Make 

Parent confirma, y la relación hijo/padre es creada. El último objeto seleccionado será el 

objeto activo (delineado en amarillo), y éste será el objeto padre. Si ha seleccionado múltiples 

objetos antes de seleccionar el padre, todos serán hijos del padre y estarán en el mismo nivel 

de jerarquía (ellos son "hermanos"). 

http://wiki.blender.org/index.php/File:25-Manual-Modeling-Objects-Parenting-SetParentPopUp.png


Para lograr el efecto contrario, presione ⇧ ShiftCtrlP  en su lugar. Esto crea una relación 

padre-hijo alternativa donde los objetos hijos existen enteramente en el sistema de 

coordenadas del padre. Esta es la mejor elección para propósitos CAD, por ejemplo. 

Moviendo y rotando el padre también moverá/rotará el hijo. Sin embargo, al mover/rotar el 

hijo del padre, no resultará en un movimiento/rotación del padre. En otras palabras, la 

influencia es usualmente descendente (padre → hijo/hijos), y no ascendente (hijo/hijos → 

padre).  

 

Emparentaje de Vértice 

Puede emparentar un objeto a un único vértice o a un grupo de tres vértices; de esta manera, el 

hijo se moverá cuando la malla del padre es deformada, como un mosquito sobre una 

pulsación arterial. En Modo Objeto, seleccione el hijo y el objeto padre. Presione ⇆ Tab  para 

ingresar a Modo Edición y en el objeto padre seleccione un vértice de cualquiera de los que 

definen un único punto, o seleccione tres vértices que definen un área (los tres vértices no 

necesitan formar una cara completa, ellos pueden ser arbitrariamente cualquier vértice del 

objeto padre), y luego presione CtrlP  y confirme. 

Hasta este punto si un único vértice es seleccionado, una línea de la relación de parentezco 

será dibujada desde el vértice hasta el hijo. Si tres vértices fueron seleccionados, entonces una 

línea de relación de parentezco es dibujada desde el promedio central de los tres puntos (del 

objeto padre) al hijo. Ahora, cuando la malla del padre se deforme y el vértice seleccionado 

del padre se mueva, el hijo se moverá con él. 

 

Opciones 

 

Mover hijo 

Puede mover un objeto hijo a su padre limpiando su origen. La relación entre el padre y el hijo 

no es afectada. Seleccione el objeto hijo y presione AltO . Al confirmar el diálogo, el objeto 

hijo se ajustará a la posición del padre. Utilice la vista del Outliner para verificar que el objeto 

hijo está aún emparentado.  

 

 

 

 



 

Remover/Cancelar la relación de Padre 

 

 

Menú emergente Clear Parent 

Puede remover una relación padre-hijo mediante AltP  

El menú contiene: 

Clear Parent 

Si el padre en el grupo está seleccionado no ocurrirá nada. Si un objeto hijo está 

seleccionado, es desasociado de su padre, o liberado, y devuelto a su posición, rotación 

y escala original. 

Clear and Keep Transformation 

Libera el hijo del padre, y mantiene la posición, rotación y escala dada a él por el 

objeto padre. 

Clear Parent Inverse 

Ubica al hijo con respecto al padre como si fueran ubicados en referencia Global. Ésto 

efectivamente cancela la transformación del padre al hijo. Por ejemplo, si el padre es 

movido 10 unidades a lo largo del eje X y la herramientaClear Parent Inverse es 

invocada, cualquier hijo seleccionado es liberado y movido -10 unidades atrás en el eje 

X. ElInverso solo utiliza la última transformación; si el padre fue movido dos veces, 10 

unidades cada vez para un total de 20 unidades, entonces el Inverso solo moverá el hijo 

10 unidades hacia atrás, y no 20. 

 

Ejemplo de Emparentaje 

 

Ejemplo de Emparentaje 

http://wiki.blender.org/index.php/File:25-Manual-Modeling-Objects-Parenting-ClearParentPopUp.png
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El objeto activo, en amarillo (cubo A), será hecho el padre de todos los otros objetos en el 

grupo (cubo naranja B). Los centros de todos los hijos ahora son relacionados con el centro del 

padre por una línea punteada; véa la imagen (Ejemplo de Emparentaje). El objeto padre es el 

cubo A y el objeto hijo es el cubo B. El encadenamiento es mostrado con L. 

En este punto, las transformaciones de arrastrar, rotar y escalar del padre harán lo mismo para 

los hijos. El emparentaje es una importante herramienta con muchas aplicaciones avanzadas, 

como veremos en posteriores capítulos; es extensivamente utilizado con animaciones 

avanzadas. 

 

Sugerencia 

 

Vista del Outliner 

Existe otra forma de ver la relación padre-hijo en grupos, y es utilizando la vista del Outliner  

de La ventana Outliner. La imagen (Vista del Outliner ) es un ejemplo de cómo se ve la vista 

del Outliner para el "Ejemplo de Emparentaje". El nombre del objeto del cubo A es 

―Cube_Parent‖ y el del Cubo B es ―Cube_Child‖.  

 

Separando Objetos 

En algún momento, llegará a un punto en el que necesita cortar partes de una malla para 

separalas. Bueno, la operación es sencilla. 

Para separar un objeto, los vértices (o caras) deben seleccionarse y ser separadas, aunque 

existen diversas maneras de lograr esto.  

Opciones 

 

Suzanne prolijamente diseccionada 

Selected 

Esta opción separa la selección en un nuevo objeto. 
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All Loose Parts 

Separa la malla en sus partes que se encuentran inconexas. 

By Material 

Crea mallas separadas para cada material. 

 

Agrupando objetos 

 

Objetos agrupados 

Agrupar objetos entre sí sin ningún tipo de relación de transformación. Utilice los grupos 

simplemente para organizar lógicamente su escena, o para facilitar en un solo paso anexar o 

vincular archivos en otras escenas. Los objetos que son parte de un grupo siempre se muestran 

con un color verde claro cuando son seleccionados (véa Objetos agrupados).  

 

Opciones 

Creando un Grupo 

CtrlG  crea un nuevo grupo y añade los objetos seleccionados a él. 

Seleccionando 

Introducción 

La selección, en todo programa, determina a qué elementos se aplicarán nuestras acciones. 

Cuanto más se adapte la herramienta de selección a la acción, mejor. Las herramientas y 

funciones de Blender son variadas, y lo mismo se aplica a las herramientas de selección. 

Esta es una breve reseña de las herramientas disponibles en Modo Objeto.  

 

La selección y el objetivo 

Blender distingue entre dos estados de selección: 

http://wiki.blender.org/index.php/File:25-Manual-Modeling-Objects-Parenting-Exampel-GroupedObj.png


 

 

Negro: objeto no seleccionado, Naranja; objeto seleccionado, Amarillo: objeto activo 

 Objeto activo: en Modo Objeto el último objeto seleccionado es el "objeto activo" (el 

resaltado en amarillo), y se mantiene como activo aún luego de deseleccionar todos los 

objetos. 

Varias acciones utilizan el objeto activo, por ejemplo, operaciones de vinculado 

(linking). Para hacer a un objeto activo, sin deseleccionar el resto, utilizamos⇧  

ShiftRMB . 

 Objetos seleccionados: puede haber cualquier número de objetos seleccionados (todos 

menos el activo se resaltan en naranja). 

Selección puntual 

Simplemente, hacemos RMB  sobre el objeto. 

Para seleccionar varios, use ⇧ ShiftRMB . 

Si los objetos se sobreponen en la vista actual, usamos AltRMB  para ver una lista de los 

objetos posibles. Para agregarlos a la selección actual: ⇧ ShiftAltRMB . 

Para hacer de un objeto seleccionado el objeto activo: ⇧ ShiftRMB . 

Para deseleccionar el objeto activo usamos ⇧ ShiftRMB . Debemos hacer dos clics si el 

objeto seleccionado no es el objeto activo.  

 

Selección rectangular o de borde 

Modo: Object mode 

Combinación de teclas: B  

Menú: Select → Border Select 
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Descripción 

Con Border Select dibujamos un rectángulo mientras mantenemos LMB  para seleccionar 

los objetos que quepan total o parcialmente en él. 

Para deseleccionar: MMB . 

Para cancelar: RMB .  

Ejemplo 

 

Selección en tres pasos 

La Selección de borde se activó en la primera imagen y se indica con un cursor punteado. En 

la segunda imagen se utiliza Selección de región al dibujar un rectángulo LMB . El 

rectángulo sólo cubre dos cubos. En la tercera imagen, la selección se libera 

completamente LMB . 

Nótese que el color del cubo más a la izquierda, indica que es el ―objeto activo‖, el último 

seleccionado antes de usarSelección de Borde.  

Sugerencias 

La selección de borde siempre añade los objetos a la selección actual, de manera que para 

seleccionar sólo los objetos bajo el rectángulo, se deben deseleccionar todos los objetos 

primero ( A ).  

 

Selección de lazo 

Mode: Object mode 

Hotkey: CtrlLMB  

Menu: Sin entrada de Menú 

Descripción 

Permite seleccionar objetos dibujando una línea punteada alrededor de los puntos de origen (o 

pivotes) de cada objeto 

http://wiki.blender.org/index.php/File:Template-LMB.png
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Uso 

Mientras mantiene presionado Ctrl , rodee los pivotes de los objetos a seleccionar 

con LMB . 

Al igual que con la herramienta de selección de borde, los objetos seleccionados se añaden a la 

selección anterior. 

 

Ejemplo 

 

Otros 

Otros métodos de selección se pueden encontrar en el menú Select en laVista 3D . 

 

Seleccionar agrupados 

Modo: Modo Objeto 

Combinación de teclas: ⇧ ShiftG  

Menú: Select → Grouped 

Descripción 

 

Menú de selección Grouped 

http://wiki.blender.org/index.php/File:Template-LMB.png


Se pueden organizar los objetos en relación a otros mediante dos métodos: emparentamiento y 

agrupación. Es posible seleccionar los objetos emparentados o agrupados a partir de un objeto 

emparentado o del mismo grupo. 

Opciones 

Select → Grouped en Modo Objeto se basa en el objeto activo para seleccionar el resto del 

grupo. 

Opciones disponibles: 

Children 

Selecciona todos los objetos hijos del objeto activo (recursivamente). 

Immediate Children 

Sólo los hijos del objeto activo. 

Parent 

Selecciona el objeto padre del objeto activo. 

Siblings 

Selecciona objetos "hermanos" (que tienen el mismo padre). Aplicado a objetos sin 

padre (objetos del espacio raíz) selecciona todos los objetos de raíz. 

Type 

Selecciona objetos del mismo tipo. 

Layer 

Objetos que comparten al menos una Capa. 

Group 

Objetos que forman parte del mismo grupo (dibujados en verde). 

Object Hooks 

Todos los hooks (ganchos) pertenecientes al objeto activo. 

Pass 

Objetos asignados a la misma pasada de renderizado. Esta configuración se encuentra 

en Properties → Object →Relations y puede utilizarse en el Compositor de 

Nodos (Add → Convertor → ID Mask.) 



Color 

Objetos con el mismo Color de Objeto. El color de los objetos se configura 

en Properties → Object → Display →Object Color. 

Properties 

Objetos con las mismas propiedades del motor de juegos (Game Engine). 

 

Seleccionar vinculados 

Modo: Modo Objeto 

Combinación de teclas: ⇧ ShiftL  

Menú: Select → Linked 

Descripción 

 

Linked Menú de selección 

Selecciona todos los objetos que comparten un bloque de datos en común en relación al objeto 

activo. 

Opciones 

Select → Linked en Object mode utiliza el objeto activo como una base para seleccionar otros 

objetos. 

Las opciones disponibles son: 

Object Data 

Selecciona cada objeto que está vinculado a los mismos Datos de Objeto, por ejemplo, 

el bloque de datos que especifica el tipo (malla, curva, etc.) y cómo está constituído el 

objeto (elementos como vértices, vértices de control, y dónde están en el espacio). 

Material 

Selecciona cada objeto que está vinculado al mismo bloque de datos de Material. 

http://wiki.blender.org/index.php/File:25-Manual-Object-Selection-Linked.png


Texture 

Selecciona cada objeto que esté vinculado al mismo bloque de datos de Textura. 

Dupligroup 

Selecciona todos los objetos que utilicen el mismo Grupo para la duplicación. 

Particle System 

Selecciona todos los objetos que utilizan el mismo Sistema de Partículas 

Library 

Selecciona todos los objetos que están en la misma Librería 

Library (Object Data) 

 

Seleccionar Todos por Tipo 

Modo: Modo Objeto 

Combinación de teclas: None 

Menú: Select → Select All by Type 

Descripción 

 

Menú de selección por Tipo 

Los Tipos son Mesh, Curve, Surface, Meta, Armature, Lattice, Text, Empty, Camera, Lamp. 

Con esta herramienta es posible seleccionar cada objeto visible de un cierto tipo en un solo 

paso. 

http://wiki.blender.org/index.php/Dev:2.5/Source/Data_system/LibraryBrowser


Opciones 

Select All by Type en Modo Objeto ofrece una opción para cada tipo de objeto que puede ser 

descrito por el bloque de datos ObData. 

Tan solo haga su elección.  

 

Seleccionar Todos por Capa 

Modo: Modo Objeto 

Combinación de teclas: Ninguno 

Menú: Select → Select All by Layer 

 

Descripción 

 

Menú de selecciónAll by Layer 

Las capas son otra manera de reagrupar sus objetos para lograr sus propósitos. 

Ésta opción le permite seleccionar todos los objetos que pertenezcan a una capa dada, visible o 

no, en un simple comando. 

Opciones 

En el Tool Shelf las siguientes opciones están disponibles: 

Extend 

Posibilita añadir objetos a la selección actual en vez de reemplazar la selección. 

Layer 

La capa en la que los objetos están. 
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Otras opciones de Menú 

Las opciones disponibles en el primer nivel del menú son: 

Random 

Selecciona aleatoriamente objetos que no estén seleccionados basado en el porcentaje 

probable en la capa actual activa. Al seleccionar el comando, la caja de selección se 

vuelve disponible en el Tool Shelf. 

Es importante notar que el porcentaje representa la probabilidad de que un objeto no 

seleccionado se pueda seleccionar, y no el porcentaje de objetos que serán 

seleccionados. 

Inverse ( CtrlI ) 

Selecciona todos los objetos que no están seleccionados al mientras deselecciona todos 

aquellos que lo están. 

Select/Deselect All ( A ) 

Si algo fue seleccionado, primero es deseleccionado. De lo contrario, intercambia entre 

seleccionar y deseleccionar cada objeto visible. 

Border Select ( B ) 

Como fue descrito más arriba en la sección de selección de borde. 

 

Nombrando un Grupo 
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Nombrando un Grupo 

Todos los grupos que un objeto tiene asignado son listados en elPanel de Propiedades 

del Objeto en el panel Relations. Para renombrar un grupo, simplemente cliquee en el 

campo de nombre del grupo. 

Para nombrar grupos en la ventana Outliner, seleccione Groups como muestra el 

outliner desde la caja de secciones de la cabecera, y haga CtrlLMB  en el nombre 

del grupo. El nombre cambiará a un campo editable; haga sus cambios y presione↵  

Enter . 

Restringiendo los contenidos de un Grupo mediante Capas 

El grupo de capas de un grupo determina desde qué capas los grupos de objetos serán 

incluidos cuando son duplicados. Si su grupo contiene objetos en las capas 10, 11 y 12, 

pero deshabilita la capa 12 en los controles del grupo, los duplicados de aquél grupo 

(usando la característica Dupligroup) sólo mostrará las porciones del grupo que residen 

en la capa 10 y 11. 

Anexando y vinculando Grupos 

Para anexar un grupo desde otro archivo .blend, consulte ésta página. En 

resumen,File → Append or 

Link → nombre_de_archivo → Group → nombre_de_grupo. 

 

Grupo Seleccionado 

 

Menú emergente Selected Grouped 
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⇧ ShiftG  muestra un diálogo para seleccionar objetos basados en sus relaciones de parentaje y 

características de grupo. 

Opciones 

Children 

Selecciona todos los hijos de los objetos activos, hasta la última generación. 

Immediate Children 

Selecciona todos los hijos de los objetos activos, pero no aquellos hijos de esos hijos 

(sin selección de granhijo). 

Parent 

Selecciona el padre del objeto activo y deselecciona el objeto activo. 

Siblings 

Selecciona todos los hermanos del objeto activo. 

Type 

Selecciona objetos basados en el tipo de objeto actualmente seleccionado. 

Layer 

Selecciona todos los objetos en la misma capa del objeto activo. 

Group 

Selecciona objetos que pertenecen al mismo grupo como el objeto activo. 

Hook 

Selecciona todos los Ganchos los cuales están sujetos al objeto activo. 

Pass 

Selecciona todos los objetos que tienen el mismo número de Pass Index (Índice de 

pasada) que el del objeto activo.  

Color 

Selecciona objetos que tienen el mismo color (que aparece en el panel Draw) del 

objeto activo. 

 

http://wiki.blender.org/index.php?title=Doc:ES/2.5/Manual/Modifiers/Mesh/Hooks&action=edit&redlink=1


Properties 

Selecciona objetos que tienen las mismas propiedades de juego como las que tiene el 

objeto activo. 

Seguimiento 

Modo: Modo Objeto 

Panel: Object » Constraints 

Combinación de teclas: CtrlT  

Menú: Object » Track » Make Track 

Descripción 

El seguimiento consiste en un objeto observando a otro. El que mira es el "seguidor" y el 

mirado es el "objetivo". Si el objetivo se mueve, el seguidor rota para mirarlo; si el seguidor se 

mueve, el seguidor rota para poder mirar al objetivo. En ambos casos, el seguidor mantiene 

una mirada constante hacia el objetivo.  

 

Tipos de Seguimiento 

 

Menú Make Track. 

Para hacer que uno o más objetos sigan a otro objeto (el objetivo), seleccione por lo menos dos 

objetos y presione CtrlT . El objeto activo se convierte en el objetivo y los demás objetos, los 

seguidores. El Menú Make Track provee varias opciones para crear el seguimiento inicial:  

 

Restricciones Seguir A... 

La Restricción Seguir A... aplica la rotación a su dueño, para que siempre apunte a un eje dado 

como To hacia su objetivo, con otro eje Up mantenido en línea permanente con el eje global Z 

(por defecto) tanto como sea posible.  

Restricción Seguimiento Bloqueado 

La Restricción Seguimiento Bloqueado es un poco complicada de explicar, tanto gráfica como 

textualmente. Básicamente, es una Restricción Seguir A..., pero con un eje bloqueado, por 

http://wiki.blender.org/index.php?title=Doc:ES/2.5/Manual/Game_Engine/Logic/Properties&action=edit&redlink=1
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ejemplo, un eje que no puede rotar (cambiar su orientación). Por lo tanto, el dueño solo puede 

seguir a su objetivo al rotar al rededor de este eje y, a menos que el objetivo esté en plano 

perpendicular con respecto al eje bloqueado, y cruzando al dueño, éste mismo no podrá 

realmente apuntar a su objetivo.  

Seguimiento Calmado 

La Restricción Seguimiento Calmado restringe un eje local del dueño para siempre apuntar 

hacia el objetivo.  

Seguimiento antiguo 

 

 

Restricción Seguimiento antiguo. 

Éste es un algoritmo más antiguo, anterior a la versión 2.30, y es similar a la Restricción 

Seguir A... en el sentido de que ningún eje es bloqueado. Éste algoritmo simplemente intenta 

mantener un eje To apuntando hacia el objetivo. El objeto seguidor usualmente terminará en 

una extraña orientación cuando esta Restricción es aplicada primero. Para obtener resultados 

correctos, utilice AltR  cuando aplique o cambie el seguimiento o el eje Up. Sin embargo, el 

método preferido es la Restricción Seguir A.... 

Supongamos que de cualquier modo ha seleccionado el Seguimiento antiguo en el diálogo con 

dos cubos seleccionados; véa (Restricción Seguimiento antiguo". Por defecto, el objeto 

inactivo sigue al objeto activo por lo que su eje local +Y apunta hacia el objeto seguido o a 

seguir. El Cubo "A" está siguiendo al Cubo "B" utilizando la Restricción Seguimiento antiguo. 

Puede ver que el eje +Y de "A" se encuentra apuntando hacia "B" pero en una extraña 

orientación. Ésto sucede típicamente si el objeto ya posee una rotación en sí mismo. Puede 

producir seguimientos correctos cancelando la rotación del objeto seguidor utilizando AltR . 

La orientación del objeto seguidor es también ubicada de manera que el eje 

seleccionado Up se encuentre apuntando hacia arriba. 

 

Configurando el eje de seguimiento. 
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Si desea cambiar esto necesitará ir al panel Anim settings donde las propiedades 

del Seguimiento antiguo se pueden encontrar. Primero seleccione el objeto seguidor (no el 

objetivo) y cambie al botón Object de la ventana Properties cliqueando el ícono ( ), o F7 ; 

Véa (Configurando los ejes de seguimiento.). 

Tiene entonces la opción de seleccionar el Eje seguidor desde el conjunto de la primera 

columna de seis botones de radio. 

 

Sugerencias 

El objeto activo siempre se vuelve el objetivo a ser seguido. En todos los casos menos en el 

método del Seguimiento antiguo una línea punteada de color azul es dibujada entre el seguidor 

y el objetivo, indicando que una Restricción de seguimiento está en el lugar entre los objetos 

correspondientes. Si ve un objeto siguiendo a otro sin una línea punteada azul, entonces sabrá 

que el objeto seguidor está utilizando la Restricción Seguimiento antiguo.  

 

Seguimiento inválido o configuraciones 

Si selecciona un eje inválido de seguimiento To y/o Up, el objeto seguidor mantiene su 

posición actual e ignora las selecciones incorrectas. Por ejemplo, si selecciona el eje +Z como 

el eje To y también selecciona el eje +Z como el eje Up, obtendrá una combinación inválida 

puesto que no puede tener el mismo eje seguidor +Z haciendo dos cosas diferentes al mismo 

tiempo. 

Si tiene problemas configurando los ejes correctos To y Up quizás desee activar los ejes 

locales del objeto. Puede hacer esto desde el panel Draw cliqueando en el botón Axis. 

 

Modificadores 

Mode: Cualquier modo 

Panel: Modifiers 
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Menú Modifiers 

Los modificadores son operaciones automáticas que afectan a un objeto de una manera no 

destructiva. Con los modificadores puede realizar muchos efectos automáticamente que de 

otra manera sería una tarea tediosa de hacer manualmente (como la subdivisión de superficies) 

y sin que afecte a la topología base de su objeto. Los modificadores funcionan cambiando 

cómo se muestra y renderiza el objeto, pero sin tocar la geometría real del objeto. Puede añadir 

varios modificadores a un sólo objeto formando una Pila de Modificadores y puede aplicar 

("Apply") un modificador si desea hacer esos cambios permanentes. 

Existen cuatro tipos de modificadores: 

 

Modify 

Modificar 

El grupo de modificadores Modify son herramientas algo similares a las de Transform, pero no 

afectan directamente a la forma del objeto, sino a otros datos, como los grupos de vértices. 

UV Project 

Proyecta las coordenadas UV de su malla. 

Vertex Weight 

Edita de varias maneras un grupo de vértices de su malla. 

Generate 

El grupo de modificadores Generate son herramientas de construcción que cambian tanto la 

apariencia general como añaden geometría a un objeto automáticamente. 

Array 

Crea un array o colección de su malla básica y formas similares (repetidas). 

Bevel 

Crea un borde en la malla del objeto seleccionado. 

Boolean 

Combina/sustrae/intersecta su malla con otra. 

Build 

Ensambla su malla paso a paso durante la animación. 
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Decimate 

Reduce el número de polígonos de su malla. 

Edge Split 

Añade filos marcados a su malla. 

Mask 

Permite ocultar algunas partes de su malla. 

Mirror 

Refleja un objeto sobre uno de sus propios ejes, de modo que la malla resultante es 

simétrica, y sólo tiene que modelar o editar la mitad, un cuarto o un octavo de la 

misma. 

Multiresolution 

Esculpe su malla en varios niveles de resolución. 

Screw 

Genera geometría en un patrón helicoidal desde un perfil sencillo. Similar a la 

herramienta Screw en el contexto de edición de malla. 

Solidify 

Da profundidad a las caras de la malla. 

Subdivision Surface 

Suaviza la superficie creando geometría interpolada. 

Skin 

Genera topología automáticamente. 

 

Deform 

El grupo de modificadores Deform sólo cambia la forma de un objeto, y están disponibles para 

mallas y a menudo para textos, curvas, superficies y lattices. 

Armature 

Usa huesos para deformar y animar un objeto. 
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Cast 

Cambia la forma de una malla, superficie o lattice a una esfera, cilindro o cuboide. 

Curve 

Dobla su objeto usando una curva como guía. 

Displace 

Deforma su objeto usando una textura. 

Hook 

Añade un gancho a sus vértices (o puntos de control) para manipularlos desde fuera. 

Lattice 

Usa un objeto Lattice para deformar su objeto. 

Mesh Deform 

Le permite deformar su objeto modificando la forma de otra malla, usada como "jaula 

de deformación de malla" (como cuando se usa un lattice). 

Shrinkwrap 

Permite reducir/envolver su objeto de acuerdo con la superficie del objeto malla 

objetivo. 

Simple Deform 

Aplica algunas deformaciones avanzadas a su objeto. 

Smooth 

Suaviza la geometría de una malla. Similar a la herramienta Smooth en el contexto de 

edición de malla. 

Warp 

Envuelve una malla especificando dos puntos entre los que la malla se extiende. 

Wave 

Deforma su objeto para formar ondas (animadas). 
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Simulate 

El grupo de modificadores Simulate activa las simulaciones. En la mayoría de los casos, estos 

modificadores se añaden automáticamente a la pila de modificadores ya se haya habilitado una 

simulación de sistema de partículas (Particle System) o de física (Physics) y su única función 

es definir el lugar en la pila de modificadores que ocupa como datos base para la herramienta a 

la que representan. Generalmente se accede en paneles separados en otras pestañas a los 

atributos de estos modificadores. 

Cloth 

Simula las propiedades de un trozo de tela. Se inserta en la pila de modificadores 

cuando designe una malla como tela (Cloth). 

Collision 

Simula la colisión entre objetos. 

Explode 

Explota su malla usando un sistema de partículas. 

Fluid 

El objeto es parte de una simulación de fluidos. El modificador se añade cuando 

designe una malla como fluido (Fluid). 

Particle Instance 

Hace que un objeto actúe de manera similar a una partícula, pero usando la forma de la 

malla a cambio. 

Particle System 

Representa un sistema de partículas en la pila, de modo que se inserta cuando añade un 

sistema de partículas al objeto. 

Smoke 

Simula humo con realismo. 

Soft Body 

El objeto es suave, elástico. El modificador se agrega cuando designe una malla como 

cuero suave (Soft Body). 
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Dynamic Paint 

Hace que un objeto o un sistema de partículas pinte un material sobre otro objeto. 

Ocean 

Crea rápidamente un océano animado y con realismo. 

 

Texturas 

 

Introducción 

En CGI, un mapa de texturas es un método para añadir detalles a las superficies proyectando 

imágenes y patrones sobre esas superficies. Las imágenes y patrones proyectados pueden ser 

configurados para afectar no solo el color, sino también la especularidad, la reflección, la 

transparencia e incluso una falsa profundidad tridimiensional. Es más común que las imágenes 

y patrones sean proyectados en tiempo de renderización, pero los mapas de texturas son 

utilizados también para esculpir, pintar y deformar objetos. 

En Blender, las Texturas pueden aplicarse a un Material, a un pincel (Brush), y al fondo 

general o Mundo (World). Además, las texturas también pueden usarse mediante varios 

Modificadores (Modifiers). 

 

 

 

 

 

 

 

El panelTexture con los botones para Material,World, y Brush resaltados 
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Materiales 

 

Algunas Texturas metálicas 

La configuración de materiales que hemos visto hasta ahora produce objetos lisos, uniformes, 

pero tales objetos no se ajustan particularmente a la realidad, donde la uniformidad es poco 

común y está fuera de lugar. Para lidiar con esta uniformidad poco realista, Blender permite al 

usuario aplicar texturas con las que puede modificar la reflectividad, especularidad, rugosidad 

y otras cualidades de la superficie de un material. 

Las texturas caen detro de tres categorías primarias: 

(Texturas procedimentales (Procedural Textures) 

Son texturas generadas por una fórmula matemática. Por ejemplo, Wood, Clouds, 

y Distorted Noise 

Imágenes o Películas 

Fotos y películas proyectadas sobre los objetos. Por ejemplo, un mapa plano de la 

tierra proyectado sobre una esfera. 

Mapas ambientales (Environment Maps) 

Son texturas empleadas para crear la impresión de reflejos y refracciones. Por ejemplo, 

una imagen de una calle reflejada en la ventana de un auto. 

Para tener una idea general podría querer ver nuestro tutorial Using Textures.  
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Capa de texturas sobre un material base 

Las texturas son como capas adicionales sobre un material base. Las texturas afectan uno o 

más aspectos de la red de color de un objeto. La red de color que ve, es una suerte de capas de 

efectos, como se muestra en esta imagen de ejemplo. Las capas, si se quiere, son: 

1. Su objeto está iluminado con luz ambiental basada en su configuración del mundo. 

2. Su material base colorea la superficie completa con un color uniforme que reacciona a 

la luz, dando diferentes matices de los colores difuso, especular y espejo de acuerdo a 

la forma en que la luz pasa a través o se refleja en la superficie del objeto. 

3. Tenemos una capa de textura primaria que se superpone a un color púrpura 

marmoleado. 

4. Tenemos a continuación una textura nube secundaria que convierte la superficie 

transparente en una especie de niebla brumosa afectando su valor Alpha. 

5. Estas dos texturas se mezclan con el material base para proporcionar el efecto de red; 

un cubo de niebla marrón purpúrea. 

La noción de usar más de una textura, para lograr un efecto combinado, es uno de los secretos 

ocultos de la creación de objetos de apariencia realista. Si cuidadosamente mira a la 

luz mientras examina cualquier objeto de la vida real, observará que la apariencia final del 

objeto se describe mejor como una combinación, de diferentes tipos y cantidades de 

características visuales subyacentes. Estas características podrían ser más (o menos) 

difícilmente aparentes en distintos ángulos, bajo diferentes condiciones de iluminación, y así 

por el estilo. Blender le permite lograr esto de distintas maneras.  

La forma más flexible de mapeo de textura 2D en un objeto 3D es un proceso llamado 

"mapeado UV". En este proceso, se toma la malla en tres dimensiones (X, Y y Z) y desarma a 

un plano de dos dimensiones (X & Y ... o más bien, como veremos más adelante, "U & V") la 

imagen . Los colores de la imagen se asignan a la malla, y se muestran como el color de las 
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caras de la malla. Use UV texturas para proporcionar realismo a los objetos que los materiales 

y las texturas de procedimiento no pueden hacer, y mejorar los detalles que Vertex Paiting 

puede proporcionar. 

Explicación de la UV  

La mejor analogía para entender mapeado UV es cortar una caja de cartón. La caja es un 

objeto de tres dimensiones (3D), al igual que el cubo de malla que añadirá a su escena. 

Si usted tomara un par de tijeras y cortara una costura o pliegue de la caja, sería capaz de 

ponerla plana sobre una mesa. Al mirar hacia abajo la caja sobre la mesa, se podría decir que 

U es la dirección de izquierda a derecha, es V es la dirección arriba-abajo. Esta imagen es, 

pues, en dos dimensiones (2D). Utilizamos U y V para referir a las "coordenadas de textura y 

espacio" en vez de X e Y, que se utilizan siempre (junto con Z) para referirse a "un espacio 

3D." 

Cuando el cuadro se vuelve a armar, un lugar determinado UV en el papel es trasladado a un 

lugar (X, Y, Z) en la caja. Esto es lo que la computadora hace con una imagen 2D al 

envolverlo alrededor de un objeto 3D. Cuando el cuadro se vuelve a armar, un lugar 

determinado UV en el papel es trasladado a un lugar (X, Y, Z) en la caja. Esto es lo que la 

computadora hace con una imagen 2D al envolverlo alrededor de un objeto 3D. 

Durante el proceso de desenvolver UV, le dice a Blender exactamente la forma de asignar las 

caras del objeto (en este caso, un cubo) en una imagen plana en la ventana del editor UV / 

Imagen. 

Usted tiene total libertad en la manera de hacer esto. (Continuando con nuestro ejemplo 

anterior, imaginemos que, después de haber inicialmente desarmado la caja plana sobre la 

mesa, ahora se la corta en pedazos más pequeños, de alguna manera se extienden y / o reducen 

las piezas, y luego ordenarlas de alguna manera en una fotografía que también está sobre la 

mesa) 

 

Caja siendo inspeccionada                       Caja mapeada plano 

 

 



Ejemplo de cartografía 

Los cartógrafos (creadores de mapas) se han ocupado de este problema desde hace milenios. 

Un ejemplo cartográfico de ello (elaboración de mapas) es la proyección de un mapa del 

mundo. En la cartografía, tomamos la superficie de la Tierra (una esfera) y hacemos un mapa 

plano que se puede plegar en la guantera a bordo del transbordador espacial. Llenamos 

espacios hacia los polos, o cambiamos el contorno del mapa en cualquiera de estas formas: 

 

Proyección Mercator 

 

 

Proyección Mollweide                    Proyección Albers-equal   

Cada uno de estos es un ejemplo de mapeo UV de una esfera. Cada una de las cientos de 

proyecciones comúnmente aceptadas tiene sus ventajas y desventajas. Blender nos permite 

hacer lo mismo, de la manera que deseemos, en la computadora. 

En los modelos más complejos (como se ve en el mapa de la Tierra más arriba) aparece un 

problema por el que las caras no se pueden "cortar", sino que se estiran para que queden 

planas. Esto ayuda a hacer más fácil los mapas UV, pero a veces añade distorsión a la textura 

asignada final. (Los países y estados que están más cerca de los Polos Norte o Sur se ven más 

pequeños en un mapa plano que los que están cerca del Ecuador.) 

Ejemplo de la media-esfera 

 



Espacio 3D (XYZ) en comparación con el espacio UV 

En esta imagen se puede ver fácilmente que la forma y el tamaño de la cara marcada en el 

espacio 3D es diferente en el espacio UV. 

Esta diferencia es causada por el «estiramiento» (técnicamente llamada mapeo) de la parte 3D 

(XYZ) en un plano 2D (es decir, el mapa UV). 

Si un objeto 3D tiene un mapa UV, entonces, además de las coordenadas 3D - X, Y y Z, cada 

punto del objeto tendrá correspondientes coordenadas U y V. (P en la imagen de arriba es un 

ejemplo de cómo un punto en un objeto 3D puede ser proyectado en una imagen 2D.) 

 

Ventajas 

Mientras que las texturas de procedimiento (que se describe en los capítulos anteriores) son 

útiles -nunca se repiten y siempre "encajan" en objetos 3D- no son suficientes para los objetos 

más complejos o naturales. 

Por ejemplo, la piel de una cabeza humana nunca se ve muy bien cuando se genera 

procesalmente. Las arrugas de una cabeza humana, o rayas en un coche no se producen en 

lugares al azar, sino que dependen de la forma del modelo y su uso. Las imágenes pintadas a 

mano, o las imágenes capturadas del mundo real dan más control y realismo. Para detalles, 

tales como cubiertas de libros, tapices, alfombras, manchas, y accesorios con más detalle, los 

artistas pueden controlar cada pixel de la superficie usando una textura UV. 

Un mapa UV describe qué parte de la textura debe corresponder a cada polígono en el modelo. 

A cada vértice del polígono se le asignan las coordenadas 2D que definen que parte de la 

imagen corresponde al mapa. Estas coordenadas 2D se llaman UVs (comparar esto con las 

coordenadas XYZ en 3D). La generación de estos mapas UV también se llama "desenvolver", 

ya que es como si la malla se desenvolviera en un plano 2D. 

Para los modelos 3D más simples, Blender tiene un conjunto de algoritmos de desenvolver 

automáticos que usted puede aplicar fácilmente. Para los modelos 3D más complejos, el 

mapeo de cubo regular, cilíndrico o esférico no es suficiente. Para la proyección uniforme y 

precisa, utilice las costuras para guiar la asignación de UV. Esto se puede utilizar para aplicar 

texturas a formas arbitrarias y complejas, como las cabezas humanas o animales. A menudo, 

estas texturas son imágenes pintadas, creadas en aplicaciones como Gimp, Photoshop, o su 

aplicación de pintura favorita. 

Juegos 

El mapeado UV es también esencial en el motor de juego de Blender, o cualquier otro juego. 

Es el estándar para la aplicación de texturas a los modelos, y casi cualquier modelo que se 

encuentra en un juego es mapeado con UV. 

 



Configurando la escena por defecto 

Cuando inicia Blender o comienza un nuevo proyecto con la entrada de 

menú File » New o CtrlN , una nueva escena es creada desde la escena por defecto 

almacenada en User Preferences. 

 

Atajo de teclado 

Para cambiar la escena por defecto, haga todos los cambios deseados a la escena actual y 

presione CtrlU . 

 

Aparecerá la ventana de confirmación Save User Settings. Confirme con LMB  en la 

ventana Save User Settings que aparece o presione ↵ Enter . Presione Esc  para cancelar. 

 

Desde el menú 

Para cambiar la escena por defecto desde el menú, haga todos los cambios deseados a la 

escena actual y presione con LMB en File » User Preferences. Aparecerá la ventana User 

Preferences. 

Presione con LMB  en el botón Save As Default para guardar los cambios. Cierre la 

ventana User Preferences (sin clickear el botón Save As Default) para dejar la Escena por 

defecto sin cambios. 
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Resultado 

La escena actual, todos sus objetos, y configuraciones serán guardadas en las User 

Preferences. 

Devolviendo la escena a sus valores de fábrica 

Para restablecer la escena por defecto de fábrica, presione con LMB  en File » Load 

Factory Settings. Esto recuperará todas las preferencias de usuario (User Preferences) a los 

valores originales de fábrica. 

 

Mundo 

Blender ofrece una serie de opciones muy interesantes para 

completar sus renders mediante la adición de fondos, o algunos 

efectos interesantes. Estos son accesibles a través del 

contexto World. Por defecto se presenta un mundo llano uniforme, 

pero esto puede ser editado o se pueden añadir mundos nuevos. 

Se pueden encontrar las siguientes pestañas: 

Preview 

Muestra una pre visualización aproximada de lo que luego se verá 

en el render. 

World 

Ambient Occlusion 

Environment Lighting  

Indirect Lighting 

Gather 

Mist 

Stars 

Custom Properties 
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